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GigaVUE Cloud Suite
Deployment Guide - OpenStack

This guide describes how to install, configure and deploy the GigaVUE Cloud solution on
OpenStack. Use this document for instructions on configuring the GigaVUE Cloud
components and setting up the traffic monitoring sessions for OpenStack.

Refer to the following sections for details:

Overview of GigaVUE Cloud Suite for OpenStack

Get Started with GigaVUE Cloud Suite for OpenStack Deployment
Deploy GigaVUE Cloud Suite for OpenStack

Configure Monitoring Session

Administer GigaVUE Cloud Suite for OpenStack

GigaVUE-FM Version Compatibility Matrix

Troubleshooting

GigaVUE Cloud Suite Deployment Guide - OpenStack
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Overview of GigaVUE Cloud Suite
for OpenStack

GCigaVUE® Fabric Manager (GigaVUE-FM) is a web-based fabric management interface that
provides a single-pane-of-glass visibility and management of both the physical and virtual
traffic. GigaVUE-FM is a key component of the GigaVUE Cloud Suite for OpenStack.

The OpenStack software is designed for multi-tenancy (multiple projects), where a common
set of physical compute and network resources are used to create project domains that
provide isolation and security. Characteristics of a typical OpenStack deployment include the
following:

» Projects are unaware of the physical hosts on which their instances are running.
» A project can have several virtual networks and may span across multiple hosts.

In a multi-project OpenStack cloud, where project isolation is critical, the Gigamon solution
extends visibility for the project's workloads without impacting others by doing the
following:

» Support project-wide monitoring domains—a project may monitor any of its instances.

* Honor project isolation boundaries—no traffic leakage from one project to any other
project during monitoring.

* Monitor traffic without needing cloud administration privileges. There is no requirement
to create port mirror sessions and so on.

* Monitor traffic activity of one project without adversely affecting other projects.

Refer to the following sections for details:

» Components of GigaVUE Cloud Suite for OpenStack
» Architecture of GigaVUE Cloud Suite for OpenStack

Components of GigaVUE Cloud Suite for
OpenStack

The GigaVUE Cloud Suite for OpenStack includes the following components:

« GigaVUE® Fabric Manager (GigaVUE-FM) is a web-based fabric management and
orchestration interface that provides a single pane of glass visibility, management, and
orchestration of both the physical and virtual traffic that form the GigaVUE Cloud Suite
Cloud.

Overview of GigaVUE Cloud Suite for OpenStack 10
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GigaVUE-FM can be installed on-premises or launched from an OpenStack image. GigaVUE-
FM manages the configuration of the following visibility components in your OpenStack
project:

» UCT-V Controllers (only if you are using UCT-V as the traffic acquisition method)
» GigaVUE V Series Configuration

e GigaVUE® V Series Proxy

e GigaVUE® V Series Nodes

» UCT-Vs (earlier known as G-vTAP Agent): An agent that is installed in your virtual
machines. This agent mirrors the selected traffic from the virtual machines to the
GigaVUE V Series Node.

« UCT-V Controller (earlier known as G-vTAP Controller) manages multiple UCT-Vs and
orchestrates the flow of mirrored traffic to GigaVUE V Series nodes. GigaVUE-FM uses
one or more UCT-V Controllers to communicate with the UCT-Vs. UCT-V Controllers

«» GigaVUE® V Series Proxy manages multiple V Series nodes and orchestrates the flow
of traffic from GigaVUE V Series nodes to the monitoring tools. GigaVUE-FM uses one or
more GigaVUE V Series Proxies to communicate with the GigaVUE V Series nodes. The
GigaVUE V Series Proxy is a optional component. If GigaVUE-FM cannot directly reach
the GigaVUE V Series Nodes (management interface) directly over the network, a Proxy
should be used. A single GigaVUE V Series Proxy can be launched to provide the
GigaVUE-FM network communication to hundreds of GigaVUE V Series Nodes present
in private networks behind the Proxy.

« GigaVUE® V Series Node is a visibility node that aggregates mirrored traffic. It applies
filters, manipulates the packets using GigaSMART applications, and distributes the
optimized traffic to cloud-based tools or backhaul to GigaVUE Cloud Suite Cloud using
L2GRE, or ERSPAN, or VXLAN tunnels.

« Next generation UCT-V (earlier known as Next Generation G-vTAP Agent) is a
lightweight solution that acquires traffic from Virtual Machines and in-turn improves
the performance of the UCT-V mirroring capability. The solution has prefiltering
capability at the tap level that reduces the traffic flow from the UCT-V to
GigaVUE V Series Node and in-turn reduces the V Series load. Next generation UCT-V
gets activated only if the kernel version is above 5.4. If the kernel version is less than 5.4
TC based mirror solution is deployed. Some of the points to be remembered while
deploying the Next generation UCT-V are as follows:

Tapping/Tunnelling features are not fully supported in all the linux kernel version.

The support for Windows is relatively new and does not tap the packets. No
change in data acquisition is planned for Windows agent.

Fore more information about Prefiltering, refer to Create a Monitoring Session.

Overview of GigaVUE Cloud Suite for OpenStack 1
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Architecture of GigaVUE Cloud Suite for
OpenStack

GigaVUE Cloud Suite for OpenStack captures traffic in OpenStack cloud using UCT-Vs
directly or through the hypervisor as described in this section.

Refer to the following architectures for details:
« UCT-V
«  Open vSwitch (OVS) Mirroring

UCT-V

A UCT-V is a tiny footprint user-space agent (UCT-V) that is deployed in a project instance.
This agent mirrors the traffic from a source interface to a destination mirror interface. The
mirrored traffic is then sent to the GigaVUE® V Series node. The following figure shows a
high-level architecture of GigaVUE Cloud Suite for OpenStack using UCT-Vs as the source for
acquiring the traffic.

GigaVUE-FM

)
OpenStack Cloud APIs @

G-vTAP GigaVUE® V Series
Controller Controller

13

m

1
1
TEAN i
“" \  GTAPs ‘l’

Target Instances (VIMs)
to be monitored

Control Traffic {—————» Monitored Data Traffic == ====== -

A UCT-V is deployed by installing the agent in the virtual instances. When a UCT-V is
installed, a UCT-V Controller must be configured in your environment. A UCT-V Controller
orchestrates the flow of mirrored traffic from UCT-Vs to the GigaVUE V Series nodes. A single
UCT-V Controller can manage up to 100 UCT-Vs deployed in the cloud.

Overview of GigaVUE Cloud Suite for OpenStack 12
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By using UCT-Vs for mirroring traffic, the monitoring infrastructure is fully contained within
the virtual machine being monitored. This agent is agnostic of the underlying virtual switch.
Also, the cost of monitoring a virtual machine is borne by the same virtual machine.

Open vSwitch (OVS) Mirroring

When deploying Open vSwitch (OVS) Mirroring, a UCT-V is installed on the hypervisor where
the VMs you wish to monitor are located. When a UCT-V is installed, a UCT-V Controller must
be configured in your environment. A UCT-V Controller orchestrates the flow of mirrored
traffic from UCT-Vs to the GigaVUE V Series nodes.

A single UCT-V Controller can manage up to 100 UCT-Vs deployed in the cloud. By using
OVS Mirroring or OVS Mirroring + DPDK, or OVS Mirroring + Hardware offload, the mirroring
infrastructure is fully contained within the hypervisors.

GigaVUE-FM >
@ OpenStack Cloud APIs ©
|Pv4/IPv Pv4/va6

mEER EEN
GigaVUE®
ol G-VIRF Cantreljor V Series Controller
GvTap Controller
4
— \ IPv4/IPv6
E'g::zlfc:mlrollar b y L G-vTAPOVS /
| ' IPva/IPv6

=|I

.:‘:\ ﬁ ______.,

=

Hypervisor OVS

Hypervisors containing the Tools
target instances (VMs)
to be monitored
Control Traffic {—————> Monitored Data Traffic ======== -

Monitored VM
G-vTap OVS Semvice L instances m

NoTe: GigaVUE Cloud Suite for OpenStack supports both the access ports and the
VLAN trunk ports for OVS traffic mirroring. To override the default values of OVS
mirror tunnel ID range, refer to Configure the OpenStack Settings.
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The UCT-Vs are deployed on the target hypervisors and the configuration file is to be
modified based on the requirements and service. GigaVUE-FM connects to UCT-V Controller
and each UCT-V Controller can talk to UCT-Vs. GigaVUE-FM identifies the interfaces to be
monitored from the monitoring session details. GigaVUE-FM mirrors and forwards the traffic
to the GigaVUE V Series nodes based on the deployed Monitoring Session.

E e UCT-V configures traffic mirroring in the OVS (with or without DPDK) and the
management of the mirrored traffic is completely based on OVS architecture and
the server.

» OVS Mirroring also supports Open vSwitch with DPDK and Open vSwitch with
Hardware offload.

» The configuration steps for OVS Mirroring, OVS Mirroring with DPDK and Open
vSwitch with Hardware offload are the same.

Refer Deploying Gigamon CloudSuite on OpenStack to scale-inand Open vSwitch with
Hardware offload and scale-out monitoring tools for more detailed information.

Cloud Overview Page

The overview page is a central location to view and monitor all the monitoring sessions in a
single place. You can use this overview page to spot issues which will help in
troubleshooting, or perform basic actions like view, edit, clone, and delete. This page
provides a quick overview of basic statistics, V Series Alarms, Connection Status and Volume
Usage vs Allowance and a table to summarize the active monitoring sessions details. You
can also edit the monitoring session from this page instead of navigating to the monitoring
session page in each platform.

You can view cloud overview page in the following ways:
Overall Cloud Overview Page

Platform specific Cloud Overview Page

Overall Cloud Overview Page

To view the Overall Cloud Overview Page, Go to Traffic > Virtual > Orchestrated Flows >
Overview

Platform specific Cloud Overview Page

To view Plaftform Specific Cloud Overview Page, Go to Traffic > Virtual > Orchestrated
Flows > and select your cloud platform.

The Monitoring Sessions page appears as shown:

Overview of GigaVUE Cloud Suite for OpenStack 14
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Monitoring Sessions

= Platform: Al ¥ Monitoring Domains: Al % New v Actions v/ Filter 1

OVERVIEW V-SERIES ALARMS By Severity CONNECTION STATUS USAGE | og
300
4/5 96 -
Critcal Faied
T T e i oo |
100% Minor. 77%
28/61 11 wa 5
CONNECTIONS V/SERIES ALARMS. > #
AGGREGATE SUMMARY
HIGHEST DAILY USAGE AVERAGE DALY USAGE 95TH PERCENTILE DALY USAGE
0 Bytes 0 Bytes 25.24 PB
HIGHEST DAILY OVERAGE AVERAGE DAILY OVERAGE IVERAGE DAILY ALLOWAIICE
T MONITORING -~ STATUS VONITORING = PLATFORM CONNECTIONS  TUNNELS NODE HEALTH  DEPLOVMENT - THRESHOLDS - TRAFFICDISTR.  PREFILIERING  PRECRV &
test - awsl AWS songyan-vpc - - @ NotDeployec - - No No
templl - aws1 AWS songyan-vpc - - @ NotDeployec - - No No 1* 3

clone-1 - aws1 AWS No connections - - - - No No

test-ms1 - md-vs1 Nutanix Cluster-E - - @ NotDeployec - - No No

For easy understanding of the Monitoring Session page, the above figure is split into three
major sections as described in the following table:

Number Section Description

1 Top Menu Top Menu

2 Charts Viewing Charts

3 Monitoring Session In Overall Cloud Overview Page, you can view the
Details monitoring session details of all the cloud platforms.

Refer to the section Viewing Monitoring Session
Details of all Cloud Platforms

In Platform specific Overview Page, you can view the
monitoring session details of the individual cloud
platforms.

Top Menu

The Top menu consists of the following: options:

Options Description

Filters You can filter the monitoring session based on a criterion or combination of criteria
such as based on the platform, monitoring session and V Series Node Id by applying
filters. For more information, refer to Filters

New Drop- | You create a new monitoring session and new monitoring domain. To create new

down list monitoring session and monitoring domain refer to Create a Monitoring Session topic.
box
Overview of GigaVUE Cloud Suite for OpenStack 15
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Options Description

Action You can do the following actions through the Action Drop down list box:
Sg(\jvpr; list « Edit - Opens the Edit page for the selected monitoring session.
box = Delete - Deletes the selected monitoring session.
» Clone - Duplicates the selected monitoring session.
« Deploy - Deploys the selected monitoring session.
« Undeploy - Un-deploys the selected monitoring session.
« Apply Threshold - Applies the threshold template created for monitoring
cloud traffic health.
« Apply Policy - Enables Precryption, Prefiltering, or Secure Tunnel.
For more information, refer to Cloud Monitoring Session topic.
Filters

You can filter the monitoring session based on a criterion or combination of criteria such as
based on the platform, monitoring session and V Series Node Id by applying filters.

You can apply the filters in two ways:
« Filter on the left corner
« Filter on the right corner

Filter on the left corner
You can view the monitoring sessions by filtering the monitoring domain based on the
platform.

1. Select the required platform from the Platform drop- down list box.

2. Click = and select the monitoring domain.
The monitoring domain selected appears on the top menu bar.

Filter on the right corner ™

You can view the monitoring sessions by filtering the monitoring domain based on a
criterion or by providing multiple criteria as follows:

=« Monitoring Session

« Status

« Monitoring Domain

« Platform

Overview of GigaVUE Cloud Suite for OpenStack 16
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« Connections
«  Tunnel
=« Deployment Status

Viewing Charts

You can view the following charts on the overview page:

* Overview

* V Series Alarms

» Connection Status
Usage (VBL)
Aggregate Summary

Overview

The overview dashboard displays the number of GigaVUE V Series Nodes active in GigaVUE-
FM, the number of Monitoring sessions and connections configured in all the platforms, and
the number of alarms triggered in V Series Nodes.

V Series Alarms

The V Series Alarms widget presents a pie chart that helps you to view the V Series alarms
generated quickly. Each type of alarm triggered is assigned a color in the graph, which is
specified by the legend. Hovering the mouse over an area in the chart displays the total
number of V Series alarms triggered.

Connection Status

The connection status presents a pie chart that helps you to quickly view the connection
status of connections configured in the monitoring domain. The success and failed
connection status is differentiated by the color in the graph, which is specified by the
legend. Hovering the mouse over an area in the chart displays the total number of
connections.

Usage

The Usage widget displays the traffic that flows through the GigaVUE V Series Nodes. Each
bar in the graph indicates the volume usage on a particular day. Hovering the mouse over a
bar in the graph displays the volume allowance and volume usage on that day.

Overview of GigaVUE Cloud Suite for OpenStack 17
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Aggregate Summary

The aggregate summary displays the highest daily volume usage, average daily volume
usage, highest daily volume over usage, average daily volume over usage, 95th percentile
daily volume usage and the average daily volume allowance.

Viewing Monitoring Session Details of all Cloud Platforms

You can view the following monitoring session details:

Details Description

Monitoring Sessions

Name of the monitoring session. When you click
the name of the session, you can view the
following options:

« View- When you click this option, you can view a split
window displaying the details of the monitoring sessions
such as Statistics, Connections, V Series Nodes, Source
Health, Http2 Logging. For more information, refer to
Viewing Monitoring Session Details of Individual Cloud
Platforms

. Edit - When you click this option, you can view the Edit
Monitoring Session page.

Status

Health status of the monitoring session.

Monitoring Domain

Name of the Monitoring Domain to which the
monitoring session is associated.

Platform

Cloud platform in which the session is created.

Connections

Connection details of the monitoring session.

Tunnels

Tunnel details related to the monitoring session

Node Health

Health of the node.

Deployment Status

Status of the deployment

Threshold Applied

Specifies whether the threshold is applied or not

Traffic Distribute

Specifies information about traffic distribution.

Prefiltering

Specifies whether Prefiltering is configured or not

Precryption

Specifies whether Precryption is configured or not.

SBI logging

Specifies whether SBI logging is configured or not.

Traffic Mirroring

Specifies whether Traffic Mirroring is configured or
not.

NoTE: Click the settings icon @ to select the columns that should appear in the

monitoring session.

Overview of GigaVUE Cloud Suite for OpenStack
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Viewing Monitoring Session Details of Individual Cloud Platforms

For a monitoring session, you can view the following details of the monitoring session:

Details Description

Statistics You can view the statistics of the incoming and outgoing traffic on
an hourly, daily, weekly, and monthly basis. You can view the
statistics for all the V Series nodes or only for the Gigamon V Series
node. You can also filter the statistics based on the elements
associated with the monitoring session. For more information, refer
to View Monitoring Session Statistics

Connections You can view the connection details of the monitoring session. You
can view details such as the name of the connection, deployment
status, number of targets, and targets source health.

V Series Nodes You can view the V Series nodes associated with the monitoring
session. You can also view details such as name of the V Series Node,
Host VPC, MD connection, Version, and Management IP.

Source Health You can view the health of the source connected to the monitoring
session.

Http2 Logging You can view the details of the 5G SBI logging details. For more
information about 5G SBI, refer to 5G-Service Based Interface
Application

To view the details, click the name of the monitoring session, and then click View. A split
window appears displaying the details.

Overview of GigaVUE Cloud Suite for OpenStack 19
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Cet Started with GigaVUE Cloud
Suite for OpenStack Deployment

This chapter describes how to configure GigaVUE® Fabric Manager (GigaVUE-FM), UCT-V
Controllers, GigaVUE V Series Proxy, and GigaVUE V Series Nodes in your OpenStack Cloud
(Project). Refer to the following sections for details:

» License Information
» Before You Begin
» Install and Upgrade GigaVUE-FM

License Information

GigaVUE Cloud Suite for OpenStack supports the Volume Based License.

Volume Based Licenses

All the GigaVUE V Series Nodes connected to GigaVUE-FM periodically report statistics on
the amount of traffic that flows through the V Series Nodes. The statistics provide
information on the actual data volume that flows through the V Series Nodes. All licensed
applications, when running on the node, generate usage statistics.

Licensing for Cloud Suite is volume-based. In the Volume-Based Licensing (VBL) scheme, a
license entitles specific applications on your V Series Nodes to use a specified amount of
total data volume over the term of the license. The distribution of the license to individual
nodes becomes irrelevant for Gigamon'’s accounting purpose. GigaVUE-FM tracks the total
amount of data processed by the various licensed applications and provides visibility on the
actual amount of data, each licensed application is using on each node, and tracks the
overuse, if any.

Volume-based licenses are available as monthly subscription licenses with a service period
of 1 month. Service period is the period of time for which the total usage or overage is
tracked. There is a grace period for each license that is encoded in the license file. The
license effectively provides data allowance for this additional time after the official end time
of the license.

For purchasing licenses with the Volume-Based License (VBL) option, contact our Sales.
Refer to Contact Sales.

Get Started with GigaVUE Cloud Suite for OpenStack Deployment 20
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Base Bundles

In volume-based licensing scheme, licenses are offered as bundles. The following three base
bundle types are available:

e CoreVUE
e NetVUE
e SecureVUEPIlus

The bundles are available as SKUs!. The number in the SKU indicates the total volume
allowance of the SKU for that base bundle. For example, VBL-250T-BN-CORE has a daily
volume allowance of 250 terabytes for CoreVUE bundle.

Bundle Replacement Policy

Refer to the following notes:

* You can always upgrade to a higher bundle but you cannot move to a lower version.

* You cannot have two different base bundles at the same time however, you can have
multiple base bundles of the same type.

» Once upgraded to a higher bundle, the existing lower bundles will be automatically
deactivated.

Add-on Packages

GigaVUE-FM allows you to add additional packages called add-on packages to the base
bundles. These add-on packages allow you to add additional applications to your base
bundles. Add-on packages have their own start/end date and volume specifications.

Rules for add-on packages:

» Add-on packages can only to be added when there is an active base bundle available in
GigaVUE-FM.

» The base bundle limits the total volume usage of the add-on package.

» If your add-on package has volume allowance less than the base bundle, then your add-
on package can only handle volume allocated for add-on package.

* When the life term of an add-on package extends beyond the base bundle, then when
the base bundle expires, the volume allowance of the add-on package will be reduced to
zero until a new base bundle is added.

For more information about SKUs refer to the respective Data Sheets as follows:

1Stock Keeping Unit. Refer to the What is a License SKU? section in the FAQs for Licenses chapter.
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GigaVUE Data Sheets

GigaVUE Cloud Suite for VMware Data Sheet

GigaVUE Cloud Suite for AWS Data Sheet

GigaVUE Cloud Suite for Azure Data Sheet

GigaVUE Cloud Suite for OpenStack

GigaVUE Cloud Suite for Nutanix

GigaVUE Cloud Suite for Kubernetes

How GigaVUE-FM Tracks Volume-Based License Usage

GigaVUE-FM tracks the license usage for each V series node as follows:

*» When you create and deploy a monitoring session, GigaVUE-FM allows you to use only
those applications that are licensed at that point (applicable only for ACTIVE licenses,
licenses in grace period are not included).

« When a license goes into grace period, you will be notified with an audit log.

* When a license expires (and has not been renewed yet), the monitoring sessions using
the corresponding license will not be undeployed.

For releases prior to 6.4:

» The monitoring sessions using the corresponding license will be undeployed (but not

deleted from the database).

e When a license is later renewed or newly imported, any undeployed monitoring
sessions are redeployed.

Manage and Activate Volume-based Licenses

To manage active Volume-based Licenses:

Get Started with GigaVUE Cloud Suite for OpenStack Deployment
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1. On the left navigation pane, click .

2. Go to System > Licenses. From the top navigation bar, select the VBL Active from the

FM/Cloud drop-down.

This page lists the following information about the active Volume-based Licenses:

Field Description

SKUs Unigue identifier associated with the license
Bundles Bundle to which the license belongs to

Volume Total daily allowance volume

Starts License start date

Ends License end date

Type Type of license (Commercial, Trial, Lab and other

license types).

Activation ID

Activation ID

Entitlement ID

Entitlement ID

NOTE: The License Type and Activation ID are displayed by default in the
VBL Active page. To display the Entitlement ID field, click on the column setting
configuration option to enable the Entitlement ID field.

The expired licenses are displayed in the VBL Inactive page, which can be found under

the FM/Cloud drop-down in the top navigation bar. This page lists the following

information about the inactive Volume-based Licenses:

Field Description

SKUs Unique identifier associated with the license.
Bundles Bundle to which the license belongs to.
Ends License end date

Grace Period

Number of days the license is in grace period

Deactivation Date

Date the license got deactivated.

Revocation Code

License revocation code.

Status

License status.

NoTE: The License Type, Activation ID and Entitlement ID fields are not
displayed by default in the VBL Inactive page. To display these fields, click
on the column setting configuration option and enable these fields.

Use the following buttons to manage your VBL.

Get Started with GigaVUE Cloud Suite for OpenStack Deployment
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Button Description

Activate Licenses Use this button to activate a Volume-based
License. Refer to Activate Volume-based Licenses
for more information.

Email Volume Usage Use this button to send the volume usage details
to the email recipients.

Filter Use this button to narrow down the list of active
Volume-based Licenses that are displayed on the
VBL active page.

Export Use this button to export the details in the VBL
active page to a CSV or XLSX file.

Deactivate Use this button to deactivate the licenses. You
can only deactivate licenses that are in grace
period or that have expired.

For more detailed information on dashboards and reports generation for Volume-based
Licensing refer to the following table:

For details about: Reference section

How to generate Volume-based License reports Generate VBL Usage Reports GigaVUE
Administration Guide

Volume-based Licensed report details Volume Based License Usage GigaVUE

Report Administration Guide
Fabric health analytics dashboards for Volume- Dashboards for Volume Based GigaVUE-FM User
based Licenses usage Licenses Usage Guide

Activate Volume-based Licenses
To activate Volume-based licenses:

1. On the left navigation pane, click .
2. Go to System > Licenses. From the top navigation bar, select the VBL Active from the
FM/Cloud drop-down.
3. Click Activate Licenses. The Activate License page appears. Perform the following
steps:
a. Download the fabric inventory file that contains information about GigaVUE-FM.
Click Next. Refer to the What is a Fabric Inventory File? section for more details.

b. Navigate to the Licensing Portal. Upload the Fabric Inventory file in the portal.
Once the fabric inventory file is uploaded, select the required license and click
Activate. A license key is provided. Record the license key or keys.

c. Return to GigaVUE-FM and add the additional licenses.
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Default Trial Licenses

After you install GigaVUE-FM, a default free 1TTB of CoreVUE trial volume-based license (VBL)

is provided one-time for 30 days (from the date of installation).

Licenses FM/Cloud Node Licenses ~ Floating > Volume Usage >

Expiry  Settings

Ll Find Search... q (&export -) (cardRMA Replace Licenses Filter
X Packet Errors and ...
10 floating licenses have expired are going to expire soon. To continue using these products, please renew your licenses, x
Port Discovery
podslobars []  sku | Feature | Type | Description | Start Date | End Date | Activation ID | Seats/Volume | Status [©)
IP Resol
esolver o BL-1T-BN-CORE-TRIAL erspan Trial 1T-AdvancedTu..  May 13,2021 Jun 12, 2021 4eBcbSad-7ebd.. 1024 GB daily Expired
Backup/Restore
| @  VBL-1T-BN-CORE-TRIAL genevesslicingm..  Trial 1T-BaseApps May 13,2021 Jun 12,2021 4e8cb5ad-7ebd.. 1024 GB daily Expired
mages
Certificates @  VBL-1T-BN-CORE-TRIAL header-stripping...  Trial 1T-HeaderStripp..  May 13,2021 Jun 12,2021 4e8cb5ad-7ebd.. 1024 GB daily Expired
Event Notifications []  SMT-HCO-GEN1-DD1-SW-TM dedup Internal HC2-GEN1-Ded..  May 14,2021 May 14, 2022 a5d70642-95eb.. SofBavailable  Grace Period
L
lcenses =] SMT-HCO0-GEN1-APF-SW-TM apf Internal HC2-GENL-APF.. May 21,2021 Never e782018-1b0f-.. 6 of 8 available Active
Logs
[J  SMT-HCO-GEN1-ASF-SW-TM asf Internal HC2-GENL-ASF..  May 21,2021 Never 24618ae4-ddb6..  1of2available  Active
Storage Managem...
> Tasks []  SMT-HCO-GEN1-HS1-SW-TM header-stripping...  Internal HC2-GEN1-HSL.. May 21,2021 Never 8d035388-013..  7ofBavailable  Active
Reports ] SMT-HCO-GEN1-NF1-SW-TM netflow Internal HC2-GEN1-Net..  May 21,2021 Never 11d3f4dd-90c6.. 7 of 8 available  Active
> Authentication [J  SMT-HCO-GEN1-SSL-SW-TM ssl-decrypt Internal HC2-GEN1-SSL..  May 21,2021 Never 30f7e2c0-aea5-.. Oof3available  Active
High Availability :
[]  SMT-HC3-GEN2-5GC-SW-TM 5G-Correlation n..  Commercial HC3-GEN2-5GC..  Apr 22,2021 Apr 22,2022 760ceb6a-c919..  1of 4 available  Expired
Tags
[]  SMT-HC3-GEN2-GTPMAX-SW-TM apfiflowrule-gtp .. Internal HC3-GEN2-GTP..  Apr 22,2021 Apr 22,2022 7228d9a9-30ac.. 4 of 4available  Expired

This license includes the following applications:

« ERSPAN
e Geneve

e Slicing

e Masking
e Trailer

e Tunneling

» Load Balancing

« Enhanced Load Balancing

* Flowmap

e Header-stripping

¢ Add header

Nodes.

NOTE: There is no grace period for the trial license. If you do not have any other
Volume-based licenses installed, then after 30 days, on expiry of the trial license, any
deployed monitoring sessions will be undeployed from the existing GigaVUE V Series

To deactivate the trial VBL refer to Delete Default Trial Licenses section for details.

Delete Default Trial Licenses

GigaVUE-FM allows you to deactivate the default trial licenses from this page. To deactivate

the license:
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1.  On the left navigation pane, cIick..
2. Go to System > Licenses >Floating. Click Activated.

3. Click Deactivate > Default Trial VBL.

The VBL trial licenses is deactivated and is no longer listed in the Activated page. However,
you can view these deactivated licenses from the Deactivated page.

Before You Begin

This section describes the requirements and prerequisites for configuring the GigaVUE
Cloud Suite for OpenStack. Refer to the following section for details.

e Supported Hypervisor

e Minimum Compute Requirements

¢ Network Requirements

¢ Virtual Network Interface Cards (VNICs)
e Security Group for OpenStack

e Create a Security Group

» Key Pairs

Supported Hypervisor

The following table lists the hypervisor with the supported versions for UCT-V.

Hypervisor Version

KVM UCT-V—Pike through Stein releases
OVS Mirroring—Rocky and above

Get Started with GigaVUE Cloud Suite for OpenStack Deployment
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Minimum Compute Requirements

In OpenStack, flavors set the vCPU, memory, and storage requirements for an image.
Gigamon recommends that you create a flavor on your choice that matches or exceeds the
minimum recommended requirements listed in the following table.

Compute Memory Disk Description

Instances Space

UCT-V 2 vCPU 4GB N/A Available as rpm or debian package.

Instances can have a single vNIC or dual vNICs
configured for monitoring the traffic.

UCT-V 1vCPU 4GB 8GB Based on the number of agents being
Controller monitored, multiple controllers will be required
to scale out horizontally.

GigaVUE V 2 vCPU 3.75GB 20GB NIC 1: Monitored Network IP; Can be used as
Series Node Tunnel IP

NIC 2: Tunnel IP (optional)
NIC 3: Management IP

GigaVUE V 1vCPU 4GB 8GB Based on the number of GigaVUE V Series
Series Proxy nodes being monitored, multiple controllers will
be required to scale out horizontally

GigaVUE-FM 4 vCPU 8GB 40GB GigaVUE-FM must be able to access the
controller instance for relaying the commmands.
Use a flavor with a root disk of minimum 40GB
and an ephemeral disk of minimum 41GB.

The instance size of the GigaVUE V Series is configured and packaged as part of the gcow?2
image file.

Get Started with GigaVUE Cloud Suite for OpenStack Deployment 27
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Network Requirements

The following table lists the recommmended requirements to setup the network topology.

Network Purpose

Management Identify the subnets that GigaVUE-FM uses to communicate with the
GigaVUE V Series nodes and controllers.

Data Identify the subnets that receives the mirrored tunnel traffic from the
monitored instances.

In data network, if a tool subnet is selected then the V Series node egress
traffic on to the destinations or tools.

NoTE: If you are using IPv6 in the tenant network, then it is recommended to use
SLAAC or stateless DHCPv6 for dynamic address assignment.

Get Started with GigaVUE Cloud Suite for OpenStack Deployment
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Virtual Network Interface Cards (vNICs)

OpenStack Cloud Instances with UCT-V can be configured with one or more vNICs.

« Single VNIC—If there is only one interface configured on the instance with the UCT-V,

the UCT-V sends the mirrored traffic out using the same interface.

« Multiple VNICs—If there are two or more interfaces configured on the instance with the
UCT-V, the UCT-V monitors any number of interfaces. It provides an option to send the
mirrored traffic out using any one of the interfaces or using a separate, non-monitored
interface. When multiple interfaces are added to the controller, floating IP is used to
make the first interface as management interface.

NoTE: VNICs are only applicable if the UCT-V is installed on the instances being
monitored. It is not applicable for OVS Mirroring or OVS Mirroring +DPDK.

Security Group for OpenStack

A security group defines the virtual firewall rules for your instance to control inbound and
outbound traffic. When you launch GigaVUE-FM, GigaVUE V Series Proxies, GigaVUE V Series

Nodes, and UCT-V Controllers in your project, you add rules that control the inbound traffic

to instances, and a separate set of rules that control the outbound traffic.

The Security Group Rules table lists the rules and port numbers for each component.

Direction Ether Protocol Port Purpose
Type
GigaVUE-FM
Inbound HTTPS TCP 443 Any IP Allows users to connect to the
address GigaVUE-FM GUI.
Inbound IPv4 UbP 53 Any IP Allows GigaVUE-FM to
address communicate with standard DNS
server
Inbound Custom TCP 5671 GigaVUE V Allows GigaVUE V Series Nodes to
TCP Rule Series Node IP | send traffic health updates to
GigaVUE-FM
Allows Next Generation UCT-V to
send statistics to GigaVUE-FM.
Outbound Custom TCP 8890 V Series Proxy | Allows GigaVUE-FM to
(optional) TCP Rule 1P communicate with V Series Proxy
Outbound Custom | TCP 8889 GigaVUE V Allows GigaVUE-FM to
TCP Rule Series Node IP | communicate with V Series node

Get Started with GigaVUE Cloud Suite for OpenStack Deployment

Before You Begin

29



GigaVUE Cloud Suite Deployment Guide - OpenStack

Direction

Ether

Type

Protocol

Port

Purpose

UCT-V Controller

Inbound Custom | TCP 9900 Custom Allows GigaVUE-FM to
TCP Rule GigaVUE-FM communicate with UCT-V
I= Controllers
Inbound Custom | TCP(6) 8891 UCT-V or Allows UCT-V Controller to
(This is the port | TCP Rule Subnet IP communicate the registration
used for Third requests from UCT-V and forward
Party the same to GigaVUE-FM.
Orchestration)
Outbound Custom | TCP(o6) 443 GigaVUE-FM | Allows UCT-V Controller to
(This is the port TCP Rule 1P communicate the registration
used for Third requests to GigaVUE-FM
Party
Orchestration)
Outbound Custom | TCP 5671 GigaVUE-FM | Allows UCT-V Controller to send
TCP Rule 1P traffic health updates to
GigaVUE-FM
UCT-V
Inbound Custom TCP 9901 Custom Allows UCT-V Controllers to
TCP Rule UCT-V communicate with UCT-Vs
Controller IP
Outbound Custom TCP(o) 8891 UCT-V or Allows UCT-V to communicate with
(This is the port TCP Rule Subnet IP UCT-V Controller for registration and
used for Third Heartbeat
Party
Orchestration)
Outbound Custom TCP N443 UCT-V subnet | Allows UCT-V to securely transfer
TCP Rule the traffic to GigaVUE V Series Node
UCT-V OVS Controller
Inbound Custom | TCP 9900 Custom Allows GigaVUE-FM to
TCP Rule GigaVUE-FM | communicate with UCT-V OVS
I= Controllers
UCT-V OVS Agent
Inbound Custom | TCP 9901 Custom Allows UCT-V OVS Controllers to
TCP Rule UCT-V OVS communicate with UCT-V OVS

Agents

Get Started with GigaVUE Cloud Suite for OpenStack Deployment
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Port

Purpose

Controller IP
GigaVUE V Series Proxy
Inbound IPv4 TCP 8890 GigaVUE-FM | Allows GigaVUE-FM to
IP address communicate with GigaVUE Cloud
Suite V Series Proxys.
Outbound Custom | TCP 8889 GigaVUE V Allows V Series Proxy to
TCP Rule Series Node IP | communicate with GigaVUE V
Series Nodes
GigaVUE V Series Node
Inbound Custom | TCP(6) 8889 GigaVUE V Allows GigaVUE V Series Proxys to
TCP Rule Series Proxy communicate with GigaVUE V
IP address Series nodes
Outbound IPv4 TCP 8890 GigaVUE-FM | Allows GigaVUE V Series Node to
IP address communicate with GigaVUE V
Series Proxy
Outbound Custom UbP « VXLAN Tool IP Allows V Series node to
UDP Rule (default communicate and tunnel traffic to
4789) the Tool
« L2GRE
(IP 47)
Outbound Custom TCP 5671 GigaVUE-FM | Allows GigaVUE V Series Node to
TCP Rule 1P send traffic health updates to
GigaVUE-FM
Bi-directional Custom TCP N443 GigaVUE V Allows to securely transfer the traffic
TCP Rule Series Node in between GigaVUE V Series Nodes.
subnet
NoTE: The Security Group Rules table lists only the ingress rules. Make sure the
egress ports are open for communication. Along with the ports listed in the Security
Group Rules table, make sure the suitable ports required to communicate with
Service Endpoints such as Identity, Compute, and Cloud Metadata are also open.

Key Pairs

A key pair consists of a public key and a private key. You must create a key pair and select
the name of this key pair when you launch the UCT-V Controllers, GigaVUE V Series nodes,
and GigaVUE V Series Controllers from GigaVUE-FM. Then, you must provide the private key
to connect to these instances. For information about creating a key pair, refer to OpenStack
documentation.

Get Started with GigaVUE Cloud Suite for OpenStack Deployment
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Prerequisites for OVS Mirroring

This section is only applicable if you which to use OVS Mirroring as your traffic acquisition
method. The following items are required to deploy a UCT-V OVS agent:

» An existing OpenStack cloud environment should be available with admin project and
login credentials to create a monitoring domain.

e A user with OVS access is required to enable OVS-Mirror. The user can be an admin or can
be a user with a custom role that has the permissions and the ability to list projects.

« A working GigaVUE-FM with latest build.

OpenStack Cloud Environment Requirements

¢ ML2 mechanism driver: Open vSwitch.

* You must have the following role privileges as shown in the table for the respective files to
enable OVS mirroring:

Ml File Command

/etc/nova/policy.js "os compute api:os-hypervisors": "role:gigamon",
on "os compute api:servers:detail:get all tenants": "role:gigamon",
"os compute api:servers:index:get all tenants": "role:gigamon",

”ewn

"os_compute api:servers:allow all filters role:gigamon",

7 ew

“os compute api:os-extended-server-attributes role:gigamon”

/eujkeysnane/poﬁ "identity:list projects": "role:admin or role:gigamon",
cy.json "identity:1list user projects": "role:admin or role:gigamon or
rule:owner",
"identity:1list users": "role:admin or role:gigamon"
/etc/neutron/poli "context is advsvc": "role:advsvc or role:gigamon",
cy.json "get subnet": "rule:admin or owner or rule:shared or
role:gigamon",
"get network": "rule:admin or owner or rule:shared or
rule:external or rule:context is advsvc”,
"update floatingip": "rule:admin or owner or role:gigamon",
"get floatingip": "rule:admin or owner or role:gigamon",
"get security groups": "rule:admin or owner or role:gigamon",
"get security group": "rule:admin or owner or or role:gigamon",
"get port": "rule:context is advsvc or rule:admin owner or

network owner",

"get port:binding:vif details”:“rule:admin only or rule:context
is _gigamon”

¢ Here are the APIs and commands required for OVS mirroring

OpenStack CLI Supported Description
command API/Action
openstack hypervisor GET /os-hypervisors Should list all hypervisors in the domain.
list
openstack server list -- GET /servers Should list all the servers on a specified host
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Supported
API/Action

Description

openstack server list-all | GET /servers Should list servers of all projects in the
domain.

openstack project list GET N3/projects Should list all projects in the domain.

openstack project list - GET N3/projects Should list all projects that a specified user

user <user with custom (user specified in FM config) is associated with

role>

openstack user GET N3/users Should list all users by username

show <userName>

openstack subnet list GET /subnets Should list all subnets for all projects in the
domain.

openstack network list | GET /network Should list all networks for all projects in the

domain.

openstack floating ip
list

GET /floatingips

Should list all floating ips for all projects in the
domain.

openstack floating ip
set-port <portid>
<floating ip>

PUT /floatingips/
{floatingip_ID}

Used to attach floating ip to fabric nodes.

openstack security
group list

GET /security-groups

Should list security groups for all projects in
the domain

openstack security
group show <security
group id>

GET /security-groups/
{security_group_id}

Should list details of specified security group

openstack port list

GET /ports

Should list ports for all projects in the domain

openstack port show
<portID>

GET /ports/{portID}

Should list port details including bridge
name.

openstack server POST /servers Launch fabric nodes

Create

openstack server POST /servers/{server_ stop/start/reboot fabric nodes
id}/action

<action>
<serverName>

openstack server
delete
<serverName>

DELETE /servers/{server|D}

Delete fabric nodes

openstack server
set

PUT /servers/
{serverID}/metadata

Update fabric node metadata

Get Started with GigaVUE Cloud Suite for OpenStack Deployment
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OpenStack CLI
command

openstack flavor list

Supported
API/Action

GET /flavors

Description

Get list of flavors

openstack
availability zone list

GET /os-availability-zone

Get list of availability zones

openstack keypair
list

GET /os-keypairs

Get list of keypairs

o key:value

E If the OpenStack CLI commmand openstack hypervisor list does not return a reachable
|P for the hypervisors that are being monitored, you must manually enter a reachable
|P for each hypervisor in OpenStack CLI using project properties. For each hypervisor
you will need to add a key value pair property in the following format:

* key: must be in the form gigamon-hv-<hypervisor|D>
» value: reachable IP for hypervisor

For exam pIe: openstack project set --property gigamon-hv-1=1.2.3.4 project-name

Default Login Credentials

You can login to the GigaVUE V Series Node, GigaVUE V Series proxy, and UCT-V Controller

by using the default credentials.

Product Login credentials

Node and
GigaVUE V Series

proxy

Username: gigamon

Password: Gigamon123!

GigaVUE V Series | You can login to the GigaVUE V Series Node and GigaVUE V Series proxy
by using ssh. The default username and password is:

Username: gigamon

Password: Gigamon123!

UCT-V Controllers | You can login to the UCT-V Controller by using ssh. The default username
and password is:

Get Started with GigaVUE Cloud Suite for OpenStack Deployment
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Install and Upgrade GigaVUE-FM

You can install and upgrade the GigaVUE Cloud Suite® Fabric Manager (GigaVUE-FM) on
cloud or on-premises. You can also upgrade GigaVUE-FM deployed in OpenStack
environment.

Cloud—To install GigaVUE-FM inside your OpenStack environment, you can simply

launch the GigaVUE-FM instance in your Project. For installing the GigaVUE-FM
instance, refer to Install GigaVUE-FM on OpenStack

NOTE: You cannot upgrade your 5.7.00 or lower versions of the GigaVUE-FM instance
deployed in OpenStack environment to GigaVUE-FM 5.8.00 or higher versions. You
must perform a fresh installation of GigaVUE-FM 5.8.00 or higher versions.

On-premises—To install and upgrade GigaVUE-FM in your enterprise data center, refer
to GigaVUE-FM Installation and Upgrade Guide available in the Gigamon
Documentation Library.

Install and Upgrade GigaVUE-FM
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Deploy GigaVUE Cloud Suite for
OpenStack

This chapter describes how to connect, launch, and deploy fabric components of GigaVUE
Cloud Suite for OpenStack in your OpenStack environment.

Refer to the following sections for details:

» Upload Fabric Images

* Prepare UCT-V to Monitor Traffic

* Pre-Configuration Checklist

¢ Create Monitoring Domain

e Configure GigaVUE Fabric Components in GigaVUE-FM

e Configure GigaVUE Fabric Components in OpenStack

» Upgrade GigaVUE Fabric Components in GigaVUE-FM for OpenStack

Refer to the following Gigamon Validated Designs for more detailed information:

» Deploying V Series 2 visibility solution for OpenStack
» Gaining Visibility and Optimizing the Traffic Between Containerized Workloads for
Seamless Monitoring

Deployment Options for GigaVUE Cloud Suite for
OpenStack

This section provides a detailed information on the multiple ways in which GigaVUE Cloud
Suite for OpenStack can be configured to provide visibility for physical and virtual traffic.
There are four different ways in which GigaVUE Cloud Suite for OpenStack can be
configured based on the traffic acquisition method and the method in which you want to
deploy fabric components. Refer to theBefore You Begin topic for minimum requirements
and prerequisites. For more detailed information and work flow refer the following topics:

» Deploy GigaVUE Fabric Components using OpenStack

¢ Deploy GigaVUE Fabric Components using GigaVUE-FM
e Traffic Acquisition Method as UCT-V
e Traffic Acquisition Method as OVS Mirroring
» Traffic Acquisition Method as Tunnel

Deploy GigaVUE Cloud Suite for OpenStack
Deployment Options for GigaVUE Cloud Suite for OpenStack
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Deploy GigaVUE Fabric Components using OpenStack

GigaVUE-FM allows you to use OpenStack as an orchestrator to deploy GigaVUE fabric
nodes and then use GigaVUE-FM to configure the advanced features supported by these
nodes. Refer the following table for the step-by-step instructions.

Step No | Task Refer the following topics
1 Install GigaVUE-FM on OpenStack Install GigaVUE-FM on OpenStack
2 Install UCT-Vs For Linux: Linux UCT-V Installation
NoTE: When using OpenStack as your orchestration For Wmf:lows: Windows UCT-V
Installation
system you can only use G-TAP Agents.
3 Create a Monitoring Domain Create Monitoring Domain
NoTE: Ensure that the Use FM to Launch Fabric
toggle button is disabled.
4 Configure GigaVUE Fabric Components Configure GigaVUE Fabric

NoOTE: Select UCT-V as the Traffic Acquisition Method.

Components in OpenStack

Create Monitoring session

Create a Monitoring Session

Add Applications to the Monitoring Session

Add Applications to Monitoring
Session

Add Applications to Monitoring
Session

Deploy Monitoring Session

Deploy Monitoring Session

View Monitoring Session Statistics

View Monitoring Session Statistics

Deploy GigaVUE Fabric Components using GigaVUE-FM

If you wish to deploy your fabric components using GigaVUE-FM, it can done is three ways
based on the traffic acquisition method you chose.

Traffic Acquisition Method as UCT-V

Follow instruction in the below table if you wish to use UCT-V as your traffic acquisition
method. In this case the traffic from the Virtual Machines are acquired using the UCT-Vs and
it is sent to the V Series nodes.

Step No | Task Refer the following topics
1 Install GigaVUE-FM on OpenStack Install GigaVUE-FM on OpenStack
2 Install UCT-Vs For Linux: Linux UCT-V Installation

For Windows: Windows UCT-V
Installation

Deploy GigaVUE Cloud Suite for OpenStack
Deployment Options for GigaVUE Cloud Suite for OpenStack
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Step No | Task Refer the following topics

3 Create a Monitoring Domain Create Monitoring Domain

NoTE: Ensure that the Use FM to Launch Fabric
toggle button is enabled.

4 Configure GigaVUE Fabric Components Configure GigaVUE Fabric
Components in GigaVUE-FM

NoTE: Select UCT-V as the Traffic Acquisition

Method.
Create Monitoring session Create a Monitoring Session
6 Add Applications to the Monitoring Session Add Applications to Monitoring Session
Add Applications to Monitoring Session
Deploy Monitoring Session Deploy Monitoring Session
View Monitoring Session Statistics View Monitoring Session Statistics

Traffic Acquisition Method as OVS Mirroring

Follow instruction in the below table if you wish to use OVS Mirroring as your traffic
acquisition method. Open vSwitch Mirroring Agent is deployed on the hypervisor where the
Virtual Machines you wish to monitor are located. Refer to the Prerequisites for

OVS Mirroring topic for OpenStack cloud requirements before using OVS Mirroring as your
traffic acquisition type.

Step No | Task Refer the following topics
1 Install GigaVUE-FM on OpenStack Install GigaVUE-FM on OpenStack
2 Install UCT-V OVS Agents Install UCT-V OVS Agent for

OVS Mirroring

3 Create a Monitoring Domain Create Monitoring Domain

NoTE: Ensure that the Use FM to Launch Fabric
toggle button is enabled.

4 Configure GigaVUE Fabric Components Configure GigaVUE Fabric
Components in GigaVUE-FM

NoTE: Select OVS Mirroring as the Traffic Acquisition

Method.
Create Monitoring session Create a Monitoring Session
6 Add Applications to the Monitoring Session Add Applications to Monitoring Session
Add Applications to Monitoring Session
Deploy Monitoring Session Deploy Monitoring Session
View Monitoring Session Statistics View Monitoring Session Statistics
Deploy GigaVUE Cloud Suite for OpenStack 38
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Traffic Acquisition Method as Tunnel

Follow instruction in the below table if you wish to use Tunnel as your traffic acquisition
method. In this case you can use tunnels as a source where the traffic is directly tunneled to
V Series nodes without deploying UCT-Vs or UCT-V Controllers.

Step No | Task Refer the following topics
1 Install GigaVUE-FM on OpenStack Install GigaVUE-FM on OpenStack
2 Create a Monitoring Domain Create Monitoring Domain

NoTE: Ensure that the Use FM to Launch Fabric
toggle button is enabled.

3 Configure GigaVUE Fabric Components Configure GigaVUE Fabric
Components in GigaVUE-FM

NOTE: Select Tunnel as the Traffic Acquisition

Method.
4 Create Monitoring session Create a Monitoring Session
Create Ingress and Egress Tunnel Endpoints Create Ingress and Egress Tunnels
6 Add Applications to the Monitoring Session Add Applications to Monitoring Session
Add Applications to Monitoring Session
Deploy Monitoring Session Deploy Monitoring Session
View Monitoring Session Statistics View Monitoring Session Statistics

Upload Fabric Images

First, you must fetch the images from Gigamon Customer Portal using FTP, SCP, or other
desired method and copy it to your cloud controller. After fetching the images, you must
source the credentials file and then upload the gcow2 images to Glance.

For example, you can source the credentials file with admin credentials using the following
command:

$ source admin_openrc.sh
To upload the qcow2 images to Glance, use one of the following commands:

glance image-create --disk-format qcow2 --visibility public --container- format bare --progress -
name gigamon-gigavue-vseries-proxy-N -file gigamon-gigavue-proxy-cntir-N.qcow2

Or

openstack image create --disk-format qcow2 --public --container-format bare --file gigamon-
gigavue-vseries-proxy-N gigamon-gigavue-vseries-proxy-N.qcow2

While uploading images to OpenStack, the names of the image files should be of the
following format:

Deploy GigaVUE Cloud Suite for OpenStack 39
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e gigamon-gigavue-vseries-node-6.5

* gigamon-gigavue-vseries-proxy-6.5
e gigamon-gigavue-uctv-cntlr-6.5

e gigamon-gigavue-uctv-ovs-cntlr-6.5

Deploy GigaVUE Cloud Suite for OpenStack
Upload Fabric Images
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Install GigaVUE-FM on OpenStack

To launch the GigaVUE-FM instance inside the cloud:

1. Log into Horizon.

2. From the Horizon GUI, select the appropriate project, and select Compute > Images.
The list of existing images is displayed.

3. Select the GigaVUE-FM image and click Launch. The Launch Instance dialog box is
displayed.

4. In the Details tab, enter the following information and Click Next.

Parameter Attribute

Instance Name Initial hostname for the instance
Availability Zone Availability zone where the image will be deployed.
Count Number of instances to be launched

5. In the Source tab, verify that the selected GigaVUE-FM image is displayed under
Allocated section and click Next.

6. In the Flavor tab, select a flavor complying the Minimum Compute Requirements and
then move the flavor from the Available section to the Allocated section. The selected
GigaVUE-FM flavor is displayed under Allocated and click Next.

7. In the Networks tab, select the specific network for the GigaVUE-FM instance from the
Available section and then move the Network to the Allocated section. The selected
network is displayed under Allocated and Click Next.

8. In the Network Ports tab, click Next again.

9. In the Security Groups tab, select the appropriate security group for the GigaVUE-FM
instance from the Available section and then move the Security Group to the
Allocated section. For information about the security groups, refer to Security Group
for OpenStack . The selected security group is displayed under Allocated. Click Next.

10. In the Key Pair tab, select the existing key pair from the Available section and then
move the Key Pair to the Allocated section. or create a new key pair. For information
about the key pairs, refer to Key Pairs. The selected key pair is displayed under
Allocated. Click Next.

11. Click Launch Instance. The GigaVUE-FM instance takes few minutes to fully initialize.

12. From the Horizon GUI, navigate to Compute > Instances. You can view the launched
instance displayed in the Instances page. During the initial boot-up sequence, click
Associate Floating IP. The Manage Floating IP Associations dialog box appears.
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13. In the Manage Floating IP Associations dialog box, enter the following information and
click Associate.

Parameter Attribute

IP Address Floating IP address of the instance

Port to be associated Port for the GigaVUE-FM instance
The Floating IP is then displayed in the IP Address column of the corresponding
Instance.

Deploy GigaVUE Cloud Suite for OpenStack
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After you have deployed a new GigaVUE-FM instance, you need to perform an initial
configuration before you can start using GigaVUE-FM. This is a one-time activity that must
be performed for each GigaVUE-FM instance deployed.

1.
2.

From the Horizon GUI, navigate to Compute > Instances.

In the Instances page, click the GigaVUE-FM instance name. The GigaVUE-FM instance
Overview tab is displayed by default.

Click the Console tab and the Instance Console appears.

Log in as admin with password as admin123All and then the console prompts you to
change the default password.

CentOS Linux 7V (Core)
Kernel 3.18.8-16862.9.1.el17.=x86_641 on an x86_64

123 login:

CentOS Linux 7V (Core)
Kernel 3.18.8-16862.9.1.el17.=x86_641 on an x86_64

123 login: admin

Password:

You are required to change your password immediately (root enforced)
Changing password for admin.

(current) UNIX password:

New password:

Retype new password:

[admin@1Z23 ~15

NOTE: You can also choose to perform the IP Networking and NTP
configurations by running the fmctl jump-start command after you power on
the GigaVUE-FM instance

5. To access GigaVUE-FM GUI, enter wget -q -O - http://169.254.169.254/latest/meta-

Deploy GigaVUE Cloud Suite for OpenStack

data/instance-id command in the Instance Console and retrieve the instance ID in the
format of i-000000## which is the default password for the admin user. If GigaVUE-FM
is deployed inside OpenStack, use the Instance ID as the password for the admin user
to login to GigaVUE-FM, however if GigaVUE-FM is deployed outside OpenStack, use
admin123All as the default admin password.
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Prepare UCT-V to Monitor Traffic

UCT-V is a tiny footprint user-space agent (UCT-V) that is deployed on each instance that
you want to monitor. This agent mirrors the selected traffic from a source interface to a
destination mirror interface. The mirrored traffic is encapsulated using GRE or VXLAN

tunneling and then sent to the GigaVUE V Series node.

NoTE: The UCT-V installation is applicable only when the UCT-V is your traffic
acquisition method.

A source interface can be configured with one or more vNIC. While configuring a source
interface, you can specify the direction of the traffic to be monitored in the instance. The

direction of the traffic can be egress or ingress or both.

Refer to the following sections for more information:

e Linux UCT-V Installation
» Install UCT-V OVS Agent for OVS Mirroring
o Windows UCT-V Installation

Supported Operating Systems for UCT-V
Supported Operating System for UCT-V! is v6.4.00, 6.5.00

Supported Operating Systems for G-vTAP Agents are v1.8-3, v1.8-4, v1.8-5, v1.8-7, v6.1.00, v6.2.00,

v6.3.00

The below table lists the validated and the supported versions of the Operating Systems for UCT-V.

Operating System

Supported Versions

Validated Versions

Ubuntu/Debian

Versions 18-04 and above are

Versions 16.04 and 20.04

supported.
CentOS Versions 7.5 and above. Versions 7.9 and 8.2
Fedora Versions 7.5 and above. Versions 7.5
RHEL Versions 7.5 and above. Versions 8.8 and 9.2

Windows Server

Versions 2012 through 2022

Versions 2022

Windows Client

Versions 10 and 11

Versions 10 and 11

Amazon Linux

Versions 1and 2 (For version 2, package
iproute-tc must be installed first)

NA

Rocky OS

Versions 8.4 and above

Versions 8.5 and 8.8

TFrom Software version 6.4.00, G-VTAP Agent is renamed to UCT-V.

Prepare UCT-V to Monitor Traffic
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GigaVUE-FM version 6.5 supports UCT-V version 6.5 as well as (n-2) versions. It is always
recommended to use the latest version of UCT-V with GigaVUE-FM, for better compatibility.

Linux UCT-V Installation

Refer to the following sections for Linux agent installation:

» Single vNIC Configuration
» Multiple vNICs Configuration
e Install UCT-Vs

Single vNIC Configuration

A single NIC/VNIC acts both as the source and the destination interface. A UCT-V with a
single NIC/VNIC configuration lets you monitor the ingress or egress traffic from the
NIC/VNIC. The monitored traffic is sent out using the same NIC/vNIC.

For example, assume that there is only one interface ethO in the monitoring VM. In the UCT-
V configuration, you can configure ethO as the source and the destination interface, and
specify both egress and ingress traffic to be selected for monitoring purpose. The egress and
ingress traffic from ethO is mirrored and sent out using the same interface.

NoTE: Using a single NIC/VNIC as the source and the destination interface may cause
increased latency in sending the traffic out from the VM.

Example of the UCT-V config file for a single NIC/VNIC configuration:

Grant permission to monitor ingress and egress traffic at iface

# ethoO mirror-src-ingress mirror-src-egress mirror-dst
Multiple vNICs Configuration

A UCT-V lets you configure multiple vNICs. One or many vNICs can be configured as the
source interface. The monitored traffic can be sent out using any one of the vNICs or using a
separate, non-monitored vNIC.

For example, assume that there is ethO and ethl in the monitoring instance. In the UCT-V
configuration, ethO can be configured as the source interface and egress traffic can be
selected for monitoring purpose. The ethl interface can be configured as the destination
interface. So, the mirrored traffic from ethO is sent to ethl. From ethl, the traffic is sent to the
GigaVUE V Series node.

Install UCT-Vs

You must have sudo/root access to edit the UCT-V configuration file.
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For dual or multiple NIC/ENI configuration, you may need to modify the network
configuration files to make sure that the extra NIC/ENI will initialize at boot time.

E Before installing UCT-V .deb or .rpm packages on your Linux VMs, you must install
packages like Python3 and Python modules (netifaces, urllib3, and requests).

You can install the UCT-Vs either from Debian or RPM packages.

Refer to the following topics for details:

 Install UCT-V from Ubuntu/Debian Package
e Install UCT-V from RPM package
e |nstall UCT-V from Red Hat Enterprise Linux and CentOS with Selinux Enabled

Install UCT-V from Ubuntu/Debian Package

To install from a Debian package:
1. Download the UCT-V 6.5.00 Debian (.deb) package from the Gigamon Customer
Portal. For assistance contact Contact Technical Support.

2. Copy this package to your instance. Install the package with root privileges, for
example:

~$ 1ls gigamon-gigavue uctv_6.5.00_amd64.deb
~$ sudo dpkg -i gigamon-gigavue uctv_6.5.00_amd64.deb

Prepare UCT-V to Monitor Traffic
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3. Once the UCT-V package is installed, modify the file /fetc/uctv/uctv.conf to configure
and register the source and destination interfaces. The following examples registers
ethO as the mirror source for both ingress and egress traffic and ethl as the destination
for this traffic:

NoOTE: Any changes to the UCT-V config file made after the initial setup require
an UCT-V restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

Example 1—Configuration example to monitor ingress and egress traffic at interface
ethO and use the same interface to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress mirror-dst

Example 2—Configuration example to monitor ingress and egress traffic at interface
ethO and use the interface ethl to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress
# ethl mirror-dst

Example 3—Configuration example to monitor ingress and egress traffic at interface
ethO and eth 1; use the interface ethl to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress
# ethl mirror-src-ingress mirror-src-egress mirror-dst

4. Save the file.

5. To enable the third-party orchestration, a configuration file /fetc/gigamon-cloud.conf
needs to be created with the following contents:

Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: orchestration
password: orchestrationl23A!
remoteIP: <IP address of UCT-V Controller 1, IP address of UCT-V

Controller2>
remotePort: 8891

6. Reboot the instance.

The UCT-V status will be displayed as running. Check the status using the following
command:

~$ sudo /etc/init.d/uctv status

Install UCT-V from RPM package

To install from an RPM (.rpm) package on a Redhat, CentOS, or other RPM-based system:
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1.

Download the UCT-V 6.5.00 RPM (.rpm) package from the Gigamon Customer Portal.
For assistance contact Contact Technical Support.
Copy this package to your instance. Install the package with root privileges, for
example:

$ ls gigamon-gigavue uctv_6.5.00_x86_ 64.rpm

$ sudo rpm -igigamon-gigavue uctv_6.5.00_x86_64.rpm
Modify the file /ete/uctv/uctv.conf to configure and register the source and
destination interfaces.The following example registers the ethO as the mirror source for
both ingress and egress traffic and registers ethl as the destination for this traffic as
follows:

NoOTE: Any changes to the UCT-V config file made after the initial setup require
an agent restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

Example 1—Configuration example to monitor ingress and egress traffic at interface
ethO and use the same interface to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress mirror-dst

Example 2—Configuration example to monitor ingress and egress traffic at interface
ethO and use the interface ethl to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress# ethl mirror-dst

Example 3—Configuration example to monitor ingress and egress traffic at interface
ethO and eth 1; use the interface ethl to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress# ethl mirror-src-
ingress mirror-src-egress mirror-dst

Save the file.

To enable the third-party orchestration, a configuration file /etc/gigamon-cloud.conf
needs to be created with the following contents:

Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: orchestration
password: orchestrationl23A!
remoteIP: <controller list IP addresses separated by comma>
remotePort: 8891

6. Reboot the instance.

Check the status with the following command:

$ sudo service uctv status
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UCT-V is running

Install UCT-V from Red Hat Enterprise Linux and CentOS with Selinux Enabled

This section provides instructions on how to install UCT-V on Red Hat and CentOS.

Prerequisites:

» For multiple NIC/ENI configuration, you might have to to modify the network
configuration files to make sure that the extra NIC/ENI will initialize at boot time.

* Install the packages Python3 and Python modules such as netifaces, urllib3, and requests.
* The packages iproute-tc, tc is required for RHEL and CentOS VMs.
« You must have sudo/root access to edit the UCT-V configuration file.

e You must ensure that the port 9901 is allowed in the Firewall. This port is required for the
communication between UCT-V and UCT-V Controller.

To install UCT-V on Redhat, CentOS, or other RPM-based system using the RPM package,
perform the following steps:

1. Download the following packages from the Gigamon Customer Portal:
e gigamon-gigavue_uctv_6.5.00_x86_64.rpm

2. Copy the downloaded UCT-V package files to UCT-V.

3. Install UCT-V package:

sudo rpm -ivh gigamon-gigavue uctv_6.5.00_x86 64.rpm

4. Edit the uctv.conf file to configure the required interface as source/destination for
mirror:

NoTE: If you make any changes to the UCT-V agent config file after the initial
setup, you need to restart the UCT-V and refresh or synchronize the inventory
from GigaVUE-FM to reflect the changes and start traffic mirroring again.
However, if you have an ongoing monitoring session that is active and
functioning well, modifying the UCT-V config file can cause traffic to be lost
until GigaVUE-FM performs an automatic synchronization every 15 minutes.

# eth0 mirror-src-ingress mirror-src-egress mirror-dst
# sudo systemctl status uctv

5. Reboot the instance.
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Windows UCT-V Installation

Windows UCT-V allows you to select the network interfaces by subnet/CIDR and modify the
corresponding monitoring permissions in the configuration file. This gives you more
granular control over what traffic is monitored and mirrored.

VXLAN is the only supported tunnel type for Windows UCT-V.
Windows UCT-V Installation Using MSI Package

To install the Windows UCT-V using the MSI file:

1. Download the Windows UCT-V 6.5.00 MSI package from the Gigamon Customer
Portal. For assistance contact Contact Technical Support.

2. Install the downloaded MSI package as Administrator and the UCT-V service starts
automatically.
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3. Once the UCT-V package is installed, modify the file C:\ProgrambData\Uct-v\uctv.conf
to configure and register the source and destination interfaces.

NOTE: Any changes to theUCT-V config file made after the initial setup require
an UCT-V restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

E Following are the rules to modify the UCT-V configuration file:
» Interface is selected by matching its CIDR address with config entries.
» For the VMs with single interface:

° if neither mirror-src permissions is granted to the interface, both mirror-
src-ingress and mirror-src-egress are granted to it.

° mirror-dst is always granted implicitly to the interface.

e For the VMs with multiple interfaces:

° mirror-dst needs to be granted explicitly in the config file. Only the first
matched interface is selected for mirror-dst, all other matched interfaces
are ignored.

° if none interfaces is granted any mirror-src permission, all interfaces will
be granted mirror-src-ingress and mirror-src-egress.

Example 1—Configuration example to monitor ingress and egress traffic at interface
192.168.1.0/24 or 2001:db8:abcd:ef01::/64 and use the same interface to send out the
mirrored packets.

For IPv4:
# 192.168.1.0/24 mirror-src-ingress mirror-src-egress mirror-dst
For IPvé:

2001:db8:abcd:ef01::/64 mirror-src-ingress mirror-src-egress
2001:db8:abcd:ef01::/64 mirror-src-egress

2001:db8:abcd:ef01::/64 mirror-dst

Example 2—Configuration example to monitor ingress and egress traffic at interface
192.168.1.0/24 or 2001:db8:abcd:ef01::/64 and use the interface 192.168.2.0/24 to send out
the mirrored packets.

For IPv4:
# 192.168.1.0/24 mirror-src-ingress mirror-src-egress

# 192.168.2.0/24 mirror-dst
For IPv6

2001:db8:abcd:ef01::/64 mirror-src-ingress mirror-src-egress
2001:db8:abcd:ef02::/64 mirror-src-egress
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2001:db8:abcd:ef01::2/64 mirror-dst
4. Save the file.

5. To enable the third-party orchestration, a configuration file
C:\ProgramData\uctv\gigamon-cloud.conf needs to be created with the following
contents:

Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: orchestration
password: orchestrationl23A!
remoteIP: <controller list IP addresses separated by comma>
remotePort: 8891

6. To restart the Windows UCT-V, perform one of the following actions:
* Restart the VM.
e Run 'sc stop uctv' and 'sc start uctv' from the command prompt.
¢ Restart the UCT-V from the Windows Task Manager.

You can check the status of the UCT-V in the Service tab of the Windows Task Manager.
Windows UCT-V Installation Using ZIP Package

To install the Windows UCT-V using the ZIP package:

1. Download the Windows UCT-V 6.5.00 ZIP package from the Gigamon Customer
Portal. For assistance contact Contact Technical Support.
2. Extract the contents of the .zip file into a convenient location.

3. Run ‘install.bat’ as an Administrator and the UCT-V service starts automatically.

Prepare UCT-V to Monitor Traffic
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4. Once the UCT-V package is installed, modify the file C:\ProgrambData\Uct-v\uctv.conf
to configure and register the source and destination interfaces.

NoTE: Any changes to the UCT-V config file made after the initial setup require
an UCT-V restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

E Following are the rules to modify the UCT-V configuration file:
» Interface is selected by matching its CIDR address with config entries.
» For the VMs with single interface:

° if neither mirror-src permissions is granted to the interface, both mirror-
src-ingress and mirror-src-egress are granted to it.

° mirror-dst is always granted implicitly to the interface.

e For the VMs with multiple interfaces:

° mirror-dst needs to be granted explicitly in the config file. Only the first
matched interface is selected for mirror-dst, all other matched interfaces
are ignored.

° if none interfaces is granted any mirror-src permission, all interfaces will
be granted mirror-src-ingress and mirror-src-egress.

Example 1—Configuration example to monitor ingress and egress traffic at interface
192.168.1.0/24 and use the same interface to send out the mirrored packets.

For IPv4
# 192.168.1.0/24 mirror-src-ingress mirror-src-egress mirror-dst
For IPv6

2001:db8:abcd:ef01::/64 mirror-src-ingress mirror-src-egress
2001:db8:abcd:ef02::/64 mirror-src-egress

2001:db8:abcd:ef01::2/64 mirror-dst

Example 2—Configuration example to monitor ingress and egress traffic at interface
192.168.1.0/24 and use the interface 192.168.2.0/24 to send out the mirrored packets.

For IPv4
# 192.168.1.0/24 mirror-src-ingress mirror-src-egress
# 192.168.2.0/24 mirror-dst

For IPv6

2001:db8:abcd:ef01::/64 mirror-src-ingress mirror-src-egress
2001:db8:abcd:ef02::/64 mirror-src-egress

2001:db8:abcd:ef01::2/64 mirror-dst
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5. Save the file.

6. To enable the third-party orchestration, a configuration file
C:\ProgramData\uctv\gigamon-cloud.conf needs to be created with the following

contents:

Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: orchestration
password: orchestrationl23A!
remoteIP: <controller list IP addresses separated by comma>

remotePort: 8891
7. To restart the Windows UCT-V, perform one of the following actions:

e Restart the VM.
* Run 'sc stop uctVv' and 'sc start uctv' from the command prompt.
* Restart the UCT-V from the Windows Task Manager.

You can check the status of the UCT-V in the Service tab of the Windows Task Manager.

NoTE: You must edit the Windows Firewall settings to grant access to the uctv
process. To do this, access the Windows Firewall settings and find “uctvd” in the list of
apps and features. Select it to grant access. Be sure to select both Private and Public
check boxes. If “uctvd” does not appear in the list, click Add another app... Browse
your program files for the uctv application (uctvd.exe) and then click Add.
(Disclaimer: These are general guidelines for changing Windows Firewall settings.
See Microsoft Windows help for official instructions on Windows functionality.)

Install UCT-V OVS Agent for OVS Mirroring

This is applicable only if you are using UCT-V OVS agent as the source of acquiring traffic.
You must have sudo/root access to edit the UCT-V OVS agent configuration file. Before
installing the UCT-V OVS agents, you must have launched the GigaVUE-FM instance.

NOTE: After rebooting your Ubuntu, you must redeploy the respective monitoring
sessions to restore the mirror traffic on the respective Ubuntu VM interfaces.

You can install theUCT-V OVS agents either from Debian or RPM packages as follows:

 Install the UCT-V OVS Agent from Ubuntu/Debian Package
» Install the UCT-V OVS Agent from RPM package

Install the UCT-V OVS Agent from Ubuntu/Debian Package

To install from a Debian package:
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1. Download the latest version of UCT-V OVS Agent Debian (.deb) package from the
Gigamon Customer Portal.

2. Copy this package to OpenStack compute nodes. Install the package with root
privileges, for example:

$ ls gigamon-gigavue-uctv-ovs-agent 6.5.00_amd64.deb
$ sudo dpkg -i gigamon-gigavue-uctv-ovs-agent 6.5.00_amdé64.deb
3. Once the UCT-V OVS agent package is installed, modify the file /fetc/uctv/uctv.conf to

configure and grant permission to monitor ingress and egress traffic and to transmit
the mirrored packets.

NoOTE: Any changes to the UCT-V config file made after the initial setup require
an agent restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

br-int mirror-dst

# Changes for OVS Mirroring
# This Value will be used as local Ip in OVS Mirror Config
tunnel-src 172.20.20.11
# This Value will be used as Next Hop for Tunneled Packets
tunnel-gw 172.20.20.1
This Value will be used as local Ipv6 in OVS Mirror Config
tunnel-src-v6 2001::161
This Value will be used as Next Hop ipv6 addr for Tunneled Packets
tunnel-gw-v6 2001::1
# OVS Agent Mode, Values: auto|standard|dpdk|hw-offload
ovs—-agent-mode auto
# VLAN Tag value (valid: 0-4094)
ovs-vlan-tag 2020
# Egress Interface for OVS Mirrored Traffic
ovs-egress-if vlan2020

4. After modifying the UCT-V OVS config file, start the agent service.
$ sudo service uctv start

5. The UCT-V OVS agent status will be displayed as running. Check the status using the
following command:

$ sudo service uctv status

UCT-V is running
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Install the UCT-V OVS Agent from RPM package

To install from an RPM (.rpm) package on a Redhat, CentOS, or other RPM-based system:

1. Download the UCT-V OVS Agent RPM (.rom) package from the Gigamon Customer
Portal.

2. Copy this package to OpenStack compute nodes. Install the package with root
privileges, for example:

$ ls gigamon-gigavue-uctv-ovs-agent 6.5.00_x86_ 64.rpm
$ sudo rpm -ivh gigamon-gigavue-uctv-ovs-agent 6.5.00_x86 64.rpm
3. Once the OVS agent package is installed, modify the file /fetc/uctv/uctv.conf to

configure and grant permission to monitor ingress and egress traffic and transmit the
mirrored packets.

NoTE: Any changes to the UCT-V config file made after the initial setup require
an UCT-V restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

# br-int mirror-dst

# Changes for OVS Mirroring

# This Value will be used as local Ip in OVS Mirror Config
tunnel-src 172.20.20.11

# This Value will be used as Next Hop for Tunneled Packets
tunnel-gw 172.20.20.1

This Value will be used as local Ipv6 in OVS Mirror Config
tunnel-src-v6 2001::161

This Value will be used as Next Hop ipv6 addr for Tunneled Packets
tunnel-gw-v6 2001::1

# OVS Agent Mode, Values: auto|standard|dpdk|hw-offload
ovs—-agent-mode auto

# VLAN Tag value (valid: 0-4094)

ovs-vlan-tag 2020

# Egress Interface for OVS Mirrored Traffic

ovs-egress-if vlan2020
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4. After modifying the UCT-V OVS config file, start the agent service and verify its status.

$ systemctl start uctv.service
$ sudo service uctv status

UCT-V is running

E When you are installing a self-signed RPM package, you must execute the following
command to import the signing key into the RPM db.

sudo rpm --import /path/to/YOUR-RPM-GPG-KEY

E To upgrade UCT-V OVS agent:

» You must backup the /etc/uctv/uctv.conf configuration file before upgrading the
UCT-V OVS Agent and uninstall the old OVS agents.

¢ Follow the same installation procedure to upgrade the UCT-V OVS agents.
» After upgrading the UCT-V OVS Agent, copy and modify the uctv.conf file, stop
the agent, and start the agent. Redeploy the Monitoring Session if required.

service uctv stop
service uctv start

Uninstall UCT-V

This section describes how to uninstall UCT-V for Windows UCT-V and Linux UCT-V

Uninstall Linux UCT-V

The following steps provide instructions on how to uninstall Linux UCT-V
Stop the UCT-V service using the following commands:

For Ubuntu/Debian Package:

sudo service uctv stop

For RPM package or Red Hat Enterprise Linux and CentOS with Selinux Enabled:

sudo systemctl stop uctv
Uninstall the UCT-V using the following:

For Ubuntu/Debian Package:
sudo dpkg -r uctv

For RPM package:

sudo rpm -e uctv

Uninstall UCT-V
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For Red Hat Enterprise Linux and CentOS with Selinux Enabled:

sudo rpm -e uctv

Uninstall Windows UCT-V

To uninstall Windows UCT-V:

1. On your windows, go to Task Manager > Services. Search for uctv.
2. Right click uctv and select Stop.
3. Go to Control Panel search for uctv and uninstall.

Upgrade or Reinstall UCT-V
Upgrade UCT-V

To upgrade UCT-V, delete the existing UCT-V and installing the new version of UCT-V.

NoTe: Before deleting the UCT-V, take a back up copy of /etc/uctv/uctv.conf
configuration file. Follow this step to avoid reconfiguring the source and destination

interfaces.

1. Uninstall the existing UCT-V. Refer to Uninstall UCT-V for more detailed information on
how to uninstall UCT-V.

2. Install the latest version or the new UCT-V. Refer to the following topics for more
detailed information on how to install a new UCT-V:

e Linux UCT-V Installation
o Windows UCT-V Installation
3. Restart the UCT-V service.

e Linux platform:
$ sudo service uctv restart

» Windows platform: Restart from the Task Manager.

NoTE: When the openssl version on the UCT-V is upgraded, Monitoring Session
needs to be redeployed

Pre-Configuration Checklist

The following table provides information that you would need while launching the visibility
components using GigaVUE-FM. Obtaining this information will ensure a successful and
efficient deployment of the GigaVUE Cloud Suite for OpenStack.
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You can log in to GigaVUE-FM and use the CLI command: ip host <controller-hostname> <ip-
address of the controller>. (For example: ip host os-controllerl 192.168.2.3.) Then, add the
connection to the OpenStack tenant.

In order for GigaVUE-FM to make a connection to an OpenStack tenant, GigaVUE-FM must
be able to resolve the hostname of the OpenStack controller, even if using an |IP address in
the Identity URL. For example, if GigaVUE-FM is configured to use DNS, and that controller
hostname is in the DNS, this will work, and no further configuration will be needed. If not,
then you must add a host entry to GigaVUE-FM.,

NoTE: If you are not using DNS, you must manually enter the host entry in /etc/hosts
on GigaVUE-FM for the OpenStack Controller. On using DNS you can directly enter
the host entry in GigaVUE-FM.

Required Information

Authentication URL

Project Name

Floating IP

Region name for the Project

Domain

SSH Key Pair

Networks

O O o/o0o o oo o

Security groups

Install Custom Certificate

GigaVUE V Series Node, GigaVUE V Series Proxy, and UCT-V Controllers have default self-
signed certificates installed. The communication between GigaVUE-FM and the fabric
components happens in a secure way using these default self-signed certificates, however
you can also add custom certificates like SSL/TLS certificate to avoid the trust issues that
occurs when the GigaVUE V Series Nodes, GigaVUE V Series Proxy, or UCT-V Controllers run
through the security scanners.

You can upload the custom certificate in two ways:

» Upload Custom Certificates using GigaVUE-FM
» Upload Custom Certificate using Third Party Orchestration
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Upload Custom Certificates using GigaVUE-FM

To upload the custom certificate using GigaVUE-FM follow the steps given below:
1. Go to Inventory > Security > Custom SSL Certificate. The Custom Certificate
Configuration page appears.

2. On the Custom Certificate Configuration page, click Add. The New Custom Certificate
page appears.

3. Enter or select the appropriate information as shown in the following table.

Field Action

Certificate Name | Enter the custom certificate name.

Certificate Click on the Upload Button to upload the certificate.

Private Key Click on the Upload Button to upload the private key associated with the certificate.
4. Click Save.

You must also add root or the leaf CA certificate in the Trust Store. For more detailed
information on how to add root CA Certificate, refer to Trust Store topic in GigaVUE
Administration Guide.

The certificates uploaded here can be linked to the respective GigaVUE V Series Node,
GigaVUE V Series Proxy, and UCT-V Controller in the Fabric Launch Configuration Page.
Refer to Configure GigaVUE Fabric Components in GigaVUE-FM topic in the respective
cloud guides for more detailed information.

Upload Custom Certificate using Third Party Orchestration

You can also upload custom certificates to GigaVUE V Series Nodes, GigaVUE V Series Proxy,
and UCT-V Controller using your own cloud platform at the time of deploying the fabric
components. Refer to the following topics on more detailed information on how to upload
custom certificates using third party orchestration in the respective platforms:

For integrated mode:

» Configure GigaVUE Fabric Components in AWS
» Configure GigaVUE Fabric Components in Azure
e Configure GigaVUE Fabric Components in OpenStack

For generic mode:

e Configure GigaVUE Fabric Components in AWS
e Configure GigaVUE Fabric Components in Azure
e Configure GigaVUE Fabric Components in GCP
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» Configure GigaVUE Fabric Components in Nutanix
» Configure GigaVUE Fabric Components in OpenStack
» Configure GigaVUE V Series Nodes using VMware ESXi

Adding Certificate Authority

This section describes how to add Certificate Authority in GigaVUE-FM.

CA List

The Certificate Authority (CA) List page allows you to add the root CA for the devices.

To upload the CA using GigaVUE-FM follow the steps given below:

1. Go to Inventory > Resources > Security > CA List.

2. Click Add, to add a new Custom Authority. The Add Certificate Authority page
appears.

3. Enter or select the following information.

Field Action

Alias Alias name of the CA.
File Upload Choose the certificate from the desired location.
4. Click Save.

Create Monitoring Domain

To create a monitoring domain in GigaVUE-FM:

1. Go to Inventory > VIRTUAL > OpenStack,. The Monitoring Domain page appears.

2. On the Monitoring Domain page, click New. The Monitoring Domain Configuration
page appears.
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3. Enter or select the appropriate information to configure Monitoring Domain for
OpenStack. Refer to the following table for field-level details.

NoTE: For the URL, User Domain Name, Project Domain Name, and Region field
values, refer to the RC file downloaded from your OpenStack dashboard.

Field Description

Monitoring A name for the monitoring domain.
Domain

NoOTE: You can only view and delete the existing configuration for V Series node 1.
You cannot create and perform any other actions on the existing configuration for
V Series node 1 as the features are deprecated from GigaVUE Fabric Manager (FM).

Alias An alias used to identify the monitoring domain.

URL The authentication URL is the Keystone URL of the OpenStack cloud. This IP address
must be DNS resolvable.

Refer to the OpenStack User Manual for more information on retrieving the
authentication URL from the OpenStack.

User Domain The domain name of your OpenStack authentication domain.
Name

NoOTE:
o If you are using a separate domain for AUTH, enter that domain name as User
Domain Name.

o If you are not using a separate domain, you can use the same domain for User
and Project Domain Name.

Project Domain The domain name of your OpenStack project.

Name

Project Name The name of the project used for OpenStack authentication.

Region The region where the Project resides. You can find your region by running one of

these commands, depending on your OpenStack version.

keystone endpoint-list or openstack endpoint list or looking at the RC file in
OpenStack to view your credentials.

Username The username used to connect to your OpenStack cloud.

NoTE: If you are using OVS mirroring, you must belong to a role that meets the
OpenStack minimum requirements for OVS Mirroring. Refer to OVS Mirroring
Prerequisites for more information.

Password The password of your OpenStack cloud.

Traffic Select the type of agent used to capture traffic for monitoring:

Acquisition « UCT-V: If you select UCT-V as the tapping method, the traffic is acquired from the

Method UCT-Vs installed on the VMs. You must configure the UCT-V Controller to monitor
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Field Description

the UCT-Vs.

« OVS Mirroring: If you select OVS Mirroring as your tapping method, the traffic is
acquired from the UCT-Vs installed on the hypervisors. Refer to Open vSwitch
(OVS) Mirroring for detailed information. You must configure the UCT-V Controller
to monitor the UCT-Vs.

o Customer Orchestrated Source: If you selectCustomer Orchestrated Source as the
tapping method, you can use tunnels as a source where the traffic is directly
tunneled to V Series nodes without deploying UCT-Vs or UCT-V Controllers.

Projects to This field only appears for OVS Mirroring traffic acquisition method.
Monitor (Only « Click the Get Project List to view the list of projects.
for OVS
Mirroring traffic NoTe: The Get Project List button will only work if all the OpenStack credentials
acquisition have been provided. Refer to OVS Mirroring Prerequisites.
method) . . .

o Select projects that you want to monitor from the list.

« You can click Select None to clear existing selections or Select All to add all

available projects to the connection configuration.

Traffic The Maximum Transmission Unit (MTU) is the maximum size of each packet that the
Acquisition tunnel endpoint can carry from the UCT-V to the GigaVUE Cloud Suite V Series node.
Tunnel MTU « For GRE, the default value is 1450.
(Maximum )
Transmission e For VXLAN, the default value is 1400.. However, the UCT-V tunnel MTU should be
Unit) 50 bytes less than the default MTU size.

4. Click Save. The OpenStack Fabric Launch Configuration page appears. Refer to
Configure GigaVUE Fabric Components in GigaVUE-FM for detailed information.

NoTE: If GigaVUE-FM fails to connect to OpenStack, an error message is displayed
specifying the cause of failure. The connection status is also displayed in Audit Logs,
refer to About Audit Logs for more information.

Managing Monitoring Domain

You can view the details of the monitoring domain that are created in the list view. The list
view details can be viewed based on:

e Monitoring Domain
* Connections Domain
¢ Connections Domain
e UCT-Vs

You can also filter the monitoring domain based on a specified criterion. In the monitoring
domain page there are two filter options as follows:

« Right filter - Click the Filter button on the right to filter the monitoring domain based
on a specific criterion.
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« Left filter - Click the

= tofilter the monitoring domain based on the domain and

connections. You can click + to create a new monitoring domain. This filter once
applied also works even when the tabs are swapped.

To edit or delete a specific monitoring domain, select the monitoring domain, click the

ellipses ™.

When you click a monitoring domain, you can view details of it in a split view of the window.
In the split view window, you can view the details such as Configuration, Launch
Configuration and V Series configuration.

Monitoring Domain

The list view shows the following information in the monitoring domain page:

« Monitoring Domain
« Connections
« Tunnel MTU
« Acquisition Method

« Centralized connection

= Management Network

NoTE: Click the to select the columns that should appear in the list view.

Use the following buttons to manage your Monitoring Domain:

Button Description

Use to create new connection

New

Actions

You can select a monitoring domain and then perform the following options:

Edit Monitoring Domain- Select a monitoring domain and then click Edit
Monitoring domain to update the configuration.

Delete Domain - You can select a monitoring domain or multiple monitoring
domains to delete them.

Edit Fabric-You can select one fabric or multiple fabrics of the same monitoring
domain to edit a fabric. You cannot choose different fabrics of multiple
monitoring domains at the same time and edit their fabrics

Deploy Fabric - -You can select a monitoring domain to deploy a fabric, you
cannot choose multiple monitoring domains at the same time to deploy fabrics.
This option is only enabled when there is No FABRIC (launch configuration) for
that specific monitoring domain and GigaVUE-FM orchestration is enabled.. You
must create a fabric in the monitoring domain, if the option is disabled
Upgrade Fabric-You can select a monitoring domain or multiple monitoring
domains to upgrade the fabric. You can upgrade the V-Series nodes using this
option.

Managing Monitoring Domain
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Button Description

. Delete Fabric- You can delete all the fabrics associated with the monitoring
domain of the selected Fabric.

« Shut down OVS Traffic - You can shut down the OVS traffic. You can view the
Shut down OVS Traffic option only when you enable the check box OVS Agent
Traffic when V Series unreachable in Advanced Settings. For more information
on settings, refer to Configure the OpenStack Settings

o Restart OVS Traffic - You can restart the OVS traffic. You can view the Restart
OVS Traffic option only when you enable the check box OVS Agent Traffic
when V Series unreachable in Advanced Settings. For more information on
settings, refer to Configure the OpenStack Settings

. Edit SSL Configuration - You can use this option to add Certificate Authority and
the SSL Keys when using the Secure Tunnels.

Filter Filters the monitoring domain based on the list view options that are configured:
« Tunnel MTU

« Acquisition Method

. Centralised Connection

. Management Subnet

You can view the filters applied on the top of the monitoring domain page as a
button. You can remove the filters by closing the button.

Connections Domain

To view the connection related details for a monitoring domain, click the Connections tab.

The list view shows the following details:
« Connections
« Monitoring Domain
« Status
«» Fabric Nodes
« User Name
« Region

Fabric

To view the fabric related details for a monitoring domain, click the Fabric tab.

The list view shows the following details:
= Connections
« Monitoring Domain
«» Fabric Nodes

« Type
«  Management IP
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«  Version
» Status - Click to view the upgrade status for a monitoring domain.

« Security groups

UCT-Vs

To view all the UCT-Vs associated with the available monitoring domains click the UCT-Vs
tab.

The list view shows the following details:
« Monitoring Domain
« [P address
» Registration time
« Last hearbeat time
» Agent mode
« Status

.Refer to Configure the OpenStack Settings, for information regarding Settings.
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Configure GigaVUE Fabric Components in
GigaVUE-FM

After configuring the Monitoring Domain, you will be navigated to the OpenStack Fabric
Launch Configuration page. In the same OpenStack Fabric Launch Configuration page,
you can configure the following fabric components:

» Configure UCT-V Controller
e Configure GigaVUE V Series Proxy
e Configure GigaVUE V Series Node

In the OpenStack Fabric Launch Configuration page, enter or select the required
information as described in the following table.

Fields Description

SSH Key Pair | The SSH key pair for the UCT-V Controller. For more information about SSH key pair, refer to
Key Pairs.

Availability The distinct locations (zones) of the OpenStack region.

Zone

Security The security group created for the UCT-V Controller. For more information, refer to Security

Groups Group for OpenStack .

Prefer IPvo Enables IPv6 to deploy all the Fabric Controllers, and the tunnel between hypervisor to V
Series node using IPv6 address. If the IPv6 address is unavailable, it uses an IPv4 address. This
functionality is supported only in OVS Mirroring.

Enable Enable this option to validate the custom certificate during SSL Communication. GigaVUE-FM

Custom validates the Custom certificate with the trust store. If the certificate is not available in Trust

Certificates Store, communication does not happen, and an handshake error occurs.

NoTE: If the certificate expires after the successful deployment of the fabric components,
then the fabric components moves to failed state.

Certificate Select the custom certificate from the drop-down menu. You can also upload the custom
certificate for GigaVUE V Series Nodes, GigaVUE V Series Proxy, and UCT-V Controllers. For
more detailed information, refer to Install Custom Certificate.
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Select Yes to configure a GigaVUE V Series Proxy.

SSH Key Pair | Select SSH Key Pair.. - |
Awvailability Zone ‘ Select Availability Zone... - ‘
Security Groups ‘ Select management subnet security group... - ‘
Configure a V Series Proxy » No

Configure GigaVUE Fabric Components in GigaVUE-FM
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Configure UCT-V Controller

A UCT-V Controller manages multiple UCT-Vs and orchestrates the flow of mirrored traffic to
GigaVUE V Series nodes. While configuring the UCT-V Controllers, you can also specify the
tunnel type to be used for carrying the mirrored traffic from the UCT-Vs to the GigaVUE V
Series nodes.

UCT-V Controller

Controller Version(s) Add

Image Selectimage...
Favor Select flavor.

Number of Instances 1

Image gigamon-gigavue-uctv-cntlr-6.4.00- 392769
Flavor mZ.small -

Number of Instances 1

Management Network

IP Address Type Private Floating

Network [ -

Floating IPs 10210191

Port Select Port ~

Additional Network(s)
Tags
Cloud-Init User Data (Optional) Enter cloud-init user data in YAML cloud-config format
Agent Tunnel Type VXLAN - 9
Agent Tunnel CA Select CA

O

UCT-V Controller Name & Gigamon-UCT-VController- + Gigamon-UCT-VCentroller-1

e Only if UCT-Vs are used for capturing traffic, then the UCT-V Controllers must be
configured in the OpenStack cloud.

e A UCT-V Controller can only manage UCT-Vs that have the same version.
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Enter or select the required information in the UCT-V Controller section as described in the

following table.

Fields Description

Controller
Version(s)

The UCT-V Controller version that you configure must always have the
same version number as the UCT-Vs deployed in the instances. For
more detailed information refer GigaVUE-FM Version Compatibility
Matrix.

NoTE: If there is a version mismatch between the UCT-V Controllers
and UCT-Vs, GigaVUE-FM cannot detect the agents in the instances.

To add UCT-V Controllers:
a. Under Controller Versions, click Add.

b. From the Image drop-down list, select a UCT-V Controller
image that matches with the version number of UCT-Vs
installed in the instances.

c. From the Flavor drop-down list, select a size for the UCT-V
Controller.

d. In Number of Instances, specify the number of UCT-V
Controllers to launch. The minimum number you can specify is
1.

Management
Network

This segment defines the management network that GigaVUE-FM
uses to communicate with UCT-V Controllers, GigaVUE V Series Proxy,
and GigaVUE V Series Nodes.

Network - Select the management network ID.

Ports - Select a port, you can choose a port related to the selected
management network ID.

IP Address Type

The type of IP address GigaVUE-FM needs to communicate with UCT-V
Controllers:

o Private—A private IP can be used when GigaVUE-FM, the UCT-V
Controller, or the GigaVUE V Series Proxy reside inside the same
project.

o Floating—A floating IP is needed only if GigaVUE-FM is not in
the same project in the cloud or is outside the cloud.
GigaVUE-FM needs a floating IP to commmunicate with the
controllers from an external network.

Additional
Network(s)

(Optional) If there are UCT-Vs on networks that are not IP routable
from the management network, additional networks or subnets must
be specified so that the UCT-V Controller can communicate with all the
UCT-Vs.

Click Add to specify additional networks (subnets), if needed. Also,
make sure that you specify a list of security groups for each additional
network.
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Fields Description

Ports: Select a port associated with the network.

Tag(s)

(Optional) The key name and value that helps to identify the UCT-V
Controller instances in your environment. For example, you might have
UCT-V Controllers deployed in many regions. To distinguish these UCT-
V Controllers based on the regions, you can provide a name (also
known as a tag) that is easy to identify such as us-west-2-uctv-
controllers. There is a specific UCT-V Controller Version for OVS
Mirroring and OVS Mirroring + DPDK.

To add a tag:
a. Click Add.
b. Inthe Key field, enter the key. For example, enter Name.

c. Inthe Value field, enter the key value. For example, us-west-2-
uctv-controllers.

Cloud-Init User
Data (Optional)

Enter the cloud-init user data in cloud-config format.

Agent Tunnel
Type

The type of tunnel used for sending the traffic from UCT-Vs to
GigaVUE V Series nodes. The options are GRE, VXLAN, and Secure
tunnels (TLS-PCAPNG).

Agent Tunnel CA

The Certificate Authority (CA) that should be used in the UCT-V
Controller for connecting the tunnel.

UCT-V Controller
Name

(Optional) Enter the name of the UCT-V Controller.
The UCT-V Controller name must meet the following criteria:

o The entire name can be a minimum of 1to a maximum of 128
characters.

o The suffix must only be a numeral and it should range between
0 to 999999999.

o When deploying multiple UCT-V Controllers, the suffix of the
consecutive UCT-V Controller name is updated successively. E.g.,
000, 001, 002, 003, etc..
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Configure GigaVUE V Series Proxy

The fields in the GigaVUE V Series Proxy configuration section are the same as those on the
UCT-V Configuration page. Refer to Configure UCT-V Controller for the field descriptions.
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Configure GigaVUE V Series Node

Creating a GigaVUE V Series node profile automatically launches the V Series node. Enter or
select the required information in the GigaVUE V Series Node section as described in the
following table.

Parameter Description

Image Select the GigaVUE V Series node image file.

Flavor Select the form of the GigaVUE V Series node.

Management For the GigaVUE V Series Node, the Management Network is what is used by the GigaVUE V

Network Series Proxy to communicate with the GigaVUE V Series Nodes. Select the management
network ID.

Ports— Select a port, you can choose a port related to the selected management network
ID.

NoTE: When both IPv4 and IPv6 addresses are available, IPve address is preferred,
however if IPv6 address is not reachable then IPv4 address is used.

Data Network Click Add to add additional networks. This is the network that the GigVUE V Series node
uses to communicate with the monitoring tools. Multiple networks are supported.

» Tool Subnet—Select a tool subnet, this is the default subnet that the GigaVUE-FM use to
egress traffic to your tools. This subnet must have proper connectivity to your endpoint.
e IP Address Type

o Private—A private IP can be used when GigaVUE-FM, the UCT-V Controller, or the
GigaVUE V Series Proxy, or the GigaVUE V Series node 2 reside inside the same
project.

o Floating—A floating IP address specified here will be where V Series node 2x.x can
be directly managed by GigaVUE-FM or can optionally managed by controllers.

o Network 1—Select a network type.

e Ports —Select a port associated with the network.

E e For OVS Mirroring or OVS Mirroring + DPDK deployments, must select Floating
in the Data Network section and then specify the IPs in the Floating IPs field.
You can have multiple Floating IPs.

o A network provider that is able to receive the monitored traffic may also be used
here for OVS Mirroring and OVS Mirroring + DPDK. In this case, you would not
need to provide a floating IP; but could select "private" and choose the provider
network.

Tag(s) (Optional) The key name and value that helps to identify the UCT-V Controller instances in
your environment. For example, you might have UCT-V Controllers deployed in many
regions. To distinguish these UCT-V Controllers based on the regions, you can provide a
name (also known as a tag) that is easy to identify such as us-west-2-uctv-controllers.
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Parameter Description

To add a tag:
a. Click Add.

b. Inthe Key field, enter the key. For example, enter Name.

c. Inthe Value field, enter the key value. For example, us-west-2-uctv-controllers.

Cloud-Init User
Data (Optional)

Enter the cloud-init user data in cloud-config format.

Min Instances

The minimum number of GigaVUE V Series nodes to be launched in OpenStack. The
minimum number can be 1.

« When you deploy an OVS Mirroring or OVS Mirroring + DPDK monitoring session, the V
Series nodes will automatically be deployed based on the # of hypervisors being
monitored.

« When you deploy a UCT-V based monitoring session, the V Series nodes will
automatically be deployed based on the # of VMs being monitored and the instance per
V Series node ratio defined in the OpenStack Setttings page.

NoTe: GigaVUE-FM will delete the nodes if they are idle for over 15 minutes.

Max Instances

The maximum number of GigaVUE V Series nodes that can be launched in OpenStack.

V Series Node
Name

(Optional) Enter the name of the V Series Node.
The V Series Node name must meet the following criteria:
o The entire name can be a minimum of 1to a maximum of 128 characters.
o The suffix must only be a numeral and it should range between O to 999999999.

o When deploying multiple V Series Nodes, the suffix of the consecutive V Series Node
name is updated successively. E.g., 000, 001, 002, 003, etc..

Tunnel MTU
(Maximum
Transmission
Unit)

The Maximum Transmission Unit (MTU) is applied on the outgoing tunnel endpoints of the
GigaVUE-FM V Series node when a monitoring session is deployed. The default value is 1450.
The value must be 42 bytes less than the default MTU for GRE tunneling, or 50 bytes less
than default MTU for VXLAN tunnels.

Click Save to save the OpenStack Fabric Launch Configuration.

To view the fabric launch configuration specification of a fabric node, click on a fabric node
or proxy, and a quick view of the Fabric Launch Configuration appears on the Monitoring

Domain page.

Configure Role-Based Access for Third Party
Orchestration

Before deploying the fabric components using a third party orchestrator, we must create
users, roles and the respective user groups in GigaVUE-FM. The Username and the Password
provided in the User Management page will be used in the registration data that can be
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used to deploy the fabric components in your orchestrator.

Refer to following topics for more detailed information on how to add users, create roles and
user groups:

e Users
* Role
e User Groups

Users

You can also configure user's role and user groups to control the access privileges of the user
in GigaVUE-FM.

Add Users

This section provides the steps for adding users. You can add users only if you are a user with
fm_super_admin role or a user with either read/write access to the FM security
Management category.

To add users perform the following steps:

1.  On the left navigation pane, cIick and select Authentication > GigaVUE-FM User
Management > Users. The User page is displayed.

*g:“ User Management User Groups Authentication

Dl .
g (D) Admin user s default and cannot be removed. New User Actions v Export v

SETTINGS
é Username Name Email Roles Tags Resources Member of Groups @

> System
Reports ® admin System Administrator fm_super_admin All: All All Super Admin Group

> Tasks
fm_user All: All All User Group
~  Authenticat...

| cigavu..
Device ...
High Availa...

Tags
Figure1 FM Users Page

2. Click New User. In the Add User wizard that appears perform the following steps.
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Add User
@ All form elements are required unless indicated as optional. =
Name
@ Your new password must contain:
«~ At least 8 characters and up to a maximumn of 64 characters in length
+ At least one numerical character
Username
./ At least one uppercase character
« At least one lowercase character
~* At least one special character from JE#SHALS()+
Password

Confirm password

Email

User Group

Cancel Ok
Figure 2 Create User

a. Inthe Add User pop-up box, enter the following details:

o Name: Actual name of the user
o Username: User name configured in GigaVUE-FM
o Email: Email ID of the user

o Password/Confirm Password: Password for the user. Refer to the Change Your
Password section.

o User Group: User group

NoTE: GigaVUE-FM will prompt for your password.

b. Click Ok to save the configuration.
The new user is added to the summary list view.

The username and password created in this section will used in the registration data, used
for deploying the fabric components.

Role

A user role defines permission for users to perform any task or operation in GigaVUE-FM or
on the managed device. You can associate a role with user.
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Create Roles

This section describes the steps for creating roles and assigning user(s) to those roles.

GigaVUE-FM has the following default roles:

« fm_super_admin — Allows a user to do everything in Fabric Manager, including adding
or modifying users and configuring all AAA settings in the RADIUS, TACACS+, and LDAP
tabs. Can change password for all users.

« fm_admin — Allows a user to do everything in Fabric Manager except add or modify
users and change AAA settings. Can only change own password.

« fm_user — Allows a user to view everything in Fabric Manager, including AAA settings,
but cannot make any changes.

NoOTE: If you are a user with read-only access you will be restricted from
performing any configurations on the screen. The menus and action
buttons in the Ul pages will be disabled appropriately.

To create a role

1. On the left navigation pane, cIick and select Authentication> GigaVUE-FM User
Management >Roles.

2. Click New Role.

User Management User Groups Authentication
ull Find New Role (@ Allform elements are mandatory unless indicated as optional. X Cancel Apply
%) SETTINGS
> System
Role Name
Reports
> Tasks
~  Authentication
q Description
I GigaVUE-FM User Mana... P
Device Authentication Se... 4
High Availability
Tags
SUPPORT Select Permission Resources Permissions Description =
API Reference
> Infrastructure Management Select a permission Manage physical and cloud infrastr...
App Protobook
About > Traffic Control Management Select a permission Manage inline resources,Define an...
End User License Agreement
> FM Security Management Select a permission Secure FM environment. User can ...
Contact Support
‘:L) > System Management Select a permission Control system administration activ...
> Forwardlist Management Select a permission Manage the forwardlist configurati...

FM Instance: GigaVUE-FM

3. Inthe New Role page, select or enter the following details:

¢ Role Name: Name of the role.
» Description: Description of the role.
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» Select Permission: For Third Party Orchestration from the Resources, select
Write from the Permissions drop-down menu.

4. Click Apply to save the configuration.

User Groups

A user group consists of a set of roles and set of tags associated with users in that group.
When a user is created they can be associated with one or more groups.

Create User Groups in GigaVUE-FM

The following user groups are available by default in GigaVUE-FM. You will not be able to
edit or change these groups in the system.

User Group Tag Key and Tag Value Permission

Super Admin Tag Key = All Group with privileges of fm_super_adminrole.
Group Tag Value = All
Admin Group Tag Key= All Group with privileges of fm_admin role.
Tag Value = All
View only user Tag Key = All Group with privileges of fm_user role.
Tag Value = All

To create a custom user group:
1. On the left navigation pane, click ,and then select Authentication> GigaVUE-
FMUser Management >User Groups.

2. Click New Group. In the Wizard that appears, perform the following steps. Click Next
to progress forward and click Back to navigate backward and change the details.
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B User Management Authentication

E

. @ : :
Cancel Back

New User Group
SETTINGS Group Info Assign Roles Assign Tags Assign Users

5

> System

Reports Roles Description Resources )

> Tasks fm_super_admin Allows a user to do everything in GigaVUE-FM, including add... All

v Authentication
fm_admin Allows a user to do everything in GigaVUE-FM except adding...  Infrastructure Management+ 6 more
| GigaVUE-FM User Mana...

Device Authentication Se... fm_user Allows a user to view everything in GigaVUE-FM, including A.. Al
High Availability

Tags
SUPPORT

AP Reference

App Protobook

About

End User License Agreement

Contact Support

Go to page of 1 3Iroles total

3. In the Group Info tab, enter the following details:

e Group Name
+ Description

»

In the Assign Roles tab, select the required role.

5. In the Assign Tags tab, select the required tag key and tag value.

o

In the Assign Users tab, select the required users. Click Apply to save the
configuration. Click Skip and Apply to skip this step and proceed without adding
users.

The new user group is added to the summary list view.

Click on the ellipses to perform the following operations:

o Modify Users: Edit the details of the users.
o Edit: Edit an existing group.

Configure GigaVUE Fabric Components in
OpenStack

You can use your own OpenStack orchestration system to deploy GigaVUE fabric nodes and
use GigaVUE-FM to configure the advanced features supported by these nodes. These
nodes register themselves with GigaVUE-FM using the information provided by your
OpenStack orchestration system. Once the nodes are registered with GigaVUE-FM, you can
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configure monitoring sessions and related services in GigaVUE-FM. Health status of the
registered nodes are determined by the heartbeat messages sent from the respective
nodes.

Recommended Instance Type

Fabric Component Machine type

GigaVUE V Series Node ml.medium
GigaVUE V Series Proxy ml.small
UCT-V Controller ml.small

Keep in mind the following when deploying the fabric components using third party
orchestration in integrated mode:

* In the above mentioned case, the Traffic Acquisition Tunnel MTU is set to the default
value 1500. To edit the Traffic Acquisition Tunnel MTU, select the monitoring domain and
click on the Edit Monitoring Domain option. Enter the Traffic Acquisition Tunnel MTU
and click Save.

* When you deploy the fabric components using 3rd party orchestration, you cannot delete
the monitoring domain without unregistering the registered fabric components.

* You can use OpenStack Orchestrator for GigaVUE fabric node configuration only using V
Series 2 nodes.

¢ GigaVUE V Series Node must have a minimum of two Networks Interfaces (NIC) attached
to it, a management NIC and a data NIC. You can add both these interfaces when
deploying the GigaVUE V Series Node in OpenStack.

In your OpenStack dashboard, you can configure the following GigaVUE fabric components:

» Configure V Series Nodes and Proxy in OpenStack
e Configure UCT-V Controller in OpenStack
e Configure UCT-V in OpenStack

Configure V Series Nodes and Proxy in OpenStack

To configure V Series Nodes and V Series Proxy in OpenStack platform:

1. Before configuring GigaVUE fabric components through OpenStack, you must create a
monitoring domain in GigaVUE-FM. Refer to Create Monitoring Domain for detailed
instructions.
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2. In the Monitoring Domain Configuration page, select No for the Use FM to Launch
Fabric field as you are going to configure the fabric components in OpenStack

Orchestrator.
»t}i OpensStack > Monitoring Domain
Ll Monitoring Domain Configuration Save Cancel
< Use V Series 2 @ ves
Monitoring Domain Enter a monitoring domain name
= Alias Alias
URL URL
User Domain Name User Domain Name
Project Domain Name Project Domain Name
Project Name Project Name
Region Region
Username Username
Password Password
Traffic Acquisition Method G-vTAP
Traffic Acquisition Tunnel MTU 1500
Use FM to Launch Fabric » No
)
@

FM Instance: GigaVUE-FM

3. In your OpenStack environment, you can deploy V Series nodes or V Series proxy using
the following methods:

e Register V Series Nodes or V Series Proxy using OpenStack GUI
e Register V Series Node or V Series Proxy using a configuration file

Register V Series Nodes or V Series Proxy using OpenStack GUI

To register V Series nodes or proxy using the user data in OpenStack GUI:

1. On the Instance page of OpenStack dashboard, click Launch instance. The Launch
Instance wizard appears. For detailed information, refer to Launch and Manage
Instances topic in OpenStack Documentation.

] openstack: (= func_automation_test ¥ & func_automation_test
Project v
Project / Gompute / Instances

APl Access

Compute . Instances

Overview
Image Name =+ || gigamon-gigavue-vseries-ni Fiter | & Launch instance | [ DESSIEEIEE  1vore Actions »
Images Displaying 1 item
i Instance . Availability Power .
Key Pairs a] Image Name IP Address Flavor Key Pair Status. Task e Actions
Narme o 4 Zone state Ao

Server Groups
gigamon-gigavue-vseries-node-2.3.2-281462_amds  TTTics-testnetwork-1 vseries2-4x8-
Volumes > O vSeesnode 4 conp e flavor
: mgmts-test-network 4°

vm_automation_test ~ Active nova None  Running 3days  Create Snapshot v

Network > Displaying 1 item

Identity >
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2. On the Configuration tab, enter the Customization Script as text in the following
format and deploy the instance. The V Series nodes or V Series proxy uses this

customization script to generate config file (/etc/gigamon-cloud.conf) used to register

with GigaVUE-FM.

Field User Data

owner: root:root
permissions: "@644"
content: |
————— BEGIN CERTIFICATE-----
<certificate content>
----- END CERTIFICATE-----
- path: /etc/cntlr-key.conf
owner: root:root
permissions: "400"
content: |
————— BEGIN PRIVATE KEY-----
<private key content>
————— END PRIVATE KEY-----
- path: /etc/gigamon-cloud.conf
owner: root:root
permissions: '0644'
content: |
Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>

Proxy>
remotePort: 443

User data
without #cloud-config
custom write files:
certificate - path: /etc/gigamon-cloud.conf
owner: root:root
permissions: '0644'
content: |
Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the GigaVUE-FM> or <IP address of the Proxy>
remotePort: 443
User data
with #cloud-config
custom write_files:
certificate - path: /etc/cntlr-cert.conf

remoteIP: <IP address of the GigaVUE-FM> or <IP address of the

Configure GigaVUE Fabric Components in OpenStack
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E * You can register your V Series node directly with GigaVUE-FM or you can use V

V Series node directly, enter the remoteport Value as 443 or if you wish to deploy V
Series node using V Series proxy then, enter the remoteport Value as 8891.

» User and Password must be configured in the User Management page. Refer to
Configure Role-Based Access for Third Party Orchestration for more detailed

Series proxy to register your V Series node with GigaVUE-FM. If you wish to register

information. Enter the UserName and Password created in the Add Users Section.

Register V Series Node or V Series Proxy using a configuration file

To register V Series node or proxy using a configuration file:

1. Log in to the V Series node or proxy.

2. Create a local configuration file (/fetc/gigamon-cloud.conf) and enter the following
customization script.

Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: orchestration
password: orchestration123A!
remoteIP: <IP address of the GigaVUE-FM>
remotePort: 443

NoTE: If you wish to register V Series node using V Series proxy then, enter the
remotePort Value as 8891.

3. Restart the V Series node or proxy service.
* V Series node:

$ sudo service vseries-node restart

e V Series proxy:
$ sudo service vps restart

The deployed V Series node or V Series proxy registers with the GigaVUE-FM. After
successful registration the V Series node or proxy sends heartbeat messages to
GigaVUE-FM every 30 seconds. If one heartbeat is missing ,the fabric node status
appears as 'Unhealthy'. If more than five heartbeats fail to reach GigaVUE-FM,
GigaVUE-FM tries to reach the V Series node or proxy and if that fails as well then
GigaVUE-FM unregisters the V Series node or proxy and it will be removed from
GigaVUE-FM.

Configure UCT-V Controller in OpenStack

To configure GigaVUE fabric components in OpenStack platform:
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1.

Before configuring GigaVUE fabric components through OpenStack, you must create a
monitoring domain in GigaVUE-FM. While creating the monitoring domain, select
UCT-V as the Traffic Acquisition Method. Refer to Create Monitoring Domain for

detailed instructions.

In the Monitoring Domain Configuration page, select No for the Use FM to Launch
Fabric field as you are going to configure the fabric components in OpenStack
Dashboard.

=

&

2

D
@&

OpenStack > Monitoring Domain

Monitoring Domain Configuration

Use V Series 2

Monitoring Domain

Alias

URL

User Domain Name
Project Domain Name
Project Name

Region

Username

Password

Traffic Acquisition Method
Traffic Acquisition Tunnel MTU

Use FM to Launch Fabric

FM Instance: GigaV/UE-FM

a@ ves

Enter a monitoring domain name
Alias

URL

User Domain Name
Project Domain Name
Project Name

Region

Username

Password

G-vTAP

1500

B No
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3. In your OpenStack environment, launch the UCT-V Controller using any of the
following methods:

e Register UCT-V Controller using OpenStack GUI
» Register UCT-V Controller using a configuration file

Register UCT-V Controller using OpenStack GUI

To register UCT-V Controller using the user data in OpenStack GUI:

a. On the Instance page of OpenStack dashboard, click Launch instance. The Launch
Instance wizard appears. For detailed information, refer to Launch and Manage
Instances topic in OpenStack Documentation.

= openstack, 3 func_automation_test ~ & func_automation_test
Project v
Project / Compute / Instances
API Access

Campute . Instances

Overview

Image Name =+ | gigamon-gigavue-vseries-n Fiter || @ Launch Instance [ IV ILEEE  1iore Actions ~

Images  Displaying 1 item

Key Pairs Ir'l‘:::“ Image Name 1P Address Flavor Key Pair Status ;:::“b""y Task :':"::" Age  Actions
Server Groups

gigamon-gigavue-vseries-node-2.32-281462_amds  Tarnes-test-network-1 Vseries2-4x8-
O vseresnode S0 “« o
& mgmts-test-network 4 4 1 ¢

vm_automation_test  Active nova None  Running 3days | Create Snapshot  ~
Volumes >

Network > Displaying 1 item

Identity >
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b. On the Configuration tab, enter the Customization Script as text in the following
format and deploy the instance. The UCT-V Controller uses this customization
script to generate config file (/fetc/gigamon-cloud.conf) used to register with

GigaVUE-FM.

Field User Data

User data
without custom
certificate

#tcloud-config
write_files:
- path: /etc/gigamon-cloud.conf
owner: root:root
permissions: '0644'
content: |
Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the GigaVUE-FM>
remotePort: 443

User data with
custom
certificate

#cloud-config
write_files:
- path: /etc/cntlr-cert.conf
owner: root:root
permissions: "@644"
content: |
————— BEGIN CERTIFICATE-----
<certificate content>

- path: /etc/cntlr-key.conf
owner: root:root
permissions: "400"
content: |
————— BEGIN PRIVATE KEY-----
<private key content>
----- END PRIVATE KEY-----
- path: /etc/gigamon-cloud.conf
owner: root:root
permissions: '0©644'
content: |
Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the GigaVUE-FM>
remotePort: 443

Configure GigaVUE Fabric Components in OpenStack
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E * User and Password must be configured in the User Management page.
Refer to Configure Role-Based Access for Third Party Orchestration for more

detailed information. Enter the UserName and Password created in the Add
Users Section.

The UCT-V Controller deployed in OpenStack appears on the Monitoring Domain page
of GigaVUE-FM.

Register UCT-V Controller using a configuration file

To register UCT-V Controller using a configuration file:
a. Logintothe UCT-V Controller.

b. Create a local configuration file (/etc/gigamon-cloud.conf) and enter the following
user data.

Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the GigaVUE-FM>
remotePort: 443

c. Restart the UCT-V Controller service.
$ sudo service uctv-cntlr restart

Assign Static IP address for UCT-V Controller

By default, the UCT-V Controller gets assigned an IP address using DHCP. If you wish to
assign a static IP address, follow the steps below:
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a. Navigate to /etc/netplan/ directory.
b. Create a new .yaml file. (Other than the default 50-cloud-init.yaml file)
c. Update the file as shown in the following sample:

network:

version: 2
renderer: networkd

ethernets:
ens3:
addresses:
- <IP address>
gateway: <IP address>
ens4:
addresses:
- <IP address>
gateway: <IP address>
ens5:

addresses:
- <IP address>
gateway: <IP address>

d. Save the file.

e. Restart theUCT-V Controller service.
$ sudo service uctv-cntlr restart

The deployed UCT-V Controller registers with the GigaVUE-FM. After successful
registration the UCT-V Controller sends heartbeat messages to GigaVUE-FM every 30
seconds. If one heartbeat is missing ,the fabric node status appears as 'Unhealthy'. If
more than five heartbeats fail to reach GigaVUE-FM, GigaVUE-FM tries to reach the
UCT-V Controller and if that fails as well then GigaVUE-FM unregisters the UCT-V
Controller and it will be removed from GigaVUE-FM.

Configure UCT-V in OpenStack

UCT-V should be registered via the registered UCT-V Controller and communicates through
PORT 8891.

NoTE: Deployment of UCT-V Agents through a third-party orchestrator is supported
on Linux and Windows platforms. Refer to Linux UCT-V Installation and Windows
UCT-V Installation for detailed information.

To register UCT-V using a configuration file:

1. Install the UCT-V in the Linux or Windows platform. For detailed instructions, refer to
Linux UCT-V Installation and Windows UCT-V Installation.

2. Login tothe UCT-V.
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3. Create a local configuration file and enter the following user data.

B /etc/gigamon-cloud.conf is the local configuration file in Linux platform.

« C:\ProgrambData\uctv\gigamon-cloud.conf is the local configuration file in
Windows platform.

* When creating C:\\ProgramData\uctv\gigamon-cloud.conf file, ensure that
the file name extension is .conf. To view the file name extension in Windows,
follow the steps given below:

a. Goto File Explorer and open the File Location.
b. On the top navigation bar, click View.
c. Inthe View tab, enable the File name extensions check box.

Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the UCT-V Controller 1>,
<IP address of the UCT-V Controller 2>
remotePort: 8891

NoTE: User and Password must be configured in the User Management
page. Refer to Configure Role-Based Access for Third Party Orchestration
for more detailed information. Enter the UserName and Password created
in the Add Users Section.

4. Restart the UCT-V service.

e Linux platform:
$ sudo service uctv restart

* Windows platform: Restart from the Task Manager.

NOTE: You can configure more than one UCT-V Controller for a UCT-V, so that if one
UCT-V Controller goes down, the UCT-V registration will happen through another
Controller that is active.

The deployed UCT-V registers with the GigaVUE-FM through the UCT-V Controller. After
successful registration the UCT-V sends heartbeat messages to GigaVUE-FM every 30
seconds. If one heartbeat is missing, UCT-V status appears as 'Unhealthy'. If more than five
heartbeats fail to reach GigaVUE-FM, GigaVUE-FM tries to reach the UCT-V and if that fails as
well then GigaVUE-FM unregisters the UCT-V and it will be removed from GigaVUE-FM.

Keep in mind the following when upgrading the GigaVUE-FM to 6.1.00 or higher version
(when using third party orchestration to deploy fabric components):
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When upgrading GigaVUE-FM to any version higher than 6.0.00 and if the GigaVUE V Series
Nodes version deployed in that GigaVUE-FM are lower than or equal to 6.0.00, then for the
seamless flow of traffic, GigaVUE-FM automatically creates Users and Roles in GigaVUE-FM
with the required permission. The username would be orchestration and the password
would be orchestration123A! for the user created in GigaVUE-FM. Ensure there is no existing
user in GigaVUE-FM, with the username orchestration.

It is recommended to change the password in the Users page, once the upgrade is
complete. Refer to Configure Role-Based Access for Third Party Orchestration for detailed
steps on how to change password in the user page.

Upgrade GigaVUE Fabric Components in
GigaVUE-FM for OpenStack

This chapter describes how to upgradeGigaVUE V Series Proxy and GigaVUE V Series Nodes.
For more detailed information about UCT-V Controller, GigaVUE V Series Proxy and Node
Version refer GigaVUE-FM Version Compatibility Matrix

Refer to the following topic for more information:

e Prerequisite
e Upgrade UCT-V Controller
e Upgrade GigaVUE V Series Nodes and GigaVUE V Series Proxy

Prerequisite

Before you upgrade the GigaVUE V Series Proxy and GigaVUE V Series nodes, you must
upgrade GigaVUE-FM to software version 5.13. For better performance, Gigamon
recommends you to upgrade to the latest version.

Upgrade UCT-V Controller

NoTeE: UCT-V Controllers cannot be upgraded. Only a new version that is compatible
with the UCT-V's version can be added or removed in the OpenStack Fabric Launch

Configuration page.

To change the UCT-V Controller version follow the steps given below:

To change UCT-V Controller version between different major versions

NOTE: You can only add UCT-V Controllers which has different major versions. For
example, you can only add UCT-V Controller version 1.8-x if your existing version is 1.7-
X.
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a. Under Controller Versions, click Add.

b. From the Image drop-down list, select a UCT-V Controller image that matches with the
version number of UCT-Vs installed in the instances.

o

d. In Number of Instances, specify the number of UCT-V Controllers to launch. The
mMinimum number you can specify is 1.

Controller Version(s) Add

Image
Flavor

Number of Instances

Image
Flavor

Number of Instances

Management Network
IP Address Type

Network

Floating IPs

Additional Network(s)

Tags

You cannot change the IP Address Type and the Additional Networks details, provided at the time of

UCT-V Controller configuration.

After installing the new version of UCT-V Controller, follow the steps given below:

1. Install UCT-V with the version same as the UCT-V Controller.

Select image...

Select flavor...

1

m1l.small

1

Private

2. Delete the UCT-V Controller with older version.

To change UCT-V Controller version with in the same major version

From the Flavor drop-down list, select a size for the UCT-V Controller.

Floating

1.8-2 to 1.8-3.

NoTE: This is only applicable, if you wish to change your UCT-V Controller version
from one minor version to another with in the same major version. For example, from

a. From the Image drop-down list, select a UCT-V Controller image with in the same

major version.

b. Specify the Number of Instances. The minimum number you can specify is 1.

c. Select the Network from the drop-down.

Upgrade GigaVUE Fabric Components in GigaVUE-FM for OpenStack
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e You cannot modify the rest of the fields.

e After installing the new version of UCT-V Controller, install the UCT-V with the same
version.

Upgrade GigaVUE V Series Nodes and GigaVUE V Series Proxy

GigaVUE-FM lets you upgrade GigaVUE V Series Proxy and GigaVUE V Series Nodes at a
time.

There are multiple ways to upgrade the GigaVUE V Series Proxy and nodes. You can:
« Launch and replace the complete set of nodes and controllers at a time.

For example, if you have 1 GigaVUE V Series Proxy and 10 GigaVUE V Series nodes in
your project, you can upgrade all of them at once. First, the new version of GigaVUE V
Series Proxy is launched. Next, the new version of GigaVUE V Series Nodes are
launched. Then, the old version of V Series Proxy and nodes are deleted from the
project.

NOTES:

o When the new version of nodes and controllers are launched, the old version still
exists in the project until they are deleted. Make sure the flavor determined during
the configuration can accommodate the total number of new and old fabric nodes
present in the project. If the flavor cannot support so many Virtual Machines, you
can choose to upgrade in multiple batches.

o Ifthereisan error while upgrading the complete set of controllers and nodes
present in the project, the new version of the fabric is immediately deleted and the
old version of the fabric is retained as before.

o Prior to upgrading the GigaVUE V Series Proxy and Nodes, you must ensure that the
required number of floating IP addresses are available in the respective subnets.
Otherwise, the upgrade will fail.

« Launch and replace the nodes and controllers in multiple batches.

For example, if there are 18 GigaVUE V Series Nodes to be upgraded, you can specify
how many you want to upgrade per batch.
To upgrade the GigaVUE V Series Proxy and GigaVUE V Series Nodes:

1. Go to Inventory > VIRTUAL > OpenStack, and then click Monitoring Domain. The
Monitoring Domain page appears.

2. On the Monitoring Domain page, select the connection name check box and click
Actions
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OpensStack » Monitoring Domain

[ New Refresh Inventory
'é’ v [ Monitoring Domain i Connection | Name Management IP Type EelE Genitring S A, Status
. = md201 Edit Fabric
] Delete Monitaring Domain
= v conn201 () Cannected
Delete Fabric
Gi -G-vTapContro... G-vTap Controll =) Ok
igamon-G-vTapContro. wTap Controller Ierare Fatae
Gigamon-YSeriesNode- 1 V Series Mode ) Ok
L
9

FM Instance: GigaVUE-FM

3. Select Upgrade Fabric from the drop-down list. The Fabric Nodes Upgrade page is
displayed.

Fabric Nodes Upgrade
V Series Proxy
Upgrade O

V Series Node

Upgrade

Current Version 232

Image Select an image... -
Change Flavor O

Batch Size 1

Upgrade Cancel

4. To upgrade the GigaVUE V Series Nodes/Proxy, select the Upgrade checkbox.

5. From the Image drop-down list, select the latest version of the GigaVUE V
SeriesProxy/Nodes.
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6. Select the Change Flavor checkbox to change the flavor of the nodes/proxy, only if
required.

7. To upgrade the GigaVUE V Series Nodes/Proxy, specify the batch size in the Batch Size
box.

For example, if there are 7 GigaVUE V Series Nodes, you can specify 7 as the batch size
and upgrade all of them at once. Alternatively, you can specify 3 as the batch size, and
launch and replace 3 V Series nodes in each batch. In the last batch, the remaining 1V
Series node is launched.

8. Click Upgrade.

The upgrade process takes a while depending on the number of GigaVUE V
SeriesProxy and Nodes upgrading in your OpenStack environment. First, the new
version of the GigaVUE V Series Proxy is launched. Next, the new version of GigaVUE V
Series Nodes is launched. Then, the older version of both is deleted from the project. In
the V Series Proxy page, click the link under Progress to view the upgrade status.

The monitoring session is deployed automatically.
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Configure Monitoring Session

This chapter describes how to setup ingress and egress tunnel, maps, applications in a
monitoring session to receive and send traffic to the GigaVUE V Series node. It also describes
how to filter, manipulate, and send the traffic from the V Series node to monitoring tools.

Refer to the following sections for details:

¢ Create a Monitoring Session

e Create Ingress and Egress Tunnels

e Create a New Map

» Add Applications to Monitoring Session
* Deploy Monitoring Session

* View Monitoring Session Statistics

e Visualize the Network Topology

Create a Monitoring Session

You must a Create Monitoring Domain before creating a monitoring session.

GigaVUE-FM automatically collects inventory data on all target instances available in your
cloud environment. You can design your monitoring session to include or exclude the
instances that you want to monitor. You can also choose to monitor egress, ingress, or all
traffic.

When a new target instance is added to your cloud environment, GigaVUE-FM automatically
detects and adds the instance to your monitoring session. Similarly, when an instance is
removed, it updates the monitoring sessions.

For the connections without UCT-Vs, there are no targets that are automatically selected.
You can use Customer Orchestrated Source in the monitoring session to accept a tunnel
from anywhere.

You can create multiple monitoring sessions per monitoring domain.

To create a new monitoring session:
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1. Go to Traffic > Virtual > Orchestrated Flows and select your cloud platform. The
Monitoring Sessions page appears.

2. Click New to open the Create a New Monitoring Session page.

New Monitoring Session Cancel Next
A monitoring session defines how traffic should be processed and send to the tunnel endpoints. You can specify prefiltering and precryption on UCT-Vs or
traffic thresholds by applying the pre-defined templates to your monitoring session.
Alias
Monitoring Domain 0 Domair v
Connections Select C s v

Traffic Distribute
® Traffic distribute is only supported on V Series version 6.5.00 and
later.

3. Enter the appropriate information for the monitoring session as described in the
following table.

Field Description

Alias The name of the monitoring session.

Monitoring The name of the monitoring domain that you want to select.

Domain

Connection The connection(s) that are to be included as part of the monitoring domain. You can

select the required connections that need to be part of the monitoring domain.

Traffic Enabling the "Traffic Distribute" option identifies duplicate packets across different
Distribute GigaVUE V Series Nodes when traffic from various targets is routed to these instances
for monitoring.

4. Click Create. The Edit Monitoring Session Canvas page appears.

The Monitoring Session page Actions button also has the following options:

Button Description

Edit Opens the Edit page for the selected monitoring
session.

NOTE: In case of an error while editing a monitoring session,
undeploy and deploy the monitoring session again.

Delete Deletes the selected monitoring session.
Clone Duplicates the selected monitoring session.
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Button Description

Deploy Deploys the selected monitoring session.
Undeploy Undeploys the selected monitoring session.
Apply Threshold You can use this button to apply the threshold template created

for monitoring cloud traffic health. Refer to Monitor Cloud

Health for more detailed information on cloud traffic health, how
to create threshold templates, and how to apply threshold
templates.

Apply Policy You can use this button to enable precyption, prefiltering, or
Secure Tunnel. Refer to Monitoring Session Options for more
details.

Edit Monitoring Session

In the edit monitoring session canvas page, you can add and configure applications, tunnel
endpoints, raw endpoints, and maps.

Refer to the following topics for detailed information:

e Create Ingress and Egress Tunnels

Add Applications to Monitoring Session

Create Raw Endpoint

Create a New Map

The Edit Monitoring Session page has the following buttons:

Button Description

Options You can enable or disable Prefiltering, Precryption, and
Secure Tunnel here. You can also create prefiltering
template and apply it to the monitoring session. Refer to
Monitoring Session Options for more detailed information.

Show Targets Use to refresh the subnets and monitored instances details
that appear in the Instances dialog box.

Dashboard The dashboard displays the statistics for all the
applications, end points and the maps available in the
monitoring session.
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Button Description

Ok / Cancel Ok: Use to save the configurations in the
monitoring session when the monitoring
session is in undeployed state.

Cancel: After the monitoring session is
deployed, if you have made any changes and
wish to remove them, use this option.

Interface mapping Use to change the interfaces mapped to an individual
GigaVUE V Series Node. Refer to Interface Mapping topic
for more details.

Deploy Deploys the selected monitoring session. Refer to Deploy
Monitoring Session topic for more details.

Monitoring Session Options

Prefiltering, Precyption, Secure tunnel, User-defined applications, and Thresholds can be
enabled for the monitoring session from the Options page.

To navigate to Options page, follow the steps given below:

1. Go to Traffic > Virtual > Orchestrated Flows > Select your cloud platform.

2. Select a monitoring session from the list view, click Actions > Edit. The Edit Monitoring
Session page appears.

3. In the Edit Monitoring Session page, click Options. The Options page appears.

You can perform the following actions in the Options page:

¢ Enable Prefiltering

e Enable Precryption

» Enable User Defined Applications
e Create Threshold

Enable Prefiltering

To enable Prefiltering, follow the steps given below:

1. In the Monitoring Session Options page, Click Mirroring tab.
2. Enable the Mirroring toggle button.

3. Enable the Secure Tunnel button if you wish to use Secure Tunnels. For more
information about Secure Tunnel, refer to Secure Tunnels.
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4. You can select an existing Prefiltering template from the Template drop-down menu,
or you can create a new template and apply it. Refer to Prefiltering for more details on
how to create a new template.

5. Click Save to apply the template to the monitoring session.

You can save the newly created template by using the Save as Template button.

Enable Precryption

To enable Precryption, follow the steps given below:

1. In the Monitoring Session Options page, Click Precryption tab.

2. Enable the Precryption toggle button. Refer to Precryption™ topic for more details on
precryption.

3. Enable the Secure Tunnel button if you wish to use Secure Tunnels. For more
information about Secure Tunnel, refer to Secure Tunnels.

Enable User Defined Applications

To enable user defined application, follow the steps given below:

1. In the Monitoring Session Options page, Click User-Defined Apps tab.

2. Enable the User-defined Applications toggle button. Refer to User Defined
Application for more detailed information User Defined Applications and how to
configure it.

Create Threshold

To create threshold, follow the steps given below:

1. In the Monitoring Session Options page, Click Threshold tab.

2. Refer to Traffic Health Monitoring topic for more detailed information on how to create
threshold template and apply the templates to the monitoring session.

Prefiltering

Prefiltering allows you to filter the traffic at UCT-Vs before sending it to the GigaVUE V Series
Nodes. For prefiltering the traffic, GigaVUE-FM allows you to create a prefiltering policy
template, and the policy template can be applied to a monitoring session.

You can define a policy template with rules and filter values. A policy template once created
can be applied to multiple monitoring sessions. However, a monitoring session can use only
one template.

Each monitoring session can have a maximum of 16 rules.
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You can also edit a specific policy template with required rules and filter values for a
particular monitoring session while editing a monitoring session. However, the customized
changes are not saved in the template.

Some of the points that must be remembered for prefiltering in Next Generation UCT-Vs are:

» Prefiltering is supported only in Next Generation UCT-Vs. It is not supported for classic
mirroring mechanism.

« Prefiltering is supported for both Linux and Windows UCT-Vs.

» For asingle monitoring session, only one prefiltering policy can be applied. All the
agents in that monitoring session are configured with respective prefiltering policy.

« For multiple monitoring sessions, if the same agent is selected by two or more
monitoring sessions, then prefiltering policy cannot be applied. It is default to PassAll.

Create Prefiltering Policy Template

GigaVUE-FM allows you to create a prefiltering policy template with a single rule or multiple
rules. You can configure a rule with a single filter or multiple filters. Each monitoring session
can have a maximum of 16 rules.

To create a prefiltering policy template, do the following steps:
1. Go to Resources > Prefiltering, and then click UCT-V.

2. Click New.

3. Enter the name of the template in the Template Name field.
4. Enter the name of a rule in the Rule Name field.

5. Click any one of the following options:

« Pass — Passes the traffic.
« Drop — Drops the traffic.

6. Click any one of the following options as per the requirement:

« Bi-Directional —- Allows the traffic in both directions of the flow. A single Bi-direction
rule should consist of 1 Ingress and 1 Egress rule.

» Ingress — Filters the traffic that flows in.
« Egress — Filters the traffic that flows out.

7. Select the value of the priority based on which the rules must be prioritized for filtering.
Select the value as 1to pass or drop a rule in top priority. Similarly, you can select the value as
2,3, 4 to 8, where 8 can be used for setting a rule with the least priority. Drop rules are added
based on the priority and, then pass rules are added.

8. Select the Filter Type from the following options:
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- L3
= L4

9. Select the Filter Name from the following options:

»  IP4Src
«  ip4Dst
»  ip6Src
»  ip6Dst

« Proto - It iscommon for both ipv4 and ipv6.

10. Select the Filter Relation from any one of the following options:

« Not Equal to
« Equalto

1. Enter the value for the given filter.

12. Click Save.

NoTe: Click + to add more rules or filters. Click - to remove a rule or a filter.

To enable prefiltering, refer to Monitoring Session Options.

Interface Mapping

You can change the interface of individual GigaVUE V Series Nodes deployed in a
monitoring session. After deploying the monitoring session, if you wish to change the
interfaces mapped to an individual GigaVUE V Series Node, you can use the Interface
Mapping button to map the interface to the respective GigaVUE V Series Nodes. To perform
interface mapping:

1. Go to Traffic > Virtual > Orchestrated Flows and select your cloud platform. The
Monitoring Sessions page appears.

2. Select a Monitoring session from the list view and click Actions > Edit. The Edit
Monitoring session page appears.

3. In the Edit Monitoring session canvas page, click on the Interface Mapping button.

4. The Select nodes to deploy the Monitoring Session dialog box appears. Select the
GigaVUE V Series Nodes for which you wish to map the interface.

5. After selecting the GigaVUE V Series Node, select the interfaces for each of the REPs
and the TEPs deployed in the monitoring session from the drop-down menu for the
selected individual GigaVUE V Series Nodes. Then, click Deploy.
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Create Ingress and Egress Tunnels

Traffic from the GigaVUE V Series Node is distributed to tunnel endpoints in a monitoring
session. A tunnel endpoint can be created using a standard L2GRE, VXLAN, UDPGRE, or

ERSPAN tunnel.

NoTe: GigaVUE-FM allows you to configure Ingress Tunnels in the Monitoring
Session, when the Traffic Acquisition Method is UCT-V.

To create a new tunnel endpoint:

1. After creating a new monitoring session, or click Actions > Edit on an existing
monitoring session, the GigaVUE-FM canvas appears.

2. In the canvas, select New > New Tunnel, drag and drop a new tunnel template to the
workspace. The Add Tunnel Spec quick view appears.
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X  Add Tunnel Spec Save Add To Library

Alias Alias *

Description Description (optional)

Type Select a type...

Select a type...
ERSPAN

VXLAN

Configure Monitoring Session
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3. On the New Tunnel quick view, enter or select the required information as described in
the following table.

Field Description

Alias The name of the tunnel endpoint.

NoTE: Do not enter spaces in the alias name.

Description The description of the tunnel endpoint.

Type The type of the tunnel.
Select ERSPAN, or L2GRE, or VXLAN, TLS-PCAPNG, UDP, or UDPGRE to create a
tunnel.

VXLAN

Traffic Direction
The direction of the traffic flowing through the GigaVUE V Series Node.

In Choose In (Decapsulation) for creating an Ingress tunnel, traffic from the source to the
GigaVUE V Series Node.

IP Version The version of the Internet Protocol. Select IPv4 or IPv6.

Remote Tunnel IP For Ingress tunnel, Remote Tunnel IP is the IP address of
the tunnel source.

VXLAN Network Unique value which is used to identify the VXLAN. The
Identifier value ranges from 1to 16777215.
Source L4 Port Port from which the connection will be established to the

target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

Out Choose Out (Encapsulation) for creating an Egress tunnel from the V Series node to
the destination endpoint.

Remote Tunnel IP For Egress tunnel, Remote Tunnel IP is the IP address of
the tunnel destination endpoint.

MTU The Maximum Transmission Unit (MTU) is the maximum
size of each packet that the tunnel endpoint can carry. The
default value is 1500.

Time to Live Enter the value of the time interval for which the session
needs to be available. The value ranges from 1to 255. The
default value is 64.

DSCP Differentiated Services Code Point (DSCP) are the values,
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Field Description

which network devices use to identify traffic to be handled
with higher or lower priority. The values ranges from O to
63 with O being the highest priority and 63 as the lowest
priority.

Flow Label Unique value which is used to identify packets that belong
to the same flow. A flow is a sequence of packets that need
to be treated as a single entity that may require special
handling. Accepted value is between 0 and 1048575

VXLAN Network Unigue value which is used to identify the VXLAN. The
Identifier value ranges from 1to 16777215.
Source L4 Port Port from which the connection will be established to the

target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

UDPGRE

Traffic Direction
The direction of the traffic flowing through the GigaVUE V Series Node.

In Choose In (Decapsulation) for creating an Ingress tunnel, traffic from the source to the
GigaVUE V Series Node.

IP Version The version of the Internet Protocol. Select IPv4 or IPv6.

Remote Tunnel IP For Ingress tunnel, Remote Tunnel IP is the IP address of
the tunnel source.

Key Identifier used to differentiate different UPDGRE/L2GRE
tunnels. It is used to route the encapsulated frames to the
appropriate tunnel on the remote endpoint. Enter value
between 0 and 4294967295

Source L4 Port Port from which the connection will be established to the
target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

L2GRE

Traffic Direction
The direction of the traffic flowing through the GigaVUE V Series Node.
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Field Description

In Choose In (Decapsulation) for creating an Ingress tunnel, traffic from the source to the
GigaVUE V Series Node.

IP Version The version of the Internet Protocol. Select IPv4 or |IPv6.

Remote Tunnel IP For Ingress tunnel, Remote Tunnel IP is the IP address of
the tunnel source.

Key Identifier used to differentiate different UPDGRE/L2GRE
tunnels. It is used to route the encapsulated frames to the
appropriate tunnel on the remote endpoint. Enter value
between 0 and 4294967295.

Out Choose Out (Encapsulation) for creating an Egress tunnel from the V Series node to
the destination endpoint.

Remote Tunnel IP For Egress tunnel, Remote Tunnel IP is the IP address of
the tunnel destination endpoint.

MTU The Maximum Transmission Unit (MTU) is the maximum
size of each packet that the tunnel endpoint can carry. The
default value is 1500.

Time to Live Enter the value of the time interval for which the session
needs to be available. The value ranges from 1to 255. The
default value is 64.

DSCP Differentiated Services Code Point (DSCP) are the values,
which network devices use to identify traffic to be handled
with higher or lower priority. The values ranges from O to
63 with O being the highest priority and 63 as the lowest
priority.

Flow Label Unique value which is used to identify packets that belong
to the same flow. A flow is a sequence of packets that need
to be treated as a single entity that may require special
handling. Accepted value is between 0 and 1048575.

Key Identifier used to differentiate different UPDGRE/L2GRE
tunnels. It is used to route the encapsulated frames to the
appropriate tunnel on the remote endpoint. Enter value
between 0 and 4294967295.

ERSPAN

Traffic Direction
The direction of the traffic flowing through the GigaVUE V Series Node.
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Field Description

In IP Version The version of the Internet Protocol. Select IPv4 or IPv6.

Remote Tunnel IP For Ingress tunnel, Remote Tunnel IP is the IP address of
the tunnel source.

Flow ID The ERSPAN flow ID is a numerical identifier that
distinguishes different ERSPAN sessions or flows. The value
ranges from 1to 1023.

TLS-PCAPNG

Traffic Direction
The direction of the traffic flowing through the GigaVUE V Series Node.

In IP Version The version of the Internet Protocol. only IPv4 is supported.

Remote Tunnel IP For Ingress tunnel, Remote Tunnel IP is the IP address of
the tunnel source.

MTU The Maximum Transmission Unit (MTU) is the maximum
size of each packet that the tunnel endpoint can carry. The
default value is 1500.

Source L4 Port Port from which the connection will be established to the
target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

Key Alias Select the Key Alias from the drop-down.
Cipher Only SHA 256 is supported.

TLS Version Only TLS Version1.3.

Selective Enable to receive the acknowledgments.

Acknowledgments

Sync Retries Enter the value for number of times the sync has to be
tried. The value ranges from 1to 6.

Delay Enable to receive the acknowledgments when there is a
Acknowledgments delay.
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Field Description

Out

IP Version

The version of the Internet Protocol. only IPv4 is supported.

Remote Tunnel IP

For Ingress tunnel, Remote Tunnel IP is the IP address of
the tunnel source.

MTU

The Maximum Transmission Unit (MTU) is the maximum
size of each packet that the tunnel endpoint can carry. The
default value is 1500.

Time to Live

Enter the value of the time interval for which the session
needs to be available. The value ranges from 1to 255. The
default value is 64.

DSCP

Differentiated Services Code Point (DSCP) are the values,
which network devices use to identify traffic to be handled
with higher or lower priority. The values ranges from O to
63 with O being the highest priority and 63 as the lowest
priority.

Flow Label

Unique value which is used to identify packets that belong
to the same flow. A flow is a sequence of packets that need
to be treated as a single entity that may require special
handling. Accepted value is between 0 and 1048575

Source L4 Port

Port from which the connection will be established to the
target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port

Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

Cipher Only SHA 256 is supported.
TLS Version Only TLS Version1.3.
Selective Enable to receive the acknowledgments.

Acknowledgments

Sync Retries

Enter the value for number of times the sync has to be
tried. The value ranges from 1to 6.

Delay
Acknowledgments

Enable to receive the acknowledgments when there is a
delay.

ubDP
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Field Description

Out L4 Destination IP Enter the IP address of the tool port or when using
Address Application Metadata Exporter (AMX), enter the IP address
of the AMX application. Refer to Application Metadata
Exporter for more detailed information on what

AMX application is and how to configure it.

Source L4 Port Port from which the connection will be established to the
target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

4. Click Save.
To delete a tunnel, select the required tunnel and click Delete.

To apply threshold template to Tunnel End Points, select the required tunnel end point on
the canvas and click Details. The quick view appears, click on the Threshold tab. For more
details on how to create or apply threshold template, refer to Monitor Cloud Health topic.

Tunnel End Points configured can also be used to send or receive traffic from GigaVUE HC
Series and GigaVUE TA Series. Provide the IP address of the GigaVUE HC Series and GigaVUE
TA Series as the Source or the Destination IP address as required when configuring Tunnel
End Points.

After configuring the tunnels and deploying the monitoring session, you can view the
names of egress tunnels configured for a monitoring session, on the Monitoring Session
details page. The Egress Tunnel column displays the name of the egress tunnel configured
for a particular monitoring session. When multiple egress tunnels are configured for a
monitoring session, then the Egress Tunnel column displays the number of egress tunnels
configured in that monitoring session. Hover over the number of egress tunnels to display
the names of the egress tunnels used in that particular monitoring session.

Create a New Map

You must have the flow map license to deploy a map in the monitoring session.

For new users, the free trial bundle will expire after 30 days, and the GigaVUE-FM prompts
you to buy a new license. For licensing information, refer to GigaVUE Licensing Guide.

Configure Monitoring Session 109
Create a New Map


../../../../../../../Content/GV-Cloud-V-Series-Applications/AMX_intro.htm
../../../../../../../Content/GV-Cloud-V-Series-Applications/AMX_intro.htm

GigaVUE Cloud Suite Deployment Guide - OpenStack

A map is used to filter the traffic flowing through the GigaVUE V Series Nodes. It is a
collection of one or more rules (R). The traffic passing through a map can match one or more
rules defined in the map.

Keep in mind the following when creating a map:

Parameter Description

Rules A rule (R) contains specific filtering criteria that the packets must
match. The filtering criteria lets you determine the targets and
the (egress or ingress) direction of tapping the network traffic.

Priority Priority determines the order in which the rules are executed.
The priority value can range from 1to 5, with 1 being the highest
and 5 is the lowest priority.

Pass The traffic from the virtual machine will be passed to the
destination.
Drop The traffic from the virtual machine is dropped when passing

through the map.

Traffic Filter Maps A set of maps that are used to match traffic and perform various
actions on the matched traffic.

Inclusion Map An inclusion map determines the instances to be included for
monitoring. This map is used only for target selection.
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Exclusion Map

An exclusion map determines the instances to be excluded from
monitoring. This map is used only for target selection.

Automatic Target Selection (ATS)

A built-in feature that automatically selects the cloud instances
based on the rules defined in the traffic filter maps, inclusion
maps, and exclusion maps in the monitoring session.

The below formula describes how ATS works:

Selected Targets = Traffic Filter Maps N Inclusion Maps -
Exclusion Maps

Below are the filter rule types that work in ATS:

« mac Source

« mac Destination

o ipV4 Source

« ipv4 Destination

« ipv6 Source

« ipv6 Destination

« VM Name Destination

« VM Name Source

« VM Tag Destination - Not applicable to Nutanix.

« VM Tag Source - Not applicable to Nutanix.

« VM Category Source - Applicable only to Nutanix

« VM Category Destination - Applicable only to Nutanix.

« Host Name -Applicable only to Nutanix and VMware.
The traffic direction is as follow:

« Forany rule type as Source - the traffic direction is egress.
« For Destination rule type - the traffic direction is ingress.

o« For Hostname - As it doesn't have Source or Destination rule
type, the traffic direction is Ingress and Egress.

NoTE: If no ATS rule filters listed above are used, all VMs and
VNICS are selected as targets. When any ATS rule results in a
null set, no target is selected and V Series Node does not
receive traffic from any VM or vNIC.

Group

A group is a collection of maps that are pre-defined and saved in
the map library for reuse.

To create a new map:

Configure Monitoring Session
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1. After creating a new monitoring session, or click Actions > Edit on an existing
monitoring session, the GigaVUE-FM canvas appears.

2. In the canvas, select New > New Map, drag and drop a new map template to sthe

workspace. The New Map quick view appears.

Monitoring Session X Map Save Add to Library

Rulesets Thresholds
v New Q

*
Q v
New Tunnel @

Description
. Descriptio

@ New Raw Endpoint

> Map Library
> Applications

> Tunnels <

3. On the New Map quick view, click on General tab and enter the required information
as described in the following table:

Field Description
Name

Name of the new map

Description Description of the map

Pass and Drop rule selection with Automatic Target Selection (ATS) differ with
the Map type as follows:

o Traffic Map—Only Pass rules for ATS
° |nclusion Map—Only Pass rules for ATS
o Exclusion Map—Only Drop rules for ATS
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4. Click on Rule Sets tab. Through the map, packets can be dropped or passed based on
the highest to lowest rule priority. You can add 5 rule sets on a map. Use the + and -
buttons to add or remove a rule set in the map. Each rule set can have only 25 rules per
map and each rule can have a maximum of 4 conditions. To add ATS rules for an
Inclusion/Exclusion map, you must select at least one rule condition. Refer to Example-
Create a New Map using Inclusion and Exclusion Maps for more detailed information
on how to configure Inclusion and Exclusion maps using ATS.

a. To create a new rule set:
i. Click Actions > New Rule Set.

ii. Enter a Priority value from 1to 5 for the rule with 1 being the highest and 5 is
the lowest priority.

iii. Enter the Application Endpoint in the Application EndPoint ID field.
iv. Select a required condition from the drop-down list.
V. Select the rule to Pass or Drop through the map.
b. To create a new rule:
i. Click Actions > New Rule.

ii. Select a required condition from the drop-down list. Click " and select Add
Condition to add more conditions.

iii. Select the rule to Pass or Drop through the map.
5. Click Save.

NoTE: If a packet is fragmented then all the fragments will be destined to the same
application end point. You can find the stats of mapped fragmented traffic in
GigaVUE-FM. Refer to "Map Statistics" section in GigaVUE Fabric Management Guide
for detailed information.

To edit a map, select the map and click Details, or click Delete to delete the map.

To apply threshold template to maps, select the required map on the canvas and click
Details. The quick view appears, click on the Threshold tab. For more details on how to
create or apply threshold templates, refer to Monitor Cloud Health.

Rules and Notes:

e Directional rules do not work on single NIC VMs that are running a Windows UCT-V.

You can also perform the following action in the Monitoring session canvas.

e Click a map and select Details to edit the map
¢ Click a map and select Delete to delete the map.

» Click the Show Targets button to refresh the subnets and monitored instances details
that appear in the Instances dialog box.
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* Click ¥ to expand the Targets dialog box. To view details about a GigaVUE V Series
Node, click the arrow next to the VM.

°* In the Instances window, click A to filter the list of instances.

Example- Create a New Map using Inclusion and Exclusion Maps

Consider a monitoring session with 5 cloud instances. Namely target-1-1, target-1-2, target-1-
3, target-2-1, target-2-2.
1. Drag and drop a new map template to the workspace. The New map quick view
appears.

2. In the General tab, enter the name as Map 1and enter the description. In the Rule sets
tab, enter the priority and Application Endpoint ID.

3. Select the condition as VM Name and enter the target. This includes the instances
target-1-1, target-1-2, target-1-3, target-2-1, and target-2-2.

4. Click on the Expand icon at the bottom of the Monitoring session canvas. The Inclusion
Maps and Exclusion Maps section appears.

5. Drag and drop a new map template to the Inclusion Maps region. The New Map quick
view appears. Enter the Name and Description of the map.

a. In the General tab, enter the name as Inclusionmapl and enter the description. In
the Rule Sets, enter the priority and Application Endpoint ID.

b. Select the condition as VM Name and enter the VM Name as target-1. Then the
instance with VM name target-1-1, target-1-2, and target-1-3 will be included.

6. Drag and drop a new map template to the Exclusion Maps region. The New Map quick
view appears. Enter the details as mentioned in the above section.

a. In the General tab, enter the name as Exclusionmapl and enter the description. In
the Rule Sets tab, enter the priority and Application Endpoint ID.

b. Select the condition as VM Name and enter the VM Name as target-1-3. Then the
instance target-1-3 will be excluded.

Based on this configuration, the Automatic Target Selection will select the instances
target-1-1 and target-1-2 as target.

Map Library

To reuse a map,

1. In the Monitoring Session page, Click Actions > Edit. The Edit Monitoring Session page
opens.

2. Click the map you wish to save as a template. Click Details. The Application quick view
appears.

3. Click Add to Library. Save the map using one of the following ways:
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4. Select an existing group from the Select Group list or create a New Group with a
name.

5. Enter a description in the Description field, and click Save.

The Map is saved to the Map Library in the Edit Monitoring Session Canvas page. This map
can be used from any of the monitoring session. To reuse the map, drag and drop the saved
map from the Map Library.

Add Applications to Monitoring Session

GigaVUE Cloud Suite with GigaVUE V Series Node supports the following GigaSMART
applications in the GigaVUE-FM canvas:

e Slicing

¢ Masking

¢ De-duplication

e |oad Balancing

e PCAPNg Application

» 5G-Service Based Interface Application
» Header Stripping

e SSL Decrypt

For more detailed information on how to configure these application, refer to GigaVUE
V Series Applications Guide.

You can also configure the following GigaSMART operations from the Traffic > Solutions >
Application Intelligence:

« Application Metadata Intelligence
« Application Filtering Intelligence

For more information, refer to these GigaSMART Operations in the GigaVVUE Fabric
Management Guide.

Deploy Monitoring Session

To deploy the monitoring session:
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1. Drag and drop the following items to the canvas as required:
* Ingress tunnel (as a source) from the NEW section
* Maps from the MAP LIBRARY section

e Inclusion and Exclusion maps from the Map Library to their respective section at the
bottom of the workspace.

* GigaSMART apps from the APPLICATIONS section
e Egress tunnels from the TUNNELS section

2. After placing the required items in the canvas, hover your mouse on the map, click the
red dot, and drag the arrow over to another item (map, application, or tunnel).

NOTE: You can drag multiple arrows from a single map and connect them to
different maps.

Monitoring Session Deploy oK
v NEW » MONITORING SESSION INFO
B .- v TARGETS =
New Map New Tunnel v Conn .
v MAP LIBRARY Q

a Tunnel2
'E Tuggel1 @
Map1 < ﬁ/ .‘—) Conn
v APPLICATIONS Q

:

o © .
10.10.30.0/24 to 10.110.50.0/24 to
10.110.40.0/282600:1f14.fa4:4bee::/64 -
Slicing Masking v
”~
+ TUNNELS Q
< v >
S TN = SR
~ =) (&3 (+

Tunnell Tunnel2 -

3. (Not applicable for Tunnel traffic acquisition method) Click Show Targets to view
details about the subnets and monitored instances. The instances and the subnets
that are being monitored are highlighted in orange.

4. Click Deploy to deploy the monitoring session. The status is displayed as Success in
the Monitoring Sessions page. The session is successfully deployed on all the V Series
nodes. Click on the status link in the Status column on the Monitoring Session page to
view the Monitoring Session Deployment Report. When you click on the Status link, the
Deployment Report is displayed. If the monitoring session is not deployed properly,
then one of the following errors is displayed in the Status column.

e Partial Success—The session is not deployed on one or more instances due to V
Series node failure.

e Failure—The session is not deployed on any of the V Series nodes.

The Monitoring Session Deployment Report displays the errors that appeared during

deployment.

NoOTE: After rebooting your Ubuntu, you must redeploy the respective monitoring
sessions to restore the mirror traffic on the respective Ubuntu VM interfaces.
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The Monitoring Session page also has the following buttons:

Button Description

Undeploy Undeploys the selected monitoring session.
Clone Duplicates the selected monitoring session.
Edit Opens the Edit page for the selected
monitoring session.
NoOTE: In case of an error while editing a monitoring
session, undeploy and deploy the monitoring session
again..
Delete Deletes the selected monitoring session.
Apply Template Applies the prefiltering template to a monitoring session

View Monitoring Session Statistics

The Monitoring Session Statistics page lets you analyze the incoming and outgoing traffic on
an hourly, daily, weekly, and monthly basis.

On the Monitoring Sessions page, click the name of the monitoring session, and then click
View. A split window appears displaying the Statistics, Connections, V Series Nodes,
Source Health and Http2 Logging of the monitoring session as shown:

Monitoring Sessions

Traffic Rate

CONNECTIONS

Conn

Conn

By Severity

TUNNELS

tun-out

Connections

New v Actions v Filter
CONNECTION STATUS USAGE GB
coara00
68
Failed
Conbectad] 000000
100% G8
oce -
Loneikozs
NODE HEALTH DEPLOYMENT ... THRESHOLDS ... TRAFFIC DISTR... PREFILTERING PRECRYPT &
1of 1 are Healtt Success No No No No
OofOareHealtt @ NotDeployec  No No No No
»
V Series Nodes Source Health Hitp2 Logging Actions W k3
Day v | Outgoing +1 more v

NN\

Lt = PBlatform: All ¥ Monitoring Domains: Al
OVERVIEW 'V-SERIES ALARMS
1/3 1 o
CONNECTIONS V SERIES ALARMS
MONITORINGS..  STATUS MONITORING . PLATFORM
Ms-test Healthy md-new OpenStack
tes_ms_1 Healthy md-new OpenStack
‘
Go to page: of 1 2 monitoring sessions total
X Ms-test md-new
Select Chart Options ©) IV Series Nodes v
CANVAS ELEMENT HEALTH
B masking
@ wnin
o
@ wnount

2023-10.26 1408

2023-10°26 1808 2023-10°26 2208 20231027 0208

To know more about the statistics of the session, click Statistics.
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You can view the statistics by applying different filters as per the requirements of analysing
the data. GigaVUE-FM allows you to perform the following actions on the Monitoring Session
Statistics page:

= You can view the Statistics in full screen. To view in full screen, click the Actions drop-

down list at the right corner of the window, and select Full Screen. Statistics appear in
full screen.

» You can view the incoming and outgoing traffic on an hourly, daily, weekly, and
monthly basis. You can select the options from the drop-down list box.

= You can filter the traffic and view the statistics based on factors such as Incoming,
Outgoing, Ratio (Out/In), Incoming Packets, Outgoing Packets, Ratio (Out/In)
Packets. You can select the options from the drop-down list box.

« You can also view the statistics of the monitoring session deployed in the individual V
Series Nodes. To view the statistics of the individual V Series Node, select the name of
the V Series Node from the drop-down list for which you want to view the statistics

from the V Series node drop-down menu on the top left corner of the Monitoring
Session Statistics page.

* You can view the statistics of the elements involved in the monitoring session. To view the

statistics, click on the Select Chart Options page and select the elements associated with
the session.

» Directly on the graph, you can click on Incoming(Mbps), Outgoing (Mbps), or Ratio
(Out/In) (Mbps) to view the statistics individually.

Visualize the Network Topology

You can have multiple connections in GigaVUE-FM. Each connection can have multiple
monitoring sessions configured within them. You can select the connection and the
monitoring session to view the selected subnets and instances in the topology view.

To view the topology diagram in GigaVUE-FM:

1. On the Monitoring Session page, select Topology tab. The Topology page appears.
2. Select a monitoring domain from the Select monitoring domain... list.
3. Select a connection from the Select monitoring session...list.
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4. Select a monitoring session from the Select connection... list. The topology view of the
monitored subnets and instances in the selected session are displayed.

Filter Default View oK

x - ~ | Filter by: O rabric (J Monitored

& Connection
s Subnet
Cinstance

9 =
o8 ®
&)

(O

= =) r

i
i
¥
:

5. (Optional) Hover over or click the subnet or VM Group icons to view the subnets or
instances present within the group.

In the topology page, you can also do the following:

e Use the Filter button to filter the instances based on the VM name, VM IP, Subnet ID, or
Subnet IP, and view the topology based on the search results.

» Use the Default View button to view the topology diagram based on the source
interfaces of the monitoring instances.

e Use the arrows at the right-bottom corner to move the topology page up, down, left, or
right. Click the Fit-to-Width icon to fit the topology diagram according to the width of
the page.

e Use + or - icons to zoom in and zoom out the topology view.
GigaVUE-FM allows you to monitor the traffic and configuration health status of the
monitoring session and its individual components. This section provides detailed

information on how to view the traffic and configuration health status of the monitoring
session and its individual components.

Configuration Health Monitoring

The configuration health status provides us detailed information about the configuration
and deployment status of the deployed monitoring session.

This feature is supported for the following fabric components and features on the respective
cloud platforms:
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For V Series Nodes:

« AWS

e Azure

* OpenStack
¢ VMware

e Nutanix

For UCT-Vs:

« AWS
e Azure
¢ OpenStack

For VPC Mirroring:
¢ AWS

For OVS Mirroring and VLAN Trunk Port:

¢ OpenStack

To view the configuration health status, refer to the View Health Status section.

Traffic Health Monitoring

GigaVUE-FM allows you to monitor the traffic health status of the entire monitoring session
and also the individual V Series Nodes for which the monitoring session is configured. Traffic
health monitoring focuses on identifying any discrepancies (packet drop or overflow etc) in
the traffic flow. When any such discrepancies are identified, GigaVUE-FM propagates the
health status to corresponding monitoring session. GigaVUE-FM monitors the traffic health
status in near real-time. GigaVUE V Series Node monitors the traffic, when the traffic limit
goes beyond the upper or lower threshold values that is configured, it notifies GigaVUE-FM,
based on which traffic health is computed.

NoTeE: When GigaVUE-FM and GigaVUE V Series Nodes are deployed in different
cloud platforms, then the GigaVUE-FM public IP address must be added to the Data
Notification Interface as the Target Address in the Event Notifications page. Refer to
Configuration Settings section in the GigaVUE Administration Guide for
configuration details.

This feature is supported for GigaVUE V Series Nodes on the respective cloud platforms:

For V Series Nodes:
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e AWS

e Azure
OpenStack
¢ VMware

The following section gives step-by-step instructions on creating, applying, and editing
threshold templates across a monitoring session or an application, and viewing the traffic
health status. Refer to the following section for more detailed information:

e Create Threshold Template

e Apply Threshold Template

e Edit Threshold Template

e Clear Thresholds

e Supported Resources and Metrics

Keep in mind the following points when configuring a threshold template:

» By default Threshold Template is not configured to any monitoring session. If you wish to
monitor the traffic health status, then create and apply threshold template to the
monitoring session.

e Editing or redeploying the monitoring session will reapply all the threshold policies
associated with that monitoring session.

e Deleting or undeploying the monitoring session will clear all the threshold policies
associated with that monitoring session.

» After applying threshold template to a particular application, you need not deploy the
monitoring session again.

Create Threshold Template

To create threshold templates:

1. In GigaVUE-FM, on the left navigation pane, select Traffic > Virtual > Orchestrated
Flows and select your cloud platform. Then, click on the Threshold Template tab in
the top navigation bar.

2. The Threshold Template page appears. Click Create to open the New Threshold
Template page.
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3. Enter the appropriate information for the threshold template as described in the
following table.

Field Description

Threshold Template The name of the threshold template.

Name

Thresholds

Monitored Objects Select the resource for which you wish to apply the threshold template. Eg:
TEP, REP, Maps, Applications like Slicing, Dedup etc

Time Interval Frequency at which the traffic flow needs to be monitored.

Metric Metrics that needs to be monitored. For example: Tx Packets, Rx Packets.

Type Difference: The difference between the stats counter at the start and end

time of an interval, for a given metric.

Derivative: Average value of the statistics counter in a time interval, for a
given metric.

Condition Over: Checks if the statistics counter value is greater than the
'Set Trigger Value'.

Under: Checks if the statistics counter value is lower than the
'Set Trigger Value'.

Set Trigger Value Value at which a traffic health event is raised, if statistics counter goes below
or above this value, based on the condition configured.

Clear Trigger Value Value at which a traffic health event is cleared, if statistics counter goes
below or above this value, based on the condition configured.

4. Click Save. The newly created threshold template is saved, and it appears on the
Threshold Template page.

Apply Threshold Template

You can apply your threshold template across the entire monitoring session and also to a
particular application.

Apply Threshold Template to Monitoring Session

To apply the threshold template across a monitoring session, follow the steps given below:

1. In GigaVUE-FM, on the left navigation pane, select Traffic > Virtual > Orchestrated
Flows and select your cloud platform. The Monitoring Session page appears.

2. Select the monitoring session and click Actions > Apply Thresholds.

3. The Apply Thresholds page appears. To apply a threshold template across a
monitoring session, select the template you wish to apply across the monitoring
session from the Threshold Template drop-down menu or enter the threshold values
manually.

4. Click Done.
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Apply Threshold Template to Applications

To apply the threshold template to a particular application in the monitoring session follow
the steps given below:

NoTE: Applying threshold template across monitoring session will not over write the
threshold value applied specifically for an application. When a threshold value is
applied to a particular application, it over writes the existing threshold value for that
particular application.

1. On the Monitoring Session page. Click Actions > Edit. The Edit Monitoring Session
page with canvas page appears.

2. Click on the application for which you wish to apply or change a threshold template
and click Details. The Application quick view opens.

3. Click on the Thresholds tab. Select the template you wish to apply from the Threshold
Template drop-down menu or enter the threshold values manually.

4. Click Save.

Edit Threshold Template

To edit a particular threshold template follow the steps given below:

1. On the Threshold Template page, Click Edit. The Edit Threshold Template page
appear.

2. The existing threshold templates will be listed here. Edit the templates you wish to
modify.

3. Click Save.

NoTE: Editing a threshold template does not automatically apply the template to
monitoring session. You must apply the edited template to monitoring session for
the changes to take effect.

Clear Thresholds

You can clear the thresholds across the entire monitoring session and also to a particular
application.

Clear Thresholds for Applications

To clear the thresholds of a particular application in the monitoring session follow the steps
given below:
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1. On the Monitoring Session page. Click Actions > Edit. The Edit Monitoring Session
page with canvas page appears.

2. Click on the application for which you wish to clear the thresholds and click Details.
The Application quick view opens.

3. Click on the Thresholds tab. Click Clear All and then Click Save.

Clear Thresholds across the Monitoring Session

To clear the applied thresholds across a monitoring session follow the steps given below:
1. In GigaVUE-FM, on the left navigation pane, select Traffic > Virtual > Orchestrated
Flows and select your cloud platform. The Monitoring Sessions page appears.
2. Select the monitoring session and click Actions > Apply Thresholds.
3. The Apply Thresholds page appears. Click Clear.

NoTE: Clearing thresholds at monitoring session level does not clear the thresholds
that were applied specifically at the application level. To clear thresholds for a
particular application refer to Clear Thresholds for Applications

Supported Resources and Metrics

The following table lists the resources and the respective metrics supported for traffic health
monitoring

Resource Metrics Threshold types Trigger
Condition

Tx Packets 1. Difference 1. Over
Rx Packets 2. Derivative 2. Under

Tunnel End Point

Tx Bytes
Rx Bytes
Tx Dropped
Rx Dropped
Tx Errors
Rx Errors

Tx Packets 1. Difference 1. Over
Rx Packets 2. Derivative 2. Under

Raw End Point

Tx Bytes
Rx Bytes
Tx Dropped
Rx Dropped

N uhWNN O30 0 N NEN o

Tx Errors
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8. Rx Errors
Map 1. Tx Packets Difference . Over
2. Rx Packets Derivative Under

3. Packets

Dropped
Slicing 1. Tx Packets Difference 1. Over
2. Rx Packets Derivative Under

3. Packets

Dropped
Masking 1. Tx Packets Difference . Over
2. Rx Packets Derivative Under

3. Packets

Dropped
Dedup 1. Tx Packets Difference 1. Over
2. Rx Packets Derivative Under

3. Packets

Dropped
Header Stripping 1. Tx Packets Difference . Over
2. Rx Packets Derivative Under

3. Packets

Dropped
Tunnel Encapsulation 1. Tx Packets Difference 1. Over
2. Rx Packets Derivative Under

3. Packets

Dropped
Load Balancing 1. Tx Packets Difference . Over
2. Rx Packets Derivative Under

3. Packets

Dropped
SSL Decryption 1. Tx Packets Difference 1. Over
2. Rx Packets Derivative Under

3. Packets

Dropped
Application Metadata 1. Tx Packets Difference . Over
2. Rx Packets Derivative Under

3. Packets

Dropped
AMI Exporter 1. Tx Packets Difference 1. Over
2. Rx Packets Derivative Under
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3. Packets
Dropped

Geneve 1. Tx Packets 1. Difference 1. Over
2. Rx Packets 2. Derivative 2. Under

3. Packets
Dropped

5G-SBI 1. Tx Packets 1. Difference 1. Over
2. Rx Packets 2. Derivative 2. Under

3. Packets
Dropped

View Health Status

You can view the health status of the monitoring session on the Monitoring Session details
page. The health status of the monitoring session is healthy only if both the configuration
health and traffic health are healthy.

View Health Status of the Entire Monitoring
Session

To view the health status of a monitoring session:
1. On the Monitoring Session details page, click on the health status displayed in the
Status column of the monitoring session.

2. The monitoring session diagram is displayed, click on the Status displayed in the top
left-corner above the canvas. The quick view page appears.

This displays the configuration health and traffic health of the monitoring session and also
the thresholds applied to that monitoring session.

View Health Status of an Application

To view the health status of an application across an entire monitoring session:

1. On the Monitoring Session page, click on the health status displayed in the Status
column of the monitoring session.

2. The monitoring session diagram is displayed.

3. To view application health, click on the application for which you wish to see the health
status. The quick view page appears.

4. Click on the Status tab.
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This displays the configuration health and traffic health of the application and also the
thresholds applied to that particular application.

NOTE: The secure tunnel status is refreshed for every 5 minutes, and the GigaVUE-FM
does not display UCT-V secure tunnel status that is older than 7 minutes. If the secure
tunnel in the UCT-V is removed, it takes up to 7 minutes to reset the status on the
GigaVUE-FM.

View Health Status for Individual V Series Nodes

You can also view the health status of the view the health status of an individual GigaVUE V
Series Node. To view the configuration health status and traffic health status of the V Series
Nodes:

1. On the Monitoring Session page, click on the health status in the Status column of the
monitoring session.

2. The monitoring session diagram is displayed. Select the V Series Node from the View
By drop-down menu and then click on the Status displayed in the top left-corner
above the canvas. The quick view page appears.

View Application Health Status for Individual V
Series Nodes

To view the application configuration and traffic health status of the GigaVUE V Series
Nodes:

1. On the Monitoring Session page, click on the health status in the Status column of the
monitoring session.

2. The monitoring session diagram is displayed. Select the V Series Node from the View
By drop-down menu.

3. To view application health, click on the application for which you wish to see the health
status. The quick view page appears.

4. Click on the Status tab.

The subsession toggle button available in the top-left corner of the canvas allows you to view
the statistics of individual paths in the monitoring session. If the traffic health is not
configured for monitoring session or a particular application, the traffic health is displayed as
Not Applicable.

View Health Status .|2,7
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View Health Status on the
Monitoring Session Page

You can view the health status of the monitoring session and the components deployed, in
the monitoring session page.

The following columns in the monitoring session page are used to convey the health status:

Health

This column displays the health status (both traffic and configuration) of the entire
monitoring session. The status is marked healthy only if both the traffic and configuration
health status is healthy, even if either of them is unhealthy then the health status is moved
to unhealthy.

V Series Node Health

This column displays the configuration and traffic health status of the monitoring session
deployed in V Series Nodes. This column provides information on the number of GigaVUE V
Series Nodes that have healthy traffic flow and monitoring session successfully deployed to
the total number of V Series Nodes that have monitoring session deployed.

You can view the health status of the individual V Series Nodes by clicking on the V Series
Node Health column.

NoOTE: V Series Node health only displays the health status therefore even if the
V Series Node is down it will not be reflected in the monitoring session page.

Target Source Health

This column displays the configuration health status of the monitoring session deployed in
targets. This column provides information on the number of monitoring sessions
successfully deployed on a particular target to the total number of monitoring session
deployed on that particular target.

You can view the health status of the individual targets and also the error message
associated with them, by clicking on the Target Source Health column.
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Secure Tunnels

Secure Tunnel securely transfers the cloud captured packets on UCT-V and UCT-C to a
GigaVUE V Series Node or Tool (only in case of UCT-C). The data from UCT-V and UCT-C are
encapsulated in PCAPNng format, and the encrypted data is sent over a TLS connection to a
GigaVUE V Series Node.

Secure Tunnel can also transfer the cloud captured packets from a GigaVUE V Series Node
to another GigaVUE V Series Node.

In case of GigaVUE V Series Node to GigaVUE V Series node, the traffic from the GigaVUE V

Series Node 1is encapped using PCAPNg format and transported to GigaVUE V Series Node
2 where the traffic is decapped. The secure tunnels between V Series Node to V Series Node
have multiple uses cases.

The GigaVUE V Series Node decapsulates and processes the packet per the configuration.
The decapsulated packet can be sent to the application such as De-duplication, Application
Intelligence, Load balancer and to the tool. The Load Balancer on this node can send the
packets to multiple V series Nodes, in this case the packets can be encapsulated again and
sent over a secure tunnel.

For more information about PCAPNg, refer to PCAPNg Application.

Secure Tunnel Use Case
Tool in remote Virtual Private Cloud (VPC) — Single V Series Node

* VS1toVS2:Single
TCP/TLS

tunnel connection
UCT-Cor

JaRy * VS2toTool :
\ Could be multiple
tools / tunnels

Secure Tunnel
Decapsulation

Application
or Filter
Map

Secure Tunnel Securem.nnel
decryption

Tunnel Tool
Encapsulation

Tunnel Map
Decapsulation

V Series Node (VS1) V Series Node (V52)

VPC-1 VPC-2

Legend
> Secure Tunnel (TCP/TLS PCAPng)

_— VxLAN or L2GRE Packet %
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Supported Platforms

Secure tunnel is supported on:

« OpenStack

« Azure

« AWS

« VMware NSX-T (only for Third Party Orchestration)

« VMware ESXi (only for Third Party Orchestration)

« Nutanix (only for Third Party Orchestration)

« Google Cloud Platform (only for Third Party Orchestration)

For information about how to configure secure tunnels, refer to the section Configure
Secure Tunnel.

Configure Secure Tunnel

Secure tunnels can be configured on:

» Precrypted Traffic
 Mirrored Traffic

Precrypted Traffic

You can send the precrypted traffic through secure tunnel. When secure tunnel for
precryption is enabled, packets are framed and sent to the TLS socket. PCAPNg format is
used to send the packet.

When you enable the secure tunnel option for both regular and precryption packets, then
two TLS secure tunnel sessions are created.

It is recommended to always enable secure tunnels for precrypted traffic to securely transfer
the sensitive information.

For more information about PCAPNg, refer to PCAPNng Application.

Mirrored Traffic

You can enable the Secure Tunnel for mirrored traffic. By default, Secure Tunnel is disabled.

Refer to the following sections for Secure Tunnel Configuration:

« Configure Secure Tunnel from UCT-V to GigaVUE V Series Node in UCT-V
« Configure Secure Tunnel from GigaVUE V Series Node 1to GigaVUE V Series Node 2
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Prerequisites

«  While creating Secure Tunnel, you must provide the following details:

SSH key pair
CA certificate

m Port 11443 should be enabled in security group settings.

Configure Secure Tunnel from UCT-V to GigaVUE V Series Node

To configure a secure tunnel in UCT-V, you must configure one end of the tunnel to the UCT-
V and the other end to GigaVUE V Series node. You must configure the CA certificates in
UCT-V and the the private keys and SSL certificates in GigaVUE V Series node. Refer to the

following steps for configuration:

S.No Task

1. Upload a CA

Description

You must upload a Custom Authority (CA) Certificate to UCT-V Controller
for establishing a connection with the GigaVUE V Series node.

To upload the CA using GigaVUE-FM follow the steps given
below:

1. Go to Inventory > Resources > Security > CA List.

2. Click New, to add a new Custom Authority. The Add Custom
Authority page appears.

3. Enter or select the following information.

Field Action

Alias Alias name of the CA.

File Upload | Choose the certificate from the desired location.

4. Click Save.

For more information, refer to Adding Certificate Authority
section.

2. Upload a SSL Key

You must add a SSL key to GigaVUE V Series node. To add SSL Key, follow
the steps in the section SSL Decrypt.

3 Enable the secure
tunnel

You should enable the secure tunnel feature to establish a connection

between the UCT-V and GigaVUE V Series node. To enable the secure

tunnel feature follow these steps:

1. Inthe Edit Monitoring Session page, click Options. The Monitoring
Session options page appears.

2. Enable the Secure Tunnel button. You can enable secure tunnel for
both mirrored and precrypted traffic.

NoTe: When GigaVUE V Series is upgraded or deployed to 6.5 version, l
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S.No Task Description

TLS TEPs are created each UCT-V agent in GigaVUE V Series node.

all the existing monitoring sessions will be redeployed, and individual |

4, Select the SSL Key You must select the added SSL Key in GigaVUE V Series node Key while
creating a monitoring domain configuring the fabric components in
GigaVUE-FM.

To select the SSL key, follow the steps in the section Configure
GigaVUE Fabric Components in GigaVUE-FM

If the existing monitoring domain does not have a SSL key, you can add it
by following the given steps:

1. Select the monitoring domain for which you want to add the SSL key.

2. Click the Actions drop down list and select Edit SSL Configuration.
An Edit SSL Configuration window appears.

3. Select the CA in the UCT-V Agent Tunnel CA drop down list.

4. Select the SSL key in the V Series Node SSL key drop down list.

5. Click Save.

5. Select the CA You should select the added Certificate Authority (CA) in UCT-V Controller
while creating the monitoring domain configuring the fabric components

in GigaVUE-FM. To select the CA certificate, follow the steps in the
sectionConfigure GigaVUE Fabric Components in GigaVUE-FM

Configure Secure Tunnel from GigaVUE V Series Node 1to GigaVUE
V Series Node 2

You can create secure tunnel in the following ways:

» Between GigaVUE V Series Node 1to GigaVUE V Series Node 2
» From GigaVUE V Series Node 1to multiple GigaVUE V Series nodes.

You must have the following details before you start the configuration of secure tunnel from
GigaVUE V Series Node 1to GigaVUE V Series Node 2:

« |P address of the tunnel destination endpoint (GigaVUE V Series Node 2).
» SSH key pair (pem file).

To configure secure tunnel from GigaVUE V Series Node 1to GigaVUE V Series Node 2, refer
to the following steps:
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S.No Task Description

1. Upload a CA. You must upload a CA Certificate to UCT-V Controller for establishing a
connection between the GigaVUE V Series node.

To upload the CA using GigaVUE-FM follow the steps given below:

1. Go to Inventory > Resources > Security > CA List.

2. Click Add, to add a new Certificate Authority. The Add Certificate
Authority page appears.

3. Enter or select the following information.

Field Action

Alias Alias name of the CA.
File Upload Choose the certificate from the desired location.
4. Click Save.

5. Click Deploy All.

For more information, refer to the Adding Certificate Authority

section.
2. Upload a SSL You must add a SSL key to GigaVUE V Series node. To add SSL Key, follow the
Key. steps in the section Upload SSL Keys.
3 Create a secure | You should create a secure tunnel to establish a connection between the UCT-
tunnel. Vand GigaVUE V Series node 1. To enable the secure tunnel feature follow these
steps:

1. Inthe Edit Monitoring Session page, click Options. The Monitoring Session
Options page appears.

2. Enable the Secure Tunnel button. You can enable secure tunnel for both
mirrored and precrypted traffic.

4, Select the Select the added SSL Key while creating a monitoring domain and configuring
added SSL Key. | the fabric components in GigaVUE-FM in GigaVUE V Series Node 1.

You must select the added SSL Key in GigaVUE V Series Node 1.

To select the SSL key, follow the steps in the section Configure GigaVUE Fabric
Components in GigaVUE-FM

5. Select the You should select the added Certificate Authority (CA) in UCT-V Controller while
added CA creating the monitoring domain. To select the CA certificate, follow the steps in
certificate. the sectionConfigure GigaVUE Fabric Components in GigaVUE-FM

6 Create an You must create an egress tunnel for traffic to flow out from GigaVUE V Series
Egress tunnel Node 1 with tunnel type as TLS-PCAPNG while creating the monitoring session.

from GigaVUE V | Refer to Create a Monitoring Session to know about monitoring session.
Series Node 1.
To create the egress tunnel, follow these steps:

1. After creating a new monitoring session, or click Actions > Edit on an existing
monitoring session, the GigaVUE-FM canvas appears.
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S.No Task Description

2. Inthe canvas, select New > New Tunnel, drag and drop a new tunnel
template to the workspace. The Add Tunnel Spec quick view appears.

3. Onthe New Tunnel quick view, enter or select the required information as
described in the following table:

Field Action

Alias The name of the tunnel endpoint.

Description The description of the tunnel endpoint.

Type Select TLS-PCAPNG for creating egress secure tunnel
Traffic Choose Out (Encapsulation) for creating an egress tunnel from
Direction the V Series node to the destination. Select or enter the

following values:
o MTU- The default value is 1500.

o Time to Live - Enter the value of the time interval till
which the session needs to be available. The value ranges
from 1to 255. The default value is 64.

o DSCP - Enter the Differentiated Services Code Point
(DSCP) value.

Flow Label - Enter the Flow Label value.

Source L4 Port- Enter the Souce L4 Port value
Destination L4 Port - Enter the Destination L4 Port value.
Flow Label

Cipher- Only SHA 256 is supported.

TLS Version - Select TLS Version1.3.

Selective Acknowledgments - Choose Enable to turn on
the TCP selective acknowledgments.

O O O 0 O O O

o SYN Retries - Enter the value for number of times the SYN
has to be tried. The value ranges from 1to 6.

o Delay Acknowledgments - Choose Enable to turn on
delayed acknowledgments.

IP Version The version of the Internet Protocol. Only IPv4 is supported.
Remote Enter the interface IP address of the GigaVUE V Series Node 2
Tunnel IP (Destination IP).

4, Click Save.

7. Select the You must select the added SSL Key while creating a monitoring domain and
added SSL Key configuring the fabric components in GigaVUE-FM in GigaVUE V Series Node 2. To
in GigaVUE V select the SSL key, follow the steps in the section Configure GigaVUE Fabric

Series Node 2 Components in GigaVUE-FM

8 Create an You must create a ingress tunnel for traffic to flow in from GigaVUE V Series Node
ingress tunnel 1with tunnel type as TLS-PCAPNG while creating the monitoring session for

in the GigaVUE | GigaVUE V Series Node 2. Refer to Create a Monitoring Session to know about

V Series node 2. | monitoring session.
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S.No Task Description

To create the ingress tunnel, follow these steps:

1. After creating a new monitoring session, or click Actions > Edit on an existing
monitoring session, the GigaVUE-FM canvas appears.

2. Inthe canvas, select New > New Tunnel, drag and drop a new tunnel
template to the workspace. The Add Tunnel Spec quick view appears.

3. Onthe New Tunnel quick view, enter or select the required information as
described in the following table:

Field Action

Alias The name of the tunnel endpoint.

Description The description of the tunnel endpoint.

Type Select TLS-PCAPNG for creating egress secure tunnel.

NoTE: If you are enabling Secure tunnel in Monitoring Session
with traffic acquistion method as UCT-V, you must not create
TLS Tunnel with direction IN, Destination L4 port 11443, and
GigaVUE V Series Node version 6.5 and above.

Traffic Choose In (Decapsulation) for creating an ingress tunnel that
Direction receives traffic from V Series node 1. Select or enter the values as
described in Step 6:

IP Version The version of the Internet Protocol. Only IPv4 is supported.
Remote Enter the interface IP address of the GigaVUE V Series Node 1
Tunnel IP (Destination IP).

4, Click Save.

Viewing Status of Secure Tunnel

GigavUE-FM allows you to view the status of secure tunnel connection in UCT-C. You can
verify whether the tunnel is connected to the tool or V Series node through the status.

To verify the status of secure tunnel, go to UCT-C > Monitoring Damain. In the monitoring
domain page, Tunnel status column shows the status of the tunnel. The green color
represents that the tunnel is connected and the red represents that the tunnel is not
connected.

For configuring secure tunnel, refer to Configure Secure Tunnel section.

Precryption™

License: Requires SecureVUE Plus license.
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Gigamon Precryption™ technology! redefines security for virtual, cloud, and containerized
applications, delivering plaintext visibility of encrypted commmunications to the full security
stack, without the traditional cost and complexity of decryption.

This section explains about:

» How Gigamon Precryption Technology Works
«  Why Gigamon Precryption

« Key Features

« Key Benefits

« Precryption Technology on Single Node

» Precryption Technology on Multi-Node

» Supported Platforms

« Prerequisites

How Gigamon Precryption Technology Works

Precryption technology leverages native Linux functionality to tap, or copy, communications
between the application and the encryption library, such as OpenSSL.

Precryption Tap Point

I
I
] EI é ? Encryption
App £ Library

&

In this way, Precryption captures network traffic in plaintext, either before it has been
encrypted, or after it has been decrypted. Precryption functionality doesn't interfere with the
actual encryption of the message nor its transmission across the network. There's no proxy,

IDisclaimer: The Precryption feature allows users to acquire traffic after it has been decrypted. This traffic can be acquired from
both virtual machine (VM) and container-based solutions, and is then sent to the V Series product for further processing. The
Precryption feature provides an option to use encrypted tunnels for communication between the acquisition (via UCT or G-
VTAP) of unencrypted traffic and the traffic processing (at the V Series) which will better safeguard the traffic while in transit.
However, if a user does not use the option for encrypted tunnels for communication, decrypted traffic will remain unencrypted
while in transit between the point of acquisition and processing.

Please note that this information is subject to change, and we encourage you to stay updated on any modifications or
improvements made to this feature.

By using this feature, you acknowledge and accept the current limitations and potential risks associated with the transmission
of decrypted traffic.
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no retransmissions, no break-and-inspect. Instead, this plaintext copy is forwarded to the
Gigamon Deep Observability Pipeline for further optimization, transformation, replication,
and delivery to tools.

Precryption technology is built on GigaVUE® Universal Cloud Tap (UCT) and works across
hybrid and multi-cloud environments, including on-prem and virtual platforms. As a bonus,
UCT with Precryption technology runs independent of the application, and doesn't have to
be baked into the application development lifecycle.

Why Gigamon Precryption

GigaVUE Universal Cloud Tap with Precryption technology is a lightweight, friction-free
solution that eliminates blind spots present in modern hybrid cloud infrastructure, providing
East-West visibility into virtual, cloud, and container platforms. It delivers unobscured
visibility into all encryption types including TLS 1.3, without managing and maintaining
decryption keys. IT organizations can now manage compliance, keep private
communications private, architect the necessary foundation for Zero Trust, and boost
security tool effectiveness by a factor of 5x or more.

Key Features

The following are the key features of this technology:

« Plaintext visibility into communications with modern encryption (TLS 1.3, mTLS, and TLS
1.2 with Perfect Forward Secrecy).

« Plaintext visibility into communications with legacy encryption (TLS 1.2 and earlier).
« Nonintrusive traffic access without agents running inside container workloads.

« Elimination of expensive resource consumption associated with traditional traffic
decryption.

« Elimination of key management required by traditional traffic decryption.
« Zero performance impact based on cipher type, strength, or version.

» Support across hybrid and multi-cloud environments, including on-prem, virtual, and
container platforms.

» Keep private communications private across the network with plaintext threat activity
delivered to security tools.

« Integration with Gigamon Deep Observability Pipeline for the full suite of optimization,
transformation, and brokering capabilities.

Key Benefits

The following are the key benefits of this technology:
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« Eliminate blind spots for encrypted East-West (lateral) and North-South
communications, including traffic that may not cross firewalls.

« Monitor application commmunications with an independent approach that enhances
development team velocity.

» Extend security tools’ visibility to all communications, regardless of encryption type.

« Achieve maximum traffic tapping efficiency across virtual environments.

« Leverage a 5-7x performance boost for security tools by consuming unencrypted data.
» Support a Zero Trust architecture founded on deep observability.

» Maintain privacy and compliance adherence associated with decrypted traffic
management.

How Gigamon Precryption Technology Works

This section explains about how Precryption technology works on single node and multiple
node in the following sections:

» Precryption Technology on Single Node
« Precryption Technology on Multi-Node

Precryption Technology on Single Node

1. When any application needs to encrypt a message, it uses an encryption library, such
as OpenSSL, to perform the actual encryption.

2. GigaVUE Universal Cloud Tap (UCT), enabled with Precryption technology, gets a copy
of this message before it's encrypted on the network.

3. The encrypted message is sent to the receiving application, with unmodified
encryption. No proxy, no re- encryption, no retransmissions.

4. GigaVUE UCT creates packet headers as needed, encapsulates in a tunnel, and
forwards to GigaVUE V Series in the deep observability pipeline. Gigamon further
optimizes, transforms, and delivers data to tools, without need for further decryption
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1. When any application needs to encrypt a message, it uses an encryption library, such
as OpenSSL, to perform the actual encryption.

2. GigaVUE Universal Cloud Tap (UCT), enabled with Precryption, gets a copy of this
message before it's encrypted on the network.

3. Optionally, GigaVUE UCT enabled with Precryption can also acquire a copy of the
message from the server end, after the decryption.

4. GigaVUE UCT creates packet headers as needed, encapsulates in a tunnel, and
forwards to V Series in the deep observability pipeline where it is further enriched,
transformed, and delivered to tools, without further decryption.
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Supported Platforms

VM environments: Precryption™ is supported on the following VM platforms where UCT-V
is supported:

Platform Type Platform

Public Cloud « AWS
« Azure
o GCP (via Third Party Orchestration)

Private Cloud « OpenStack
« VMware ESXi (via Third Party Orchestration only)
« VMware NSX-T (via Third Party Orchestration only)

Precryption™
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Container environments: Precryption™ is supported on the following container platforms
where UCT-C is supported:

Platform Type Platform

Public Cloud « EKS
. AKS
Private Cloud « OpenShift
« Native Kubernetes (VMware)

Prerequisites

Deployment Prerequisites

OpenSSL version 1.0.2, version 1.1.0, version 1.1.1, and version 3.x
Protocol version IPv4

For GigaVUE-FM, to capture the statistics, you must add the port 5671 in the security
group

Port 9900 should be enabled in security group settings on the UCT-V controller to
receive the statistics information from UCT-V agent

For UCT-C, you must add the port 42042 and port 5671 in the security group

License Prerequisite

Precryption™ requires SecureVUE Plus license.

Supported Kernel Version

Precryption is supported for Kernel Version 5.4 and above for all Linux and Ubuntu
Operating Systems. For the Kernel versions below 5.4, refer to the following table:

Kernel Version Operating System

418.0-193.e18 x86_64 | RHEL release 8.2 (Ootpa)

4.18.0-240.el8.x86_64 RHEL release 8.3 (Ootpa)

4.18.0-305.76.1.el8_4.x86_64 | RHEL release 8.4 (Ootpa)

418.0-348.12.2.el8_5x86_64 | RHEL release 85 (Ootpa)

4.18.0-372.9.1.el8.x86_64 RHEL release 8.6 (Ootpa)
4.18.0-423.e18.x86_64 RHEL release 8.7 Beta (Ootpa)
4.18.0-477.15.1.e18_8.x86_64 | RHEL release 8.8 (Ootpa)
5.3.0-1024-kvm ubuntul9.10

4.18.0-305.3.1 Rocky Linux 8.4

Precryption™
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Kernel Version Operating System

418.0-348 Rocky Linux 8.5
418.0-372.9.1 Rocky Linux 8.6
4.18.0-42510.1 Rocky Linux 8.7
418.0-477.10.1 Rocky Linux 8.8
418.0-80.el8.x86_64 centos 82

418.0-24011el8_3x86_64 | centos 8.3

418.0-305.31.e18_4x86_64 | centos 8.4

4.18.0-408.el8.x86_64 centos 8.5

Note

« See the Configure Precryption in UCT-V section for details on how to enable
Precryption™ in VM environments.

» See the Configure in UCT-C section for details on how to enable Precryption™ in
container environments.

« See how Secure Tunnels feature can enable secure delivery of precrypted data.

Configure Precryption in UCT-V

GigaVUE-FM allows you to enable or disable the Precryption feature for a monitoring
session.

To enable or disable the Precryption feature in UCT-V, refer to Create monitoring session.

To create a new monitoring session with Precryption, follow these steps:

1. In GigaVUE-FM, on the left navigation pane, select Traffic > Virtual > Orchestrated
Flows and select your cloud platform. The Monitoring Sessions page appears.

2. Click New to open the Create a New Monitoring Session page.
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3. Enter the appropriate information for the monitoring session as described in the
following table:

Field Description

Alias The name of the monitoring session.

Monitoring The name of the monitoring domain that you want to select.

Domain

Connection The connection(s) that are to be included as part of the monitoring domain. You can

select the required connections that need to be part of the monitoring domain.

Traffic Enabling the "Traffic Distribute" option identifies duplicate packets across different
Distribute GigaVUE V Series Nodes when traffic from various targets is routed to these instances
for monitoring.

Click Next. The Edit Monitoring Session page appears with the new canvas.
Click Options button. The Monitoring Session Options appears.

Click Precryption tab.

Enable Precryption.

© N o ok

Click Save. The Edit Monitoring Session page appears. You can proceed to create
map, tunnels, and adding applications.

NOTE: It is recommended to enable the secure tunnel feature whenever the
Precryption feature is enabled. Secure tunnel helps to securely transfer the cloud
captured packets or precrypted data to a GigaVUE V Series Node. For more
information, refer to Secure Tunnel .

Validate Precryption connection

To validate the Precryption connection, follow the steps:

« Toconfirm it is active, navigate to the Monitoring Session dashboard and check the
Precryption option, which should show yes.

« Click Status, to view the rules configured.
Rules and Notes
e To avoid packet fragmentation, you should change the option precryption-path-mtu in

UCT-V configuration file (/fetc/uctv/uctv.conf) within the range 1400-9000 based on the
platform path MTU.
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Analytics for Virtual Resources

Analytics in GigaVUE-FM is a standalone service that provides data visualization capabilities.
Using Analytics! you can create visual elements such as charts that are embedded as
visualizations. The visualizations are grouped together in dashboards. You can also create
search objects using Analytics. Dashboards, Visualizations and Search Objects are called
Analytics objects. Refer to Analytics topic in GigaVUE Fabric Management Guide for more
detailed information on Analytics.

Rules and Notes:

¢ You cannot edit or delete these default dashboards. However, you can clone the
dashboards and visualizations. Refer to the Clone Dashboard section for more details.

¢ Use the Time Filter option to select the required time interval for which you need to view
the visualization.

Virtual Inventory Statistics and Cloud Applications
Dashboard

Analytics dashboards allow users to monitor the physical and virtual environment and
detect anomalous behavior and plan accordingly. Refer to the Analytics section in GigaVUE
Fabric Management Guide for details on how to create a new dashboard, clone a
dashboard, create a new visualization, and other information about the Discover page and
Reports page.

To access the dashboards:

1. Goto Iﬂ» Analytics -> Dashboards.
2. Click on the required dashboard to view the visualizations.

The following table lists the various virtual dashboards:

lAnalytics uses the OpenSearch front-end application to visualize and analyze the data in the OpenSearch database of GigaVUE-FM.
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Dashboard

Inventory Status
(Virtual)

Displays

Statistical details of the virtual inventory
based on the platform and the health
status.

You can view the following metric
details at the top of the dashboard:

« Number of Monitoring Sessions
« Number of V Series Nodes

« Number of Connections

« Number of GCB Nodes

You can filter the visualizations based
on the following control filters:

o Platform
o Health Status

Visualizations

V Series Node
Status by Platform

Displays

Number of healthy and
unhealthy V Series
Nodes for each of the
supported cloud
platforms.

Monitoring Session
Status by Platform

Number of healthy and
unhealthy monitoring
sessions for each of the
supported cloud
platforms

Connection Status
by Platform

Number of healthy and
unhealthy connections
for each of the
supported cloud
platforms

GCB Node Status
by Platform

Number of healthy and
unhealthy GCB nodes for
each of the supported
cloud platforms

V Series Node
Statistics

Displays the Statistics of the V
Series node such as the

CPU usage, trend of the
receiving and transmitting
packets of the V Series node.

You can filter the visualizations
based on the following control
filters:

e Platform
e« Connection
e V Series Node

V Series Node
Maximum
CPU Usage Trend

Line chart that
displays maximum
CPU usage trend of
the V Series node in
5 minutes interval,
for the past one
hour.

NoTE: The maximum
CPU Usage trend
refers to the CPU
usage for service cores
only. Small form factor
V-series nodes do not
have service cores,
therefore the CPU
usage is reported as O.

V Series Node with
Most CPU Usage
For Past 5 minutes

Line chart that
displays Maximum
CPU usage of the V
Series node for the
past 5 minutes.

NOTE: You cannot use
the time based filter

Analytics for Virtual Resources
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Dashboard Displays Visualizations | Displays
options to filter and
visualize the data.
V Series Node Rx Receiving trend of the V
Trend Series node in 5 minutes
interval, for the past one
hour.
V Series Network Total packets
/”terfc’ce: with received by each of
Most Rx for Past 5 .
. the V Series
mins .
network interface
for the past 5
minutes.
NOTE: You cannot use
the time based filter
options to filter and
visualize the data.
V Series Node Displays the reception of
Tunnel Rx packet at the Tunnel RX.
Packets/Errors This is the input to V
Series Node, Grouping
by tunnel identifier
comprising
{monDomain, conn, VSN,
tunnelName}, before
aggregation.
V Series Node TX is for output tunnels
Tunnel Tx from GigaVUE V Series
Packets/Errors Node. V Series Node
Tunnel Tx Packets/Errors
Dedup Displays visualizations related to | Dedup Packets Statistics of the total
Dedup application. Detected/Dedup Qedup pac.kets received
Packets Overload (ipV4Dup, ipVeDup and
You can filter the visualizations goglpDup)l_algat!nst the
. edup application
based on the following control Papp
] overload.
filters:
Dedup Packets Percentage of the dedup
e Platform Detected/Dedup packets received against
« Connection Packets Overload the dedup application
.« VSeries Node Percentage overload.
Total Traffic In/Out | Total incoming traffic
Dedup against total outgoing
traffic

Analytics for Virtual Resources
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Dashboard

Tunnel (Virtual)

Displays

Displays visualizations related to
the tunneled traffic in both bytes
as well as the number of
packets.

You can select the following
control filters, based on which
the visualizations will get
updated:

» Monitoring session: Select the
required monitoring session. The
cloud platform, monitoring domain
and connection within the
monitoring domain that is used by
the V-series node are shown in
square brackets, comma-separated,
after the name, to distinguish the
whole path to it.

« V series node: Management IP of
the V Series node. Choose the
required V-series node from the
drop-down.

e Tunnel: Select any of the tunnels
shown in the Tunnel drop-down. The
direction for each tunnel is shown
with the prefix in or out.

The following statistics are
displayed for the tunnel:

e Received Bytes

o Transmitted Bytes

o Received Packets

o Transmitted Packets

e Received Errored Packets

e Received Dropped Packets

o Transmitted Errored Packets

e Transmitted Dropped Packets

Visualizations

Tunnel Bytes

Displays

Displays received
tunnel traffic vs
transmitted tunnel
traffic, in bytes.

e Forinput tunnel,

transmitted traffic is
displayed as zero.

e For output tunnel,
received traffic is
displayed as zero.

Tunnel Packets

Displays packet-level
statistics for input and
output tunnels that are
part of a monitoring
session.

App (Virtual)

Displays Byte and packet level
statistics for the applications for
the chosen monitoring session
on the selected V series node.

App Bytes

Displays received traffic
Vs transmitted traffic, in
Bytes.

Analytics for Virtual Resources
Virtual Inventory Statistics and Cloud Applications Dashboard

147




GigaVUE Cloud Suite Deployment Guide - OpenStack

Dashboard Displays Visualizations | Displays
You can select the following
control filters, based on which
the visualizations will get
updated:
« Monitoring session
» V series node
+ Application: Select the required
application. By default, the
visualiza.tion.s displayed includes all App Packets Displays received traffic
the applications. vs transmitted traffic, as
the number of packets.
By default, the following
statistics are displayed:
e Received Bytes
e Transmitted Bytes
o Received Packets
o Transmitted Packets
o Errored Packets
e Dropped Packets
End Point Displays Byte and packet level Endpoint Bytes Displays received traffic
(Virtual) statistics for the un-tunneled vs transmitted traffic, in

traffic deployed on the V-series
nodes.

The following statistics that are
shown for Endpoint (Virtual):

Received Bytes

Transmitted Bytes

Received Packets
Transmitted Packets
Received Errored Packets
Received Dropped Packets
Transmitted Errored Packets

Transmitted Dropped Packets

The endpoint drop-down shows
<V-series Node Management IP
address : Network Interface> for
each endpoint.

Bytes.

Analytics for Virtual Resources
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Dashboard Displays

You can select the following
control filters, based on which
the visualizations will get
updated:

« Monitoring session
e V Series node

o Endpoint: Management IP of the V
Series node followed by the Network
Interface (NIC)

Visualizations

Displays

Endpoint Packets

Displays received traffic
vs transmitted traffic, as
the number of packets.

version 5.14.00 and beyond.

NoTe: The Tunnel (Virtual), App (Virtual) and Endpoint (Virtual) dashboards do not
show data from the previous releases if the Monitoring Session [Platform : Domain :
Connection] dashboard filter is applied. This is because, this filter relies on the new
attributes in the OpenSearch database, which are available only from software

Analytics for Virtual Resources
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Administer GigaVUE Cloud Suite
for OpenStack

You can perform the following administrative tasks in GigaVUE-FM for GigaVUE Cloud Suite
for OpenStack:

e Configure the OpenStack Settings
* Role Based Access Control

e About Audit Logs

* About Events

Configure the OpenStack Settings

To configure the OpenStack Settings:
1. Go to Inventory > VIRTUAL > OpenStack, and then click Settings.
2. Click the Settings drop-down, and then select Advanced Settings.

3. Click Edit to edit the Advanced Settings fields.
Advanced Settings

Refresh interval for VM target selection inventory (secs) 120
Refresh interval for fabric deployment inventory (secs) 900
Number of UCT-Vs per V Series Node 100
Number of hypervisors per V Series Node 5
Refresh interval for UCT-V inventory (secs) 900
OVS Mirror tunnel range start 10000
OVS Mirror tunnel range end 30000
Traffic distribution tunnel range start 8000
Traffic distribution tunnel range end 8512
Traffic distribution tunnel MTU 9001
OVS Agent Traffic when V Series is down Disabled
Administer GigaVUE Cloud Suite for OpenStack 150
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Refer to the following table for descriptions of the Settings fields.

Settings Description

Refresh interval for VM Specifies the frequency for updating the inventory of VMs in OpenStack.
target selection
inventory (secs)

Refresh interval for Specifies the frequency for updating the inventory of GigaVUE fabrics in OpenStack.
fabric deployment
inventory (secs)

Number of UCT-Vs per V | Specifies the maximum number of instances that can be assigned to the V Series
Series Node (applicable node.

only for UCT-V based
connections)

Number of hypervisors Specifies the maximum number of hypervisors that can be assigned to the V Series
per V Series Node node.

(applicable only for
OVS mirroring)

Refresh interval for UCT- | Specifies the frequency for discovering the UCT-Vs available in the project. This is
V inventory (secs) applicable for UCT-Vs only.

OVS Mirror tunnel range | Specifies the startup range value of the OVS mirror tunnel ID. This is applicable for
start UCT-V OVS Agents only.

OVS Mirror tunnel range | Specifies the closing range value of the OVS mirror tunnel ID. This is applicable for
end UCT-V OVS Agents only.

Traffic distribution Specifies the start range value of the tunnel ID.
tunnel range start

Traffic distribution Specifies the closing range value of the tunnel ID.
tunnel range end

OVS Agent Traffic Enable this option to stop the OVS Agent from sending the traffic to the V Series
when V Series is down | node. You can stop the traffic either manually or automatically. Refer to Shutdown
or Restart of OVS traffic to know more about the manual or automatic shut down
and restart.

NoTE: A maximum of 100 OpenStack connections are allowed for an OpenStack
module.

Shutdown or Restart of OVS traffic

GigaVUE-FM allows you to stop or restart the traffic through OVS Mirroring based on the
availability of V Series node.
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GigaVUE-FM helps you to stop the traffic when the V Series node is unreachable or
unrecoverable, and restart it when the V Series node is reachable again in the following
ways:

« Manual shutdown or restart of OVS traffic
« Automatic shutdown or restart of OVS traffic

Manual shutdown or restart of OVS traffic

The traffic sent from the OVS Mirroring Agent can be manually stopped and started.

To shut down or restart the OVS traffic manually, follow these steps:

1. Go to Inventory > VIRTUAL > OpenStack, and then click Settings
Click the Settings drop-down, and then select Advanced Settings.
Enable the check box OVS Agent Traffic when V Series is down.
Click the Fabric tab.

Select the V Series node.

o A WN

Click the Actions drop-down list and select Shut down OVS Traffic or Restart OVS
Traffic as required.

NOTE: You can view the Shut down OVS Traffic or Restart OVS Traffic options only
when you enable the check box OVS Agent Traffic when V Series is down in the
Advanced Settings.

Automatic shutdown or restart of OVS traffic

When the GigaVUE Cloud Suite V Series node is deleted or changed to an unrecoverable
state in the OpenStack platform, GigavUE-FM performs the action as explained in the
following table:

Administer GigaVUE Cloud Suite for OpenStack 152
Shutdown or Restart of OVS traffic



GigaVUE Cloud Suite Deployment Guide - OpenStack

V Series node Status in OpenStack

Action in
GigaVUE-FM

Action in
GigaVUE-FM when
you enable the

When a V Series node is deleted from
the OpenStack platform

GigaVUE-FM
automatically sets the
status of that V Series
node as terminated.

option

In the Advanced
Settings, when the
OVS Agent Traffic
when V Series is
down checkbox is
enabled, GigaVUE-FM
removes the source
interfaces of

OVS Mirroring agent

When a V Series Node is changed to a
stopped or shutoff state in Openstack

GigaVUE-FM Health
monitoring module
tries to start the V
Series node. If
unsuccessful after two
attempts, GigaVUE-
FM considers the V
Series node to be
unrecoverable.

In the Advanced
Settings, when the
OVS Agent Traffic
when V Series is
down checkbox is
enabled, GigaVUE-FM
removes the source
interfaces of

OVS Mirroring agent.

When a V Series node is in an active
state and its connection to GigaVUE-FM
is restored

GigaVUE-FM Health
Monitoring module
determines V Series
Node is in a healthy
state.

In the Advanced
Settings, when the
OVS Agent Traffic
when V Series is
down checkbox is
enabled, GigaVUE-FM
adds the source
interfaces of the
OVS Mirroring agent
and restarts the OVS
traffic.

Role Based Access Control

The Role Based Access Control (RBAC) feature controls the access privileges of users and
restricts users from either modifying or viewing unauthorized data. Access privileges in

GigaVUE Cloud Suite works on the same principles of access privileges in GigaVUE-FM in
which the access rights of a user depends on the following:

Administer GigaVUE Cloud Suite for OpenStack

Role Based Access Control

153




GigaVUE Cloud Suite Deployment Guide - OpenStack

» User role: A user role defines permission for users to perform any task or operation

» User group: A user group consists of a set of roles and set of tags associated with that
group. When a user is created they can be associated with one or more groups.

To access the resources and to perform a specific operation in GigaVUE Cloud Suite you
must be a user with fm_super_admin role or a user with write access to the following
resource category depending on the task you need to perform.

Resource Category Cloud Configuration Task

Physical Device Infrastructure e Configure GigaVUE Cloud Components
Management: This includes the
following cloud infrastructure
resources:

e Create Monitoring Domain and Launch Visibility Fabric

o Cloud Connections

e Cloud Fabric Deployment
e Cloud Configurations

e Sys Dump

e Syslog

o Cloud licenses

e Cloud Inventory

Traffic Control Management: This o Create, Clone, and Deploy Monitoring Session
includes the following traffic

e Create and Apply Threshold Template
control resources:

« Add Applications to Monitoring Session

* Monitoring session « Create Maps

o Threshold Template . View Statistics

o Stats o Create Tunnel End Points
e Map library
e Tunnel library
e Tools library

« Inclusion/exclusion Maps

NoTE: Cloud APIs are also RBAC enabled.

Refer to the GigaVUE Administration Guide for detailed information about Roles, Tags, User
Groups.

About Audit Logs

Audit logs track the changes and activities that occur in the virtual nodes due to user
actions. The logs can be filtered to view specific information.
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Navigate to Dashboard > SYSTEM > Audit Logs. The All Audit Logs page appears.

All Audit Logs Filter Manage
Filter : none
Time User Operation Type Entity Type Source Device IP Hostname Status Description Tags (©)
admin User SUCCESS ‘
admin User SUCCESS
admin User SUCCESS

Annn 4 e eee

Go to page: 1 > of 16 M Total Records: 106

The Audit Logs have the following parameters:

Parameters Description

Time Provides the timestamp on the log entries.

User Provides the logged user information.

Operation Type Provides specific entries that are logged by the system such as:
= Loginand Log out based on users.

= Create/Delete/Edit tasks, GS operations, maps, virtual ports, and
so on.

Source Provides details on whether the user was in FM or on the node when
the event occurred.

Status Success or Failure of the event.
Description In the case of a failure, provides a brief update on the reason for the
failure.

NoTE: Ensure that the GigaVUE-FM time is set correctly to ensure accuracy of the
trending data that is captured.

Filtering the audit logs allows you to display specific type of logs. You can filter based on any
of the following:

e When: display logs that occurred within a specified time range.

* Who: display logs related a specific user or users.

What: display logs for one or more operations, such as Create, Read, Update, and so on.
Where: display logs for GigaVUE-FM or devices.

Result: display logs for success or failure.

To filter the audit logs, do the following:
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1. Click Filter. The quick view for Audit Log Filters displays.
2. Specify any or all of the following:
» Start Date and End Date to display logs within a specific time range.

« Who limits the scope of what displays on the Audit Logs page to a specific user or
users.

* What narrows the logs to the types of operation that the log is related to. You can
select multiple operations. Select All Operations to apply all operation types as part
of the filter criteria.

« Where narrows the logs to particular of system that the log is related to, either FM
or device. Select All Systems apply both FM and device to the filter criteria.

¢ Result narrows the logs related to failures or successes. Select All Results to apply
both success and failure to the filter criteria.

3. Click OK to apply the selected filters to the Audit Logs page.

About Events

The Events page displays all the events occurring in the virtual fabric node, VM Domain, and
VM manager. An event is an incident that occur at a specific point in time. Examples of
events include:

e Cloud provider License Expiry
* UCT-V Inventory Update Completed
e Cloud provider Connection Status Changed

An Alarm is a response to one or more related events. If an event is considered of high
severity, then GigaVUE-FM raises an alarm. An example of alarm could be your cloud
provider license expiry.

The alarms and events broadly fall into the following categories: Critical, Major, Minor, or info.

Navigate to Dashboard > SYSTEM > Events. The Event page appears.

Events All Events Manage Events

Lot Filter Export v
'%’ Source Time Event Type Severity Affected Entity T... Affected Entity Alias Device IP Host Name Scope Description Tags &

™M 2022-08-100... Licenses Expir... Info Floating License ™M 4 Floating
™M 2022-08-09 0... Licenses Expir... Info Floating License ™M 4 Floating
™ 2022-08-08 0... Licenses Expir... Info Floating License M 4 Floating
FM 2022-08-07 0... Licenses Expir... Infa Floating License FM 4 Floating
™M 2022-08-06 0... Licenses Expir... Info Floating License ™M 4 Floating
™M 2022-08-051... FM Applicatio... Info fm application ... fmhal fmService CMS service f...
™M 2022-08-04 1.. FM Applicatio... Info fm application ... fmhal fmService CMS service f...

™ 2022-08-04 1.. Alarm Delete ... Critical VSeries Node ve-obe-pod2.u... Alarm Node Down. P...
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The following table describes the parameters recording for each alarm or event. You can also
use filters to narrow down the results.

Controls/
Parameters

Description

Source

The source from where the events are generated. The criteria can be as follows:
= FM -indicates the event was flagged by the Fabric Manager.

= |P address - is the address of the GigaVUE HC Series node that detected the
event. For a node to be able to send notifications to the Fabric Manager, the
SNMP_TRAP must be configured with the Fabric Manager’s IP address
specified as a host. Refer to the GigaVUE Administration Guide for
instructions on adding a destination for SNMP traps.

= VMM -indicates the event was flagged by the Virtual Machine Manager.

= FM Health - indicates the event was flagged due to the health status change
of GigaVUE-FM.

Time

The timestamp when the event occurred.

IMPORTANT:Timestamps are shown in the time zone of the client browser's
computer and not the time zone of the node reporting the event. The timestamp is
based on the correctly configured clock on the GigaVUE-FM server and converted
fromn UTC to the client computer's configured time zone.

Event Type

The type of event that generated the events. The type of events can be CPU
utilization high, cluster updated, device discovery failed, fan tray changed, netflow
statistics, and so on.

Severity

The severity is one of Critical, Major, Minor, or Info.

Info is informational messages. For example, when power status change
notification is displayed, then the message is displayed as Info.

Affected Entity Type

The resource type associated with the event. For example, when low disk space
notification is generated, 'Chassis' is displayed as the affected entity type.

Affected Entity

The resource |ID of the affected entity type. For example, when low disk space
notification is generated, the IP address of the node with the low disk space is
displayed as the affected entity.

Alias Event Alias

Device IP The IP address of the device.

Host Name The host name of the device.

Scope The category to which the events belong. Events can belong to the following

category: Domain, Node, Card, Port, Stack, Cluster, Chassis, GigaVUE-FM, GigaVUE-
VM, and so on. For example, if there is a notification generated for port utilization
low threshold, the scope is displayed as Physical Node.

To filter the alarms and event:

1. Click Filter. The Filter quick view is displayed.
2. Select the filtering criteria, then click Apply Filter. The results are displayed in the

Events page.
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GigaVUE-FM Version
Compatibility Matrix

The following tables list the different versions of GigaVUE Cloud Suite Cloud solution

components available with different versions of GigaVUE-FM.

components with GigaVUE-FM for better compatibility.

NoTE: GigaVUE-FM version 6.5 supports the latest fabric components version as well
as the (n-2) versions. It is always recommended to use the latest version of fabric

SesEE Controller | Veries | GI9AVUE
Proxy V SeriesNode

6.5.00 v6.5.00 v6.5.00 v6.5.00 v6.5.00 v6.5.00
6.4.00 Vv6.4.00 Vv6.4.00 Vv6.4.00 Vv6.4.00 v6.4.00
6.3.00 v6.3.00 v6.3.00 v6.3.00 v6.3.00 v6.3.00
6.2.00 v6.2.00 v6.2.00 v6.2.00 v6.2.00 v6.2.00
6.1.00 v6.1.00 v6.1.00 v6.1.00 v6.1.00 v6.1.00
6.0.00 V1.8-7 V1.8-2 V1.8-7 v2.7.0 v2.7.0
5.16.00 v1.8-5 v1.8-2 v1.8-5 v2.6.0 v2.6.0
515.00 Vv1.8-5 V1.8-1 Vv1.8-5 v2.5.0 v2.5.0
5.14.00 Vv1.8-4 v1.8-1 Vv1.8-4 Vv2.4.0 Vv2.4.0
513.01 Vv1.8-3 V1.8-1 Vv1.8-3 Vv2.3.3 Vv2.3.3
513.00 v1.8-2 v1.8-0 v1.8-2 v2.3.0 v2.3.0
512.00 V1.7-1 \l V1.7-1 v2.1.0 v2.1.0
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Troubleshooting

This section provides the information needed to troubleshoot GigaVUE-FM integration with
OpenStack.

OpenStack Connection Failed

The connFailed state indicates that the OpenStack connection has failed. Check the
following troubleshoot tips to restore the connection:

« Verify if GigaVUE-FM is able to reach the OpenStack cloud controller.

« Check if the OpenStack cloud controller is DNS resolvable from GigaVUE-FM.

« Verify if the region name provided while launching the instance is accurate.

» Ensure that all the security group rules required for communication between
GigaVUE-FM and OpenStack cloud controller OR GigaVUE-FM and DNS server are
accurately setup.

» Check if the Compute Servers that the nova API returns are reachable from
GigaVUE-FM. Refer to Handshake Alert: unrecognized_name.

Handshake Alert: unrecognized_name

When setting up the OpenStack connection in GigaVUE-FM, the GigaVUE-FM logs might
show a handshake alert: unrecognized_name error. This error is related to a Server Name
Indication (SNI) error. Starting with Java 7, the JDK does not ignore the unrecognized name
warning. To resolve this issue, perform either of the following:

« Fix the configuration on the server where the error is occurring.

« Ignore the warning on the client side (GigaVUE-FM server) by using the Java system
property --Djsse.enableSNIExtension=false while launching GigaVUE-FM.

Contact support for information on how to use the Java system property. However, this is
not recommended for security reasons.
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GigaVUE V Series Node or UCT-V Controller is
Unreachable

If GigaVUE V Series node or UCT-V Controller is unreachable, verify the following:

« The correct version of the image is uploaded.
« The network is reachable.
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Additional Sources of Information

This appendix provides additional sources of information. Refer to the following sections for
details:

« Documentation

= Documentation Feedback

« Contact Technical Support

« Contact Sales

« The VUE Community

Documentation

This table lists all the guides provided for GigaVUE Cloud Suite software and hardware. The
first row provides an All-Documents Zip file that contains all the guides in the set for the
release.

NoTE: In the online documentation, view What's New to access quick links to topics
for each of the new features in this Release; view Documentation Downloads to
download all PDFs.

Table 1: Documentation Set for Gigamon Products

GigaVUE Cloud Suite 6.5 Hardware and Software Guides

DID YOu KNOoW? [f you keep all PDFs for a release in common folder, you can easily search across the doc set
by opening one of the files in Acrobat and choosing Edit > Advanced Search from the menu. This opens an
interface that allows you to select a directory and search across all PDFs in a folder.

Hardware

how to unpack, assemble, rack-mount, connect, and initially configure ports the respective GigaVUE Cloud
Suite devices; reference information and specifications for the respective GigaVUE Cloud Suite devices

GigaVUE-HC1 Hardware Installation Guide

GigaVUE-HC2 Hardware Installation Guide

GigaVUE-HC3 Hardware Installation Guide

GigaVUE-HCI1-Plus Hardware Installation Guide

GigaVUE-HCT Hardware Installation Guide

GigaVUE-TA25 Hardware Installation Guide

GigaVUE-TA25E Hardware Installation Guide
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GigaVUE Cloud Suite 6.5 Hardware and Software Guides

GigaVUE-TA100 Hardware Installation Guide

GigaVUE-TA200 Hardware Installation Guide

GigaVUE-TA200E Hardware Installation Guide

GigaVUE-TA400 Hardware Installation Guide

GigaVUE-OS Installation Guide for DELL S4112F-ON

G-TAP A Series 2 Installation Guide

GigaVUE M Series Hardware Installation Guide

GigaVUE-FM Hardware Appliance Guide for GFM-HW1-FM010 and and GFM-HW1-FMOO1-HW

Software Installation and Upgrade Guides

GigaVUE-FM Installation, Migration, and Upgrade Guide

GigaVUE-OS Upgrade Guide

GigaVUE V Series Migration Guide

Fabric Management and Administration Guides

GigaVUE Administration Guide
covers both GigaVUE-OS and GigaVUE-FM

GigaVUE Fabric Management Guide

how to install, deploy, and operate GigaVUE-FM; how to configure GigaSMART operations; covers both
GigaVUE-FM and GigaVUE-OS features

Cloud Guides

how to configure the GigaVUE Cloud Suite components and set up traffic monitoring sessions for the cloud
platforms

GigaVUE V Series Applications Guide

GigaVUE V Series Quick Start Guide

GigaVUE Cloud Suite Deployment Guide - AWS

GigaVUE Cloud Suite Deployment Guide - Azure

GigaVUE Cloud Suite Deployment Guide - OpenStack

GigaVUE Cloud Suite Deployment Guide - Nutanix

GigaVUE Cloud Suite Deployment Guide - VMware (ESXi)

GigaVUE Cloud Suite Deployment Guide - VMware (NSX-T)

GigaVUE Cloud Suite Deployment Guide - Third Party Orchestration
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GigaVUE Cloud Suite 6.5 Hardware and Software Guides

Universal Cloud Tap - Container Deployment Guide

Gigamon Containerized Broker Deployment Guide

GigaVUE Cloud Suite for Nutanix Guide—GigaVUE-VM Guide

GigaVUE Cloud Suite Deployment Guide - AWS Secret Regions

Reference Guides

GigaVUE-OS CLI Reference Guide
library of GigaVUE-OS CLI (Command Line Interface) commmands used to configure and operate GigaVUE

HC Series and TA Series devices

GigaVUE-OS Security Hardening Guide

GigaVUE Firewall and Security Guide

GigaVUE Licensing Guide

GigaVUE-OS Cabling Quick Reference Guide
guidelines for the different types of cables used to connect Gigamon devices

GigaVUE-OS Compatibility and Interoperability Matrix
compatibility information and interoperability requirements for Gigamon devices

GigaVUE-FM REST API Reference in GigaVUE-FM User's Guide
samples uses of the GigaVUE-FM Application Program Interfaces (APIs)

Release Notes

GigaVUE-OS, GigaVUE-FM, GigaVUE-VM, G-TAP A Series, and GigaVUE Cloud Suite Release Notes
new features, resolved issues, and known issues in this release ;
important notes regarding installing and upgrading to this release

NoTE: Release Notes are not included in the online documentation.

NoTE: Registered Customers can log in to My Gigamon to download the Software and Release Notes
from the Software & Docs page on to My Gigamon. Refer to How to Download Software and Release
Notes from My Gigamon.

In-Product Help

GigaVUE-FM Online Help
how to install, deploy, and operate GigaVUE-FM.
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How to Download Software and Release Notes from My Gigamon

Registered Customers can download software and corresponding Release Notes documents
from the Software & Release Notes page on to My Gigamon. Use the My Gigamon Software
& Docs page to download:

¢ Gigamon Software installation and upgrade images,
» Release Notes for Gigamon Software, or
» Older versions of PDFs (pre-v5.7).

To download release-specific software, release notes, or older PDFs:

1. Log in to My Gigamon
2. Click on the Software & Release Notes link.

3. Use the Product and Release filters to find documentation for the current release. For
example, select Product: "GigaVUE-FM" and Release: "5.6," enter "pdf" in the search box,
and then click GO to view all PDF documentation for GigaVUE-FM 5.6.xx.

NoTE: My Gigamon is available to registered customers only. Newer documentation
PDFs, with the exception of release notes, are all available through the publicly
available online documentation.

Documentation Feedback

We are continuously improving our documentation to make it more accessible while
mMaintaining accuracy and ease of use. Your feedback helps us to improve. To provide
feedback and report issues in our documentation, send an email to:
documentationfeedback@gigamon.com

Please provide the following information in the email to help us identify and resolve the
issue. Copy and paste this form into your email, complete it as able, and send. We will
respond as soon as possible.

Documentation Feedback Form

Your Name

About You Your Role

Your Company
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Online doc link

(URL for where the issue is)

For Online Topics

Topic Heading

(if it's a long topic, please provide the heading of the
section where the issue is)

Document Title

(shown on the cover page or in page header )

Product Version

(shown on the cover page)

For PDF Topics Document Version

(shown on the cover page)

Chapter Heading

(shown in footer)

PDF page #

(shown in footer)

Describe the issue

Describe the error or issue in the documentation.

(If it helps, attach an image to show the issue.)

How can we improve

the content?
How can we

improve? Be as specific as

possible.

Any other
comments?

Contact Technical Support

For information about Technical Support: Go to Settings > Support > Contact Support

in GigaVUE-FM.

You can also refer to https://www.gigamon.com/support-and-services/contact-support for

Technical Support hours and contact information.

Email Technical Support at support@gigamon.com.
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Contact Sales

Use the following information to contact Gigamon channel partner or Gigamon sales
representatives:

Telephone: +1.408.831.4025
Sales: inside.sales@gigamon.com

Partners: www.gigamon.com/partners.html

Premium Support

Email Gigamon at inside.sales@gigamon.com for information on purchasing 24x7 Premium
Support. Premium Support entitles you to round-the-clock phone support with a dedicated
Support Engineer every day of the week.

The VUE Community

The VUE Community is a technical site where Gigamon users, partners, security and
network professionals and Gigamon employees come together to share knowledge and
expertise, ask questions, build their network and learn about best practices for Gigamon
products.

Visit the VUE site to:

» Find knowledge base articles and documentation
« Ask and answer guestions and learn best practices from other members.

» Join special-interest groups to have focused collaboration around a technology, use-
case, vertical market or beta release

» Take online learning lessons and tutorials to broaden your knowledge of Gigamon
products.

« Open support tickets (Customers only)
«» Download the latest product updates and documentation (Customers only)

The VUE Community is a great way to get answers fast, learn from experts and collaborate
directly with other members around your areas of interest.

Register today at community.gigamon.com

Questions? Contact our Community team at community@gigamon.com.
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Glossary

D
decrypt list
need to decrypt (formerly blacklist)
decryptlist
need to decrypt - CLI Command (formerly blacklist)
drop list
selective forwarding - drop (formerly blacklist)
F

forward list

selective forwarding - forward (formerly whitelist)

L
leader

leader in clustering node relationship (formerly master)
M

member node

follower in clustering node relationship (formerly slave or non-master)

N

no-decrypt list

no need to decrypt (formerly whitelist)
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nodecryptlist

no need to decrypt- CLI Command (formerly whitelist)

P

primary source

root timing; transmits sync info to clocks in its network segment (formerly grandmaster)

R

receiver

follower in a bidirectional clock relationship (formerly slave)

S

source

leader in a bidirectional clock relationship (formerly master)
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